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About GeoSyn

About GeoSyn
GeoSyn 1D enables you to create one-dimensional and offset   sythetic models. 
Logs can be edited, stretched, squeezed, shifted, and   more.

Synthetics creation
A synthetic can be created in several ways:

 l Open   a previously saved GeoSyn synthetic with a .syn   extension.

 l Import   raw log data from LAS or GeoSyn synthetic files.

 l Launch GeoSyn from Kingdom, AccuMap or PetraSeis applications.

 l Download   digitized logs from the IHS Information Hub or  AccuMap

 l Create   a blocked log suite.

Layout templates
GeoSyn enables you to create multiple templates that   control the display and 
placement of elements in the main synthetic display   including color palettes, dir-
ectory paths, and display presentations for   logs, traces, and models.

As well, the main synthetic display includes drag and   drop, and right-click func-
tionality for working with individual synthetic   elements.

File management
GeoSyn includes a Directory Browser that displays GeoSyn   and LAS format files in 
either the current directory or the current directory   and its sub-directories too. All 
files are displayed in one central view   sorted by UWI. Filter the display by exten-
sion, UWI column, or   geographic coordinates.

Export capability
Export tops, directional surveys, logs, synthetic   models, and more into ASCII 
text, LAS, and SEGY format as applicable.   All exports are managed through a cent-
ral export manager dialog box with   each data type displayed on separate tabs.

As well, any element that appears in the main synthetic   display can be copied to 
the Windows clipboard and pasted into other applications   to create a montage.
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About GeoSyn

GeoSyn includes batch printing and reformatting, which   enables you to sim-
ultaneously convert or print multiple LAS or GeoSyn   format files.

Tops management
When you create a new synthetic or launch an existing   one, GeoSyn auto-
matically downloads the latest system tops and user tops   from your local 
AccuMap database. Configure top lithology and   save various tops in different lists 
that you import, export, and display   in a tops table in the main synthetic display.

Information in the tops table can be exported as ASCII   text or as an image file for 
use with other applications.

Seismic
Import and display single-trace and multi-trace   seismic data saved in SEGY 
format and display the file in a stand-alone   SEGY Viewer before importing to 
review file format and contents. Imported   seismic can be tied to models for cor-
relation.

IHS Kingdom Integration
Create a GeoSyn synthetic using a well or seismic data from IHS Kingdom. Read a 
time depth chart directly from the Kingdom database, apply the data to a GeoSyn 
model, and then save the time/depth data back to the Kingdom database. 
GeoSyn can be launched directly from Kingdom and the resulting GeoSyn files can 
be saved within the Kingdom Project directory.

Modelling (traces)
Create zero-offset, multi-offset, or derived models. GeoSyn also enables you to 
create blocked log models to eliminate tuning effects that sometimes occur when 
using actual logs.

Cross-Plotting
Create crossplots using data from logs, seismic,   and models that appear in the 
synthetic for the X and Y axes.

Following are some of the more common crossplots you   might create:
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About GeoSyn

 l Offset   trace along the x axis and an amplitude trace along the y axis.

 l Incident   angle along the x axis and the amplitude from the seismic along 
the y   axis

 l Gradient   on one axis and intercept on the other.

 

Recommended system specifications
The recommended system specifications for GeoSyn are:

Hardware
Minimum 64-bit quad-core machine with 8 GB of physical RAM

Recommended 64-bit processor with 8 CPU cores and 16 GB of physical 
RAM or higher

Graphics card 
(Recommended)

Video cards that support CUDA 4.x, have at least 1 GB of 
graphic card memory

Operating System
OS Install Supported

Windows 7 SP1 (64-bit) Yes Yes

Windows 8 Yes * Yes *

Windows 10 Yes Yes

Windows 2008 R2 Server (Citrix based 
Applications)

Yes * Yes *

Windows 2012 Server (Citrix based 
Applications)

Yes * Yes *

* Basic support; we do not certify on these operating systems but will provide 
Customer Care support and consider bugs found during installation

Related topics
"Contacting customer care" on the facing page
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Contacting customer care

Contacting customer care
Contact IHS Customer Care for assistance with any questions or problems not 
answered in this help system.

To forward your GeoSyn license file to Customer Care, from the File menu, click 
License to display the Current License Status dialog box and click Email 
License File to IHS to launch your native email program and automatically 
attach the license file to a new message.

Phone 1 800 IHS-CARE (1 800 447-2273)
Mon. to Fri. 8:00 AM to 6:00 PM

Email Kingdom users: kingdom_support@ihsmarkit.com
Non-Kingdom users: support.cdn@ihsmarkit.com

Web site www.ihs.com/products/oil-gas-geosyn-software.html

When reporting a difficulty, please include any information that might help us dia-
gnose the problem including the following:

 l Version of GeoSyn (and AccuMap, if installed)

 l Windows operating system

 l Circumstances and steps that led to the problem

 l Complete text from any error messages

Related topics
"Recommended system specifications" on the previous page
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About Displaying Synthetics

About Displaying Synthetics
GeoSyn generates synthetics in its own proprietary   format. A GeoSyn synthetic 
can be the product of filtering and or other variables   that differs from raw data 
used to create synthetics.   

There are several ways to open a synthetic in GeoSyn:

 l Open   a previously saved GeoSyn synthetic with a .syn   extension.

 l Import  raw log data from LAS file or GeoSyn synthetic files.

 l Open a GeoSyn synthetic linked to a Kingdom synthetic

 l Creating      a blocked sonic log.

 l Download   digitized logs from the IHS Information Hub using either:
 l The online   data search wizard 

 l Clicking the desired well in AccuMap and   selecting GeoSyn 
Viewer from the   popup menu.

Directory Browser 
When importing LAS or GeoSyn files and when launching   GeoSyn synthetics, you 
can launch the Directory Browser tool that displays   an index of LAS and GeoSyn 
files located in directories and sub-directories.   Directory Browser enables you to 
sort and manage numerous files based   on Unique Well Identifier (UWI) instead of 
file name.

Related topics

Configuring GeoSyn defaults
The Properties dialog box is used to set the configuration defaults and control 
how imported logs, seismic, and tops files are interpreted and   displayed in cur-
rent and future GeoSyn sessions.

The Configuration properties dialog provides separate tabs for:

 l GeoSyn configuration defaults

 l File locations

 l Support addresses

 l Log in credentials

 l Log library
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About Displaying Synthetics

 l Import defaults

 l Statistics

To configure GeoSyn defaults:
 1. Open the Properties configuration dialog. Edit > Configuration prop-

erties

 2. Click the Edit   button beside the Working   box to specify a different loc-
ation where GeoSyn looks for and saves synthetic   layout templates, 
color palettes, and more.

 3. If   your subscription to the IHS Information Hub is charged by the trans-
action,   select the Show transaction warning prompt   check box to 
be notified before digits are downloaded and charges incurred.

 4. Click Close   to apply the changes or click a different tab. 

Note: Configuration changes are automatically applied   to this and future 
GeoSyn sessions.

Related topics
"Changing import defaults" on page 12
"Changing log defaults" on page 54
"Contacting customer care" on page 5
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About Displaying Synthetics

Opening GeoSyn synthetics
Each time you open a synthetic, GeoSyn pulls the formation   tops defined in the 
well from your local AccuMap system tops and AccuMap   user tops databases. 
There are several ways to open a GeoSyn file depending on your need:

 l Dragging a GeoSyn synthetic file (*.syn) onto the current GeoSyn display 
or, use the GeoSyn Directory Browser to filter existing GeoSyn files.

 l Synthetic mode options

 l Importing a well from Kingdom

 l Importing   a LAS or GeoSyn file

 l From AccuMap

 l Download   Logs from the IHS Information Hub
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Synthetic Generation Modes

Synthetic Generation Modes
GeoSyn offers two different modes when generating a synthetic:

 l Modelling mode — Time objects are placed by referencing velocity fields 
from a sonic log. The active sonic is edited by the user, however impor-
ted check shot surveys or time depth charts are only referenced (once) 
to correct the sonic and are then discarded.

 l Correlation mode — Time objects are placed by referencing velocity 
fields from a saved time depth chart.Objects are moved in time by alter-
ing the saved time/depth chart, not the sonic. 

Refer to the chart below for the advantages and disadvantages of each mode.
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Synthetic Generation Modes

Mode Advantages Disadvantages

Modeling mode Allows accurate “What if “log models 
to be to generated because log edit-
ing will change reflection coefficients 
as well as time spacing (tuning 
effect).

Tightly spaced, 
mis-picked 
check shots, or 
badly designed 
time depth 
charts can gen-
erate dramatic 
excursions dur-
ing the cor-
rection 
operation. Gen-
erally, time 
/depth cor-
rection data 
should be 
coarsely spaced 
and quality con-
trolled for valid 
velocities.

Correlation 
mode 

Correlating seismic is simplified. 
Reflection coefficients are readily 
moved by manipulating the 
time/depth chart.

With unlimited 
flexibility, it is 
easy to intro-
duce unreas-
onable or 
impossible velo-
city regimes. 
GeoSyn 
provides tools to 
monitor for this.

Related topics
"Importing wells from Kingdom" on page 29

Using Directory Browser
The GeoSyn Directory Browser  displays and sorts the contents of LAS and 
GeoSyn files by UWI rather than file name in selected directories and associated 
sub-directories.  Sorting by UWI instead of a file name allows users to:

 l Filter files by geographic coordinates

 l Sort by various UWI columns
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Synthetic Generation Modes

 l View basic details about the individual files before opening or importing 

UWIs are listed in the appropriate survey system tab   separated into columns rep-
resenting each coordinate group of the survey   system. Log files with missing or 
invalid UWIs are only listed in the   Labels tab

Cataloging files
The  first time it reads a directory, the Directory Browser creates a catalog file 
(.cat )of all (.las) and GeoSyn files in the selected directories .  Depending on 

the volume of files, this can take several minutes as each file is read and cata-
loged. As a best practice and to reduce time,  search directories should only 
include..las and ..syn files.

Note: Corrupt GeoSyn files in the target directory may cause   Directory 
Browser to crash.

To use Directory Browser
 1. Depending on whether you are searching for an existing synthetic or 

creating a new one:

 l File > Open., working with existing GeoSyn synthetic.

 l File > Import > Log Data, creating a new synthetic from an imported
 .las file.

 2. Select a directory path from the resulting dialogs Look in: folder drop 
down list .

 3. Click one of the action buttons at the bottom of the dialog:
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Synthetic Generation Modes

 l Browse dir, Opens the Directory Browser with files in current directory 
only.

 l Browse sub-dir, Opens Directory Browser with files in current directory 
and sub directories

 l Importor Open, Immediately opens the selected file without opening Dir-
ectory Browser.

 l File Viewer, Displays selected .las files   in text editor for viewing without 
Directory Browser.

The Directory Browser opens listing all UWIs in the selected path under the 
appropriate survey system tab. 

 4. Select the desired   survey system tab and then click a column header 
to sort rows based on   the values in that column or change the column 
order by clicking transpose   ( ) between two columns to swap.
To   remove UWIs that appear outside of a certain geographic boundary, 
select   Filter then click Edit   to display the Edit   a UWI dialog box and 
specify the coordinates for the area within   which to display UWIs.

 5. Right-click a   row to view a popup window with basic log details. 

 6. Select the row   to open or import into GeoSyn file and click Open. Addi-
tionally you can:

 l Click a column header to sort rows based on   column values

 l Change the column order by clicking transpose    between two columns to 
swap

 l Remove UWIs   that appear outside of a certain geographic boundary

 l Select Filter   then click Edit to display the   Edit a UWI   dialog box and spe-
cify the coordinates for the pane within which to display   UWIs.

 l Right-click a   row to view a popup window with basic log details.

 l Click Report   to display the Browser   report dialog box.

Related topics
"Opening GeoSyn synthetics" on page 8
"Importing LAS or GeoSyn files" on page 14

Changing import defaults
Import the control path settings and display parameters for everything in a new 
synthetic except logs from a default file. Log default settings   are instead 
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Synthetic Generation Modes

controlled by a centralized log database with one exception:   when you update a 
default file with settings from the current synthetic,   settings for the logs in the cur-
rent synthetic are also saved to the import   defaults file and override, but don't 
overwrite settings in the log defaults   database. For details on changing log dis-
play, see Related topics below.

Create multiple import default files with a .def   extension in the GeoSyn Working   
directory and then apply these defaults to a given synthetic when you launch it. 
For example, you could create unique default files for several different projects 
with differing criteria, or several default files for the same project that you switch 
between to view different scenarios.   

Defaults can either be applied to the current model, or the parameters set in the 
current model can be applied to a default file that you then save for future use.

To change import defaults:

1. From the Edit menu, select Default   synthetic properties ( ) > Import   
Defaults.

The Properties: Import Defaults   dialog box opens.
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Synthetic Generation Modes

2. Select an import   defaults file to modify in the Current   default file drop-down list 
or click New   to display the New   default file name dialog box and type a name for 
the file you will create. The new   import defaults file inherits the settings of the cur-
rent synthetic. 

To   apply changes that you've made in the current synthetic to the default file that 
other GeoSyn synthetics use, select the file in the Current   default file box, then 
click Update beside the Update current default file with model label.

To   apply parameters from a default file to the current synthetic, select the default 
file in the Current   default file box, then click Update    beside the Update synthetic 
with current default file label. 

The nodes in the import defaults file tree display   settings from the selected file. 
Click to expand nodes and view their   settings. 

3. From the Edit Specific   parameters drop-down list, select the synthetic prop-
erties to change   (general synthetic, model, seismic, well, crossplot, tops, and 
user paths).

4. Configure the   properties as desired then click OK   to return to the Properties:   
Import Defaults tab.

5. Click Close   to return to the main synthetic display with your changes applied.

The import defaults file listed in the Current   default file drop-down list is auto-
matically selected next time   you launch GeoSyn and applies to all future syn-
thetics derived from imported   logs.

Related topics
Configuring   GeoSyn Defaults
Changing   Log Defaults
Reformatting   GeoSyn and LAS Files

 

Importing LAS or GeoSyn files
GeoSyn enables you to create a synthetic by importing   raw log data from LAS or 
GeoSyn files. Creating synthetics from   a GeoSyn file is different than opening a 
GeoSyn synthetic because only log information and no formatting is saved in the   
imported file. 
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Synthetic Generation Modes

When you import a GeoSyn or LAS file, GeoSyn renders   the file using the settings 
in the import defaults file and loads the   formation tops defined in the well from 
your local AccuMap system tops   and AccuMap user tops databases. 

There are two ways to import log data into GeoSyn:

 l Drag and drop a single LAS file  onto the main GeoSyn display. 

 l Use the Import log data wizard 

To import LAS or GeoSyn files using the Iog import wizard:
 1. Start the log import wizard,  FIle > Import >Log data.... This opens 

the Import log data   dialog box 

 2. Select the root   directory or drive from the Look in   drop-down list then 
double-click folders in the display pane and browse   to the directory 
that contains either the desired files or the subdirectories   with those 
files. To filter the type of files displayed, from the File filter drop-down 
list, select a   file format extension.

3. Either click Browse dir. or Browse   sub-dir to launch Directory   Browser, or 
simply select the desired file in the display pane. 

 o For   LAS files, you can inspect the raw data in an ASCII text editor before   
importing the file by clicking File Viewer.   

When you select the file, details appear in the   LAS or   GeoSyn format file pane.

4. In the well tree,   select whether to import specific logs. A check mark ( )   
appears beside logs that will import, a cross ( ) beside those   that won't. For 
wells with numerous logs, toggle the group by clicking   All (  or ) depending on 
whether to import or ignore the majority of   logs, then toggle the individual logs to 
import or ignore.

5. Specify whether   the selected log(s) is in Measured Depth or True Vertical 
Depth units   so that GeoSyn correctly places the formation tops from the AccuMap 
system   tops and user tops databases, and then click Import.

If you ignore the sonic log or one isn't available,   GeoSyn automatically creates a 
straight line (constant velocity) sonic   log. For details on manually   editing logs, 
see Related topics below.
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If the import file has missing or invalid data   such as an invalid UWI or log alias, 
GeoSyn enables you to correct it   during the import. For details,   see Related topics 
below.

Related topics
"Opening GeoSyn synthetics" on page 8
"Changing import defaults" on page 12
"Using Directory Browser" on page 10
"Changing log display properties" on page 52
"Correcting invalid data when importing" on page 27
"Reformatting GeoSyn and LAS files" on page 188
"Drawing straight edge and freehand curves" on page 59
"Clipping or filtering logs" on page 75
"Applying math equations to logs" on page 77
"Cutting logs" on page 80

Importing directional surveys
Import and modify a directional survey saved   in ASCII, GeoGraphix, or Open 
Works format, or create one from scratch   by typing measured depth, dip, and azi-
muth values. 

If a well from the IHS Information Hub has a directional   survey available and 
you're licensed to access them, you can save it to   disk while downloading the log 
and then import it into GeoSyn. For details,   see Related topics below.

To import a directional survey:

1. From the File menu, select Import   > Directional survey. 
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The Measured Depth to True Vertical Depth   correction   dialog box opens.

2. Either click Import Survey and   browse for the desired directional survey file 
or type individual   depth, dip, and azimuth values in the dialog box above and click 
Insert.

If importing a check shot file, complete the bulleted   steps otherwise continue to 
step 3.

The Import   Directional Survey dialog box opens. You can also launch this   dialog 
box from the Well   Properties: Well properties tab.

Browse   to the file to import then click Open.
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The Highlight first line   dialog box opens.

Select   the first line to import and click Next.

The Highlight last line   dialog box opens.

Select   the last line to import and click Next.
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Synthetic Generation Modes

The Set column delimeters   dialog box opens.

Set the   column delimeters ( ) by clicking in the display pane between   required 
columns. The green line cannot bisect a data column. Double-click   column delim-
iters to delete. 

Click the   box that appears below each delimeter to display the 
Select   from List dialog box and identify the data type then click 
Next.
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The Finish   dialog box opens.

Click Finish.

The Measured Depth to True Vertical Depth   correction   dialog box opens, pop-
ulated with the typed or imported values.

3. Do any of the   following:

To modify or add values, select the row to replace,   or type values in the MD, Dip, 
and Azimuth   boxes, and then click either Update   or Insert.
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To delete a row, select it in   the display pane and click Delete   or click All to clear 
the entire   display pane.

To save the display pane to an   ASCII format file, click Save Report.

4. Click Apply   and Closeto complete the import.

GeoSyn imports the data and displays the deviated   synthetic in the main syn-
thetic display, where you can adjust the azimuth   of the projection using the Well   
Properties: Directional Survey tab. For details see Related topics below.

Related topics
"Viewing deviated well properties" on page 51
"Downloading logs from the IHS information hub" on page 41

 l placeholder

 l All Files

You are here: 

Importing check shot surveys and vertical seismic 
profiles
Apply a check shot correction to a GeoSyn synthetic by importing an ASCII 
format file or create one from scratch by typing time and depth values for indi-
vidual check shot pairs. 

If the well to be check shot corrected also requires a directional survey cor-
rection, apply the directional survey first. For details, see Related topics below.

To import check shot surveys and VSPs:

1. From the File menu, select Import >Check Shot or VSP Survey.
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The Import Data   dialog box opens.

2. Either click Import and browse   for the desired check shot survey file or type 
individual time   depth pairs in the Time and Depth boxes, and then click Insert.

 a. If importing a check shot file, complete the bulleted   steps otherwise 
continue to step 3.

The Import   Check Shots dialog box opens.
 l Browse   to the desired file.

To view and modify the contents of an ASCII file   before importing, click File 
Viewer   to display the file contents in an ASCII text editor.

 l Browse   to the file to import then click Open.
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The Highlight first line   dialog box opens.

 b. Select   the first line to import and click Next.

The Highlight last line   dialog box opens.

Select   the last line to import and click Next.
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The Set column delimeters   dialog box opens.

Set   the column delimeters ( ) by clicking in the display pane   between 
required columns. The green line can't bisect a data column. Double-click   
column delimiters to delete. 
Click   the box that appears below each delimeter to display the Select   from 
List dialog box and identify the data type then click Next
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The Finish   dialog box opens.

Click   Back to change any previous selections   or click Finish.
The Import Data   dialog box opens, populated with the typed or imported val-
ues.

3. Do any of the   following:

 l To modify or add values, select the row to replace,   or type values in the 
Time and   Depth boxes, and then click either   Update or Insert.
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 l To delete a row, select it in the display pane and   click Delete or click All   
to clear the entire display pane.

 l To save the display pane to an ASCII format file,   click Export.

4. Click Next.

The Define Datums   dialog box opens. It's very important to properly define the 
datum parameters   of the check shot data.

5. Define the datum   parameters then click Next.
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The Shift Time Zero   dialog box opens. If you don't change the datum, synthetic 
time zero   will be at the check shot time datum.

6. Select the appropriate   options then click Apply and Close to   complete the 
import. 

Click Undo in the above dialog box to go back and select different settings.
 

Note: The changes applied above are also visible in the Time Datum Prop-
erties dialog box. If a layer was already added above the model using the 
Time Datum Properties dialog box, the check shot import process adds an 
additional zone to that dialog box. See Related topics for details.

Related topics
Importing directional surveys
Changing time datum properties
Check shot computation
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Correcting invalid data when importing
Warning messages allow you to correct information during an   import if:
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 l kelly   bushing or depth increment of the imported file and the current syn-
thetic   don't match.

 l the UWI is missing or invalid

 l specific logs are missing

 l log aliases   are missing or unrecognized

 l sonic and density log units don't match

Note: You can change general synthetic display properties if   you don't 
want to be notified of missing or an invalid UWI or unrecognized   log 
aliases. 

 

Problem Resolution

Kelly   bushing  and the current 
synthetic   don't match.

GeoSyn offers to automatically depth shift 
the imported   log to match the kelly bushing 
depth of logs in the current synthetic.   Altern-
ately, you can change the kelly bushing 
depth for the current synthetic:

Missing or invalid UWI  l Modify the UWI and or labels before 
continuing. 

 l Ignore the UWI and build the   synthetic.

Missing or invalid log alias Logs associated with the GENERAL   alias may 
not display correctly and GeoSyn won't 
recognize them as logs  of importance (sonic, 
density, etc).

The sonic log is missing GeoSyn can create a constant velocity sonic 
log.

The sonic log has invalid 
data.

GeoSyn can either reduce the sample rate 
until the integrated   sonic data falls below 
the program limits or abandon the import.

The sonic and density units 
don't match.

GeoSyn issues a warning and automatically 
corrects the   problem.

Importing data into a pre-
existing synthetic with dif-
ferent   parameters (different 
KB, different depth incre-
ment, etc.) than the impor-
ted   file. 

GeoSyn issues a warning and can correct all 
the problems   before you import the data.
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Related topics
"Importing LAS or GeoSyn files" on page 14
"Configuring GeoSyn defaults" on page 6
"Changing log defaults" on page 54
"Downloading logs from the IHS information hub" on page 41
"Launching GeoSyn using AccuMap" on page 35

Importing wells from Kingdom
Import a well into GeoSyn from IHS Kingdom in order to create synthetic models 
based on Kingdom wells or seismic. 

When launched from Kingdom, a sub directory named GeoSyn is created under 
the Kingdom project directory. All GeoSyn data associated with the created 
model is written to this location.

To import well(s) from Kingdom:
 1. Right click on a single well from the Kingdom Base Map or the Project 

Tree.

 2. Select GeoSyn ... from the context menu. GeoSyn  will launch and dis-
play the Quick Start and GeoSyn mode dialog.

 
 3. Select mode:

 l Modeling: Time objects are placed by reference to a velocity 
field derived from the sonic log. Time data points are discarded 
after import. Click Details... button for advantages and dis-
advantages of this option.

© 2020 IHS Markit™. All Rights Reserved 29



Synthetic Generation Modes

 l Correlation: Time objects are placed by reference to a velocity 
field derived from saved time depth charts. The correlating seis-
mic procedure is simplified but users should restrain from over 
editing the time depth chart. Click Details... button for advant-
ages and dis-advantages of this option.

 4. Select import option:
 l Quick Start

 l Detailed.

 5. Click OK.
 l Quick Start, imports log and creates model. The model is  ready 

for editing.

 l Detailed, Continue to Detailed Import steps below.

Detailed Import steps:
The Kingdom Data Browser dialog box opens if Detailed was selected.
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 1. Filter the results displayed in the drop-down list near the top of the dia-
log in which you select the wells by clicking check boxes to the right of 
the Hide if well label, and select the columns to display in the Model 
Options pane by clicking check boxes to the right of the Identify by 
label.

 l Where the well includes a directional survey, select whether to convert it 
to true vertical depth. 

 l If you selected a model above, an Open button appears in the bottom-
right of the above dialog box and when clicked, immediately opens a new 
or existing GeoSyn synthetic.

 l If you selected Log(s) above, the Next button appears in the bottom-
right of the above dialog box that when clicked, displays the  Kingdom 
Data Browser dialog box, where you apply corrections to the data and 
select display options for the resulting model before launching GeoSyn.
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 l Make selections in the dialog box above and then click Apply. If you tie 
the synthetic to a single depth point, click View and Edit to display the 
Time/Depth Quality Control dialog boxes where you apply changes to the 
time depth curve before applying it to the sonic. 
Note: In order for changes made using the Time/Depth Quality Control 
dialog boxes to be applied, upon exiting that dialog box, when the Save 
Modified Time/Depth Chart dialog box opens, you must click Save. 

 l The synthetic is created based on the well imported above. The above 
dialog box remains visible and the Apply button changes to an Undo but-
ton in case you want to apply different data correction options or select a 
different depth chart. The Back button also remains active in the above 
dialog box so that you can add additional logs to the model. If importing 
additional logs, GeoSyn warns you so that you don't inadvertently apply 
the same time depth chart twice.

 2. Tie the imported seismic section to a model (for details, see Related 
topics below).
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 3. From the File menu, click Save. 
This option is only available in GeoSyn when it's launched from King-
dom.

The Save Model Data dialog box opens.

 4. Specify the outputs to save that can be used by Kingdom, and then 
click Save. 

Related topics
"Tying seismic to models" on page 164
"Importing check shot surveys and vertical seismic profiles" on page 21
"Importing LAS or GeoSyn files" on page 14

Importing seismic from Kingdom
Import Kingdom data into GeoSyn to create a synthetic. Tie the seismic data to a 
well and extract a wavelet. Before importing seismic from Kingdom, you first 
import a well. For details on importing a well, see Related topics below.
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To import Seismic from Kingdom:

1. From the File menu, click Kingdom Import and then Seismic Data. The 
Import Kingdom Seismic dialog box will open.

2. Select either the 2D seismic or 3D seismic tab depending on the type of seismic 
to import. The number of seismic sections available is denoted in the label of the 
tab.

3. Populate the dialog box fields, and then click Import.

Related topics
"Import Kingdom Seismic: 2D" on page 219
"Import Kingdom seismic: 3D" on page 220
"Changing seismic properties" on page 162
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"Importing seismic data" on page 158
"Importing wells from Kingdom" on page 29

Launching GeoSyn using AccuMap
Right-click a well that appears in AccuMap and   launch GeoSyn. If the well you 
select doesn't have a sonic log, GeoSyn   generates a constant velocity sonic log 
that you can manually edit later. For details, see Related topics   below.

To launch GeoSyn using AccuMap:

1. In AccuMap, with   the desired Detail Map and the Wells layer displayed, click 

the button   below the Inspect tool and select   Wells ( ).

2. Click the Inspect tool to activate Inspect mode.

The cursor changes to a magnifying glass ( ).

3. Right-click the   desired well and select GeoSyn Launch   from the popup menu.

The Define search range   dialog box opens.
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4. Click either Add Location or Add   Range to display the Edit a UWI   dialog box 
and specify the survey system and coordinates of the well(s)   for which to retrieve 
logs. 

To change your IHS Information Hub   connectivity parameters or GeoSyn default 
directories, click Edit   online configuration to display the Configuration   tab. For 
network installations, hub connectivity parameters affect all   GeoSyn users.

5. Click Next.

The Select data from catalog   dialog box opens.

6. Click Display layout   to configure the options with which to sort and filter the 
wells that   appear above. For example, by column order, row order, by the pres-
ence   of digital sonic and density logs, and by depth range.

A check mark ( ) appears beside logs   that will import, a cross ( ) beside those 
that won't. Logs   with true vertical depths and measured depths can't be selected 
for the   same import.

7. Click Next.
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The Define save options   dialog box opens.

8. Select the locations   in which to save downloaded files and whether to convert 
downloaded logs   into GeoSyn format using the import defaults options. These 
options are   defined in the Properties:   Import Defaults dialog box, which can be 
accessed by clicking Edit Defaults above.

9. Click Next.

The specified logs are downloaded from the IHS   Information Hub and the results 
are listed in a summary report   dialog box that can be saved to an ASCII format 
file to log downloads.

10. Click Close.

Related topics
"Changing import defaults" on page 12
"Importing LAS or GeoSyn files" on page 14
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Launching GeoSyn using PetraSeis
Right-click a well in PetraSeis for which to create a synthetic in GeoSyn. Using 
PetraSeis, you specify the curves and tops to include in your synthetic. You can 
also include a seismic line and a directional survey.

GeoSyn projects you launch using PetraSeis can be exported back to PetraSeis 
from GeoSyn. For details, see Related topics below.

To launch GeoSyn using PetraSeis:

1. Using the PetraSeis application, right-click the well for which to launch GeoSyn 
and select Start GeoSyn.
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The GeoSyn Settings dialog box opens.

2. Select the desired log(s) and tops to import into GeoSyn, and then click OK. 
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The Import data for Well dialog box opens.

Any data that PetraSeis includes that can be used in GeoSyn appears in this dia-
log. 

3. Verify the import options, select a log from which to use the depth increment, 
and then click OK.

Depending on whether you're importing a seismic line or a directional survey, 
either the Set time and range for or the directional survey dialog box opens. For 
details on importing seismic or directional surveys, see Related topics below.

Related topics
"Importing seismic data" on page 158
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"Importing directional surveys" on page 16
"Exporting to Petra" on page 197

Downloading logs from the IHS information hub
With a subscription to the IHS Information Hub,   you can select a specific UWI or a 
range defined by NW and SE corners   from which to download select logs. 
Licensed users can also download directional   surveys and request IHS digitize ser-
vice   curves.

Note: If your subscription is transactional, GeoSyn can warn   you before down-
loading digits from the hub to eliminate unexpected charges.

To download logs from the IHS   information hub:
 1. Launch the Data Search Wizard: File > Import > DataSearch wiz-

ard

 2. Select a  location or range of logs to retrieve and click Next. 

 l Click Add Location or Add   Range to open a UWI dialog to enter specific 
UWI or range of UWIs.

 l Select a previous UWI search from the drop down list.
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 3. Select UWI or range from results box.

 4. Select IHS Direct Connect data for your data source and click Next. 
Search results are displayed Select data from catalog   dialog box opens 
with search results.

4. Click Display Layout   to show and configure  filter options.

A check mark ( ) appears beside logs   that will be imported.

Logs   with true vertical depths and measured depths can't be selected during   the 
same import.

5. Click Next.
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The Define save options   dialog box opens.

6. Select the location    to save downloaded files and whether to convert down-
loaded logs   into GeoSyn synthetic format during the download. The above options 
are   defined in the Properties:   Import Defaults dialog, which can be accessed by 
clicking Edit Defaults above.

Note: If you save logs to disk and then import   them into the model from disk, 
you can restrict the depth range.

7. Click Next.

The specified logs are downloaded from the IHS   Information Hub and the results 
are listed in a summary report   dialog box that you can save to an ASCII format 
file to log downloads.

8. Click Close.

Related topics
"Changing import defaults" on page 12
"Launching GeoSyn using AccuMap" on page 35
"Importing LAS or GeoSyn files" on page 14
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Viewing synthetic statistics
View statistics about imported logs including   the original raw data and the res-
ulting integrated data following import.   The minimum and maximum raw values 
enable you to determine whether there   are spikes in the imported log that influ-
enced your synthetic that you   can subsequently remove using the Log Editor.

 To view project statistics:

1. From the Edit menu, select Default properties ( ) > Statistics.

The Properties: Statistics   tab appears.

2. Click the appropriate   log in theData Ranges list and   view the Raw and Integ-
rated values.

3. Click Close.

Related topics
"Changing the main synthetic display" on page 46
"Importing LAS or GeoSyn files" on page 14
"Opening GeoSyn synthetics" on page 8
"Launching GeoSyn using AccuMap" on page 35
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About the Main Synthetic Display
The main synthetic display is where you do analysis.   When you launch GeoSyn, 
the main synthetic display appears as a blank   canvas. After you import a log 
image or launch an existing GeoSyn synthetic,   labels, logs, a tops table, and 
traces appear as depicted below.

Elements in the main synthetic display can be moved,   copied to and from the Win-
dows clipboard, hidden, deleted, resized, and configured.   Right-click, double-
click, or use the main menu to configure individual   elements. Drag and drop to 
reposition them on the canvas. If you resize an element larger than the canvas, 
the canvas automatically resizes to accommodate the new size.
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The status bar beneath the 
main synthetic display shows   
time, both kelly bushing and 
subsea depth, and details 
about the synthetic   element 
beneath the cursors current 
position. For example, if the 
cursor   is over a top, the top 
name appears. If the cursor 
is over a trace, the   filter and 
phase appears. To toggle the 
status bar, from the View 
>Statusbar.

Any number of logs defined as sonic or density may be   included in a synthetic, but 
GeoSyn only uses a single sonic and a single   density to create the synthetic. 
These logs are called the active sonic   and active density, and are clearly labeled 
on the main synthetic display.   The active sonic and density logs control the gen-
eration of the synthetic.

Transfer the active status to any log (not just   other sonic or density logs). Trans-
ferring the active status is ideal   for modeling purposes, because it enables you to 
rapidly shift between   sonic and density logs representing different geological 
scenarios.

Related topics
"Changing well display properties" on page 50
"Changing the main synthetic display" below
 

Changing the main synthetic display
Configure general options in the main synthetic   display including:

 l elements to display

 l vertical scale properties

 l zone of interest

 l number of undo levels.
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Once the synthetic has been configured, you can   save those display options to 
the import default file and apply them to all new synthetics. For details, see 
Related topics below. 

To change the main synthetic   display:

1. Open the Synthetic Properties   dialog box:

 l Menu: Synthetic properties

 l Toolbar: ( )

 l Main display well header : Right click and selectSynthetic properties.. 

 2. In   the Display elements pane, select   what informational elements 
appear in the main synthetic display. To import   a company logo, beside 
the Image banner   box, click Edit.
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 3. In   the General model parameters pane,   specify sample rates, up to 
10 undo limits, and whether the import process   prompts you when 
either missing or invalid UWIs or aliases are found in   the import file.

 4. In   the Vertical scale pane, select   either the time or depth and in the 
Plot   range pane, type the top and bottom of the zone of interest to   dis-
play.

 5. Click Close   to apply the changes to the main synthetic display. These 
changes only   apply to the current synthetic.

Related topics
"About the Main Synthetic Display" on page 45
"Changing import defaults" on page 12

Zooming
Draw the boundary upon which to zoom in the main   synthetic display. 

To zoom:

1. From the View menu, select Zoom In ( ).

The cursor changes to a magnifying glass ( ).

2. Click and hold   one of the corners that will become your zoom extents then drag 
the zoom   rectangle to the opposite corner and release the mouse button.

3. Either repeat   the above steps to zoom in further or from the View   menu, select 
Zoom Out ( ) to return to the previous view. If you've zoomed in multiple   
times, each time you zoom out returns to the previous view. To return   to the ori-
ginal unzoomed view, from the Edit   menu, select Undo ( ).

Related topics
"About the Main Synthetic Display" on page 45
"Changing the main synthetic display" on page 46
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Undoing and redoing changes
An operation can be undone even if you saved the synthetic after performing the 
operation that you now wish to undo. Undo ( ) and redo ( ) buttons appear both 
on the main toolbar and on the Log Editing toolbar. Note that the undo and redo 
buttons on the Log Editor toolbar affect any operation done throughout GeoSyn, 
not just those that were done using the Log Editor. To hone in on a specific 
change to either undo or redo, click Edit > Undo or Redo.

Related topics
"About the Main Synthetic Display" on page 45
"Changing the main synthetic display" on page 46
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Display Properties
There are several ways to output GeoSyn data:

"Changing well display 
properties" below

Well display properties include   UWI, labels, and 
depth parameters.

 Modify directional properties after   importing a dir-
ectional survey.

Changing well display properties
Change well display properties including the   UWI, labels, and depth parameters.

To adjust well display properties:

1. From the Edit menu, select Well and Log Properties ( ).

The Well Properties: Well properties   dialog box opens.

To   change label text, simply type it in the adjacent field, click Edit   to display the 
Edit a UWI dialog box, or select a different well symbol from the Status drop-
down list.
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To   import a directional survey in .txt   format or to create one from scratch, click 
Import   directional survey. For details, see Related topics below.

To   change tops display properties, click Edit   to display the Tops Properties dialog 
box. For details, see Related topics below.

2. Select the desired   options then click Update All.

Related topics
"Viewing deviated well properties" below
"Changing tops properties" on page 89
"Importing directional surveys" on page 16

Viewing deviated well properties
The Directional properties tab provides a view of a selected seismic line  relative 
to the well bore. The view provides the option to select individual traces or none 
from a drop down list.

The calculated offset between the TVD and the KB is represented by a colored dot 
along the well bore.  The dots color changes according to the depth of the cal-
culated offset. 
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Related topics

Changing   Well Display Properties

Changing log display properties
Change the display properties of logs in the   current synthetic including label 
information, which logs are the active   sonic and density, and other details. The 
term Active   denotes the log upon which the synthetic is based. If you have sev-
eral   sonic logs with different geological scenarios in one synthetic, for example,   
you can switch which of the sonic logs is the active one to see what affect   it has 
on the model. 

You can also create new logs or duplicate and modify   existing logs. For example, 
you can apply a mathematical equation to a   log to derive a log that's useful for 
AVO modelling and that would otherwise   not be available. Changes you apply 
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affect only the current synthetic,   not log defaults for new synthetics. For   details 
on changing log defaults and import defaults, see Related topics below.

To change log display properties:
 1. From the Edit menu, select Well and Log Properties ( ) > Log 

Properties.

The Well Properties: Log properties   dialog box opens.

 2. In the display   pane, select the log(s) to modify using the controls 
below. SHIFT+CLICK   or CTRL+CLICK for multiple selection. 

Duplicate and modify selected logs, and   also clear logs in the Show column   
to save them with the synthetic but hide them from the main synthetic   dis-
play.

 3. In the Properties   common to all logs pane, specify label and scale 
information and   whether multiple logs are combined in the same track.   
For details on combining logs in the same track, see Related topics 
below.

If   the synthetic layout is only a single log per track, specify track and   infill 
colors. For details   on editing color, see Related topics below.
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 4. In the Log properties pane, specify log associations such as the type 
of log,   whether it's the active sonic or density, and whether it meas-
ures transit   time or velocity, and then click Close.

Related topics
"Changing log defaults" below
"Changing import defaults" on page 12
"Changing color palettes" on page 131
"Combining logs in tracks" on page 62

Changing log defaults
GeoSyn maintains a centralized database of log defaults   for all log types. Cus-
tomize settings for track widths, scales,   aliases, color fills, and more. These set-
ting apply to new synthetics   where log settings aren't already defined in the 
import defaults file.

The import defaults file generally contains all default   settings except those that 
apply to logs, but when you update the import   defaults file with settings from the 
current synthetic, settings for log   types in the current synthetic are also written 
to it. Log settings in   the import defaults file override, but don't overwrite settings 
in the   log defaults database.

When GeoSyn creates a synthetic, it first checks whether   display settings for the 
log upon which the synthetic will be based exist   in the current import defaults file. 
If they do, GeoSyn uses them instead. For details on changing import defaults,   
see Related topics below.

The log database is the LogInit50.gld   file in the GeoSyn Working directory.

To change log defaults:
 1. From the Edit menu, select Default   log properties > Log Libraryto 

open the Properties: Log Library   dialog box.
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 2. In the tree display,   click the plus sign (+) beside   the appropriate node 
to expand it and view current configuration details.

 3. Click Edit to open the Edit Default Display Properties dialog box.
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 4. Configure the   curve properties then click OK   to return to the Prop-
erties:   Log Library tab.

 5. Click Alias  priority to open the Set Log Alias Selection Priority dialog 
box.

 6. Configure the default import priority for Alias (Type) of individual logs 
then click OK   to return to the Properties:   Log Definitions tab.

 7. Click Close   to return to the main synthetic display. The changes you 
made are applied   to future synthetics providing a different setting 
doesn't exist in the   import defaults file for that synthetic.

Related topics
"Changing import defaults" on page 12
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Building equations using the log equation 
library
A library of standard functions or equations ships with GeoSyn. While you can't 
overwrite the default equations in this library, you can copy them as user func-
tions and then modify or delete them. Because the function library is centralized, 
any GeoSyn synthetic can access the equations you create. 

GeoSyn users with their own equations created with versions of GeoSyn before 
the function library was introduced can open the synthetics that contain these 
equations and save the equations to the function library so that they're available 
to all synthetics.

The general Log Equation Library dialog box, which is used to create equations for 
any log type, is accessed through several different dialog boxes available from 
the Edit menu. You can also invoke the Log Equation Library dialog box for only a 
specific log using the Well Properties > Log Properties dialog box.

To create log equations:

1. Launch the Log Equation Library dialog box by selecting one of the following:

Edit > Log Editing > Log Math ( ), and then click Edit.

Edit > Configuration Properties > Log Library, and then click Edit Curve 
Equations.

Edit > Default Synthetic > Log Library, and then click Edit Curve 
Equations.

Edit > Default Log Properties > Log Library, and then click Edit Curve Equa-
tions.
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The Log Equation Library dialog box opens.

2. From the Log type drop-down list, select the log type with which to associate 
the equation you create. The equation is grouped under this log type to facilitate 
selection from drop-down lists.

3. Do one of the following:

Select an existing equation upon which to base your new equation from the Log 
function drop-down list and then modify the equation parameters using either of 
the next two options.

Drag equation elements from the three equation panes into either the Metric or 
Imperial boxes.

Simply type your equation directly in the Metric or Imperial boxes.

4. Depending on whether you created your equation in the Metric or the Imperial 
box, click Down or Up to copy it to the adjacent box and then modify your equa-
tion with a conversion factor.

5. In the first box of the Descriptions, type a description of the equation function. 
You may even want to paste the equation from the Metric or Imperial box into 
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here as a description. What you type here populates the Log function box when 
you click either Update or Add.

You may want to type additional details in the second description box. Text you 
type here only appears in the Log Equation Library dialog box.

6. Click Add (if you're updating a previous user equation instead of creating a 
new one, you can click Update instead). And then click Close to exit the Log Equa-
tion Library dialog box.

Related topics

Applying Math Equations to Logs

Drawing straight edge and freehand curves
Draw a single segment straight line or multi-segment   freehand line to replace a 
curve portion.

To draw straight edge and freehand   curves:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.

2. Click either the   straight line ( ) or freehand tool ( ).

3. Hover the cursor   (  or ) over the location at which to draw   a line. The 
cursor position appears in the banner of the Log   Editor.

4. Starting at the   top or bottom of the log portion to change, drag to draw the line. 

5. Click End Draw in the popup dialog box to complete the line.

Related topics
"Creating blocked log models" on page 65

Inserting log sections using log editor
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Create a section of log with a constant value and insert   it at a specific depth to 
provide a time datum shift or to provide room   for new geological section. You can 
also specify whether to raise or lower   the log start depth or stop depth to accom-
modate the insertion.

When you insert a section in any log, new data is inserted   in all logs throughout 
the synthetic. Specify different constant   values to insert in each of the individual 
logs. An option to doing the below process is to add one or more invisible zones 
above the log, the sum of which is recognized in all related GeoSyn calculations 
such as AVO analysis. Invisible zones are added using the Edit > Time Datum 
option. For details, see Related topics below.

To insert log sections using Log Editor:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.

2. Select the tab   for the log in which to insert a log section and in the Log Editor 
toolbar,   click the Insert Section tool   ( ).
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The Insert Constant Value Log Section   dialog box opens.

3. Hover the cursor   ( ) at the top of the zone at which to insert a log section.   
The cursor position appears in the banner of the Log   Editor. 

4. Drag to the bottom   of the zone.

5. In the Insertion   point pane, type a more precise depth at which to insert the log 
section   or click top or bottom   to select the absolute top or bottom of the log. 

6. In the Insertion   range box, type the thickness to insert. This section is inserted 
in every   log throughout the synthetic.

7. In the Insertion   values display pane, select a log to display the constant value 
that will   be inserted in the Edit log insertion value box and each of the logs.   Type 
a different constant value if desired.

8. Select whether   to raise the start depth or lower the stop depth and click Apply.

Related topics
"Cutting logs" on page 80
"Shifting logs" on page 84
"Changing time datum properties" on page 111
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Combining logs in tracks
Logs can either occupy separate tracks in the main synthetic   display or can share 
tracks to save work space. GeoSyn enables you to   specify the logs to display in 
up to ten tracks and can display an unlimited   number of logs in any track. The 
same log can be repeated in multiple tracks.

With a left and right log defined in the same track, select the Show cross over 
option and adjust the horizontal placement of the logs to infill areas where the 
two logs overlap, or where the curves exceed a given value.

Save composite log layouts with different configurations   as templates with a .tpl 
extension   in the GeoSyn Working directory.

To combine logs in tracks:

1. Do either of the   following:

If your current synthetic displays   multiple logs per track, right-click the track and 
select Multi-log per track Template properties.

If your current synthetic displays  only single logs per track, from the Edit   menu, 
select Well and log properties   ( ) > Log properties   to display the Log prop-
erties   tab and in the Properties common to all   logs pane, select Multiple logs / 
track then click the adjacent Edit   button.
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The Multi-log per Track Template   dialog box opens.

2. For the Populate tracks radio buttons, select either automatically by type 
(sonic, density, etc), or manually by name (Delta-T, Bulk Density, etc.) depend-
ing on the degree of control you want over which logs appear, and then click Edit.
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The Multi-log per track layout dialog box opens.

3. For each of the track columns, click the log type to display, and then click OK.

To ensure a log doesn't get dropped, click the All unselected linear logs and 
the All unselected logarithmic logs options.

The log types selected above are displayed in the various track tabs of the main 
Multi-log per Track Edit dialog box.

4. Using the Multi-log per Track Edit dialog box, for the tracks to display, click the 
Track tab, specify whether to show the track and select other criteria such as the 
track width, scale type, and so on.

5. In the log display pane click or clear Show as depicted below to display or hide 
a log in a given track.
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The Tracks column above displays the tracks in which a log appears. In the 
example above, the density log can be displayed in track 1. It also appears in 
track 3. The column to the right of the Log name column specifies whether the log 
appears in a track by default or was deliberately designated to appear in that 
track.

To fill areas where curve readings for two or four curves intersect within the same 
track, select the check box to the left of the drop-down lists in the Cross overs 
section and then select either logs that appears in your model or select fixed 
value depending on whether you want to infill where curves intersect, or where a 
curve exceeds a given value. Manually shift a curve by clicking  to the right 
of the curve drop-down list to enhance the cross over, or type a percentage by 
which to shift the log scales.

6. Type a descriptive   name in the Template name box   and click Save to write 
the   file to the current GeoSyn Working   directory with the name GSTemplateX.tpl   
where X is an incrementing number   based on the number of template files already 
in the Working   directory. When importing the template file in the future, whatever 
is   typed in the Template name box   appears as the file description.

7. Click Apply   to update the current synthetic with your changes.

Related topics
"Changing log display properties" on page 52

Creating blocked log models
Create log models consisting of simple blocked sections   that may be useful when 
modelling complex, tuned geology using the Model   Builder Wizard. Also block sec-
tions of existing logs using Log Editor   so that GeoSyn, working within the 
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highlighted zone, applies the mean,   median, or RMS value between two tops to 
each set of tops. 

Separate procedures for each appear below.

To create blocked log models:

1. From the File menu, select Import   > Make a blocked log well.

An informational dialog box opens. 

2. Click Next.

The Description and Output Options   dialog box opens.

3. Type any label   changes for the log, specify depth and measurement details, 
and whether   to write the blocked log to an LAS file or display it in a synthetic,   and 
then click Next.
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The Create New Layers and Logs   dialog box opens.

4. To define the   zone of interest, beside the Layers label, click Add and then 
select   the newly added cell in the Layer   column and type the name of the first 
formation top in the Edit box. Click the adjacent cell in the Depth   column and 
type the corresponding kelly   bushing depth in the Edit box.   

5.   In the Layers pane, click Add to insert a row below the formation   just added 
then complete the above steps for the inserted row.

6. Beside the Logs label, click Add to display the   Select from List   dialog box and 
select the type of log(s) to create for the zone of interest   defined above and click 
OK to return to the Blocked   Log Wizard dialog box.

7. Click Apply.

The blocked log appears in your synthetic.

To block portions of existing   logs using Log Editor:

1. From the Edit menu, select Log editing ( ).
OR
Right-click the log and select Log editing.
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The Log Editor   dialog box opens.

2. In the toolbar   beside the Log Editor, click the Blocking   tool ( ).
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The Log Blocking   dialog box opens.

3. Select the algorithm   used to derive a constant value, which can be used across 
the log or to the zone between shallowest   and deepest tops within your selection. 
GeoSyn automatically connects   your selection to the nearest top.

4. Select the log(s)   to block. CTRL+CLICK or SHIFT+CLICK for multiple selection.

5. Do one of the   following:

Drag the cursor ( ) on the Log Editor log display pane to select a range to   block.

Type values in the Depth range   KB pane for the start and stop depth and click 
Update

Click either Top   or Bottom to accept the absolute   depth from the log or click All   
to accept both.
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Click Depths from tops to display the Depth   Range from Tops dialog box and 
then select the formation tops that   signify your zone of interest from the drop-
down lists and click OK.

6. Click Apply.

Related topics
"Drawing straight edge and freehand curves" on page 59
"Inserting log sections using log editor" on page 59
"Clipping or filtering logs" on page 75
"Cutting logs" on page 80
"Applying math equations to logs" on page 77
"Shifting logs" on page 84

Stretching and squeezing logs
Stretch and squeeze a selected log portion in either   time or depth using the Log 
Editor, which displays the log view in depth,   or stretch it in time using the Cor-
relation Window, which enables you   to hover the log over seismic.

Stretch and squeeze functionality is also available when   tying seismic to models 
or by specifying values when importing check shot   surveys. For details, see 
Related topics   below.          

To stretch and squeeze logs:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.

2. Select the tab   for the log to stretch or squeeze and in the Log Editor toolbar, 
click   the Stretch Squeeze tool ( ).
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The Stretch/Squeeze log curves in time   dialog box opens.

3. Select whether   to stretch or squeeze the log in time or depth.

4. Do one of the   following:

Drag the cursor ( ) on the Log Editor log display pane to select a range to   stretch 
or squeeze. The cursor position appears in the banner of the Log Editor.

Type values in the Set depth   range KB pane for the start and stop depth and click 
Update

Click either Top   or Bottom to accept the absolute   depth from the log or click All   
to accept both.

Click Depths from tops to display the Depth   Range from Tops dialog box and 
then select the formation tops that   signify your zone of interest from the drop-
down lists and click OK.

5. Do one of the   following:

If you selected depth above,   type the desired thickness of the zone defined 
above after stretching   or squeezing. If the value is less than the difference 
between the start   and stop depth, the log will be squeezed. If more, the log will 
be stretched.

If you selected time above, type   a value by which to adjust the transit times for 
the zone defined above   and the number of samples over which to taper the 
change.
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6. Click Apply.

Related topics
"Changing import defaults" on page 12
"Changing log display properties" on page 52
"Exporting log aliases" on page 194

Merging logs
Merge an upper run with a lower run using the Merge Log Runs tool ( ) on the 
Log Editor by importing 

a log in either LAS or GeoSyn format. You can also use the Math tool or the Com-
posite Log tool to merge runs; however, the Merge Log Runs tool is the simplest 
and quickest method.      

To merge logs:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.

2. Using the Log Editor toolbar, click   the Merge Log Runs tool ( ).
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The Import Log Data dialog box opens.

3. Select the log file to merge with the existing log, and then click Import.

A warning dialog may appear warning of a mismatching kelly bushing depth 
between the two logs. Continue to import the log file and change the kelly bush-
ing depth of the imported well using the Merge Log Runs dialog box that appears 
below.
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The Merge Log Runs dialog box opens.

4. Using the Host and Donor panes that appear in the bottom-left of the Merge 
Log Runs dialog box, select the log to merge with and the imported log to merge 
in either pane.

The display in the Unmerged Logs display pane updates to reflect the relationship 
of the two selected logs.

To set the area of interest, to the left of the Show label at the bottom of the 
Merge Log Runs dialog box, specify whether to show the entire depth of both log 
runs in the Unmerged Logs display pane, or just the depth where they overlap. 

To clarify the display, enable or disable the Scales check box to specify whether 
horizontal and vertical scale lines appear in the Unmerged Logs display pane. 
Click the Zoom buttons to the right of the Unmerged logs display pane to change 
the zoom resolution. 
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To set the specific point at which to merge the logs, either drag the slider to the 
left of the Unmerged Logs pane (or drag the display pane), or type a specific 
depth in the box to the right of the Merge at button below the Unmerged Logs dis-
play pane and then click Update.

Specify whether to include tops from either (or both) the host or donor well.

5. Click Merge at to perform the actual log splice.

The spliced log appears in the Merged Logs pane in the right portion of the Merge 
Log Runs dialog box with merge details in the table below the Merged Logs dis-
play pane.

6. Either complete the above steps for additional logs to merge in the GeoSyn 
well,
OR
Click OK to return to the Log Editor.

Related topics
"Creating log composites" on page 81
"Applying math equations to logs" on page 77

Clipping or filtering logs
Clip the data of either an entire log or a zone of interest   within that log to remove 
data spikes or incorrect data.

To clip or filter logs:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.

2. In the toolbar   beside the Log Editor,   click the Clip tool ( ).
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The Clip or filter the log   dialog box opens.

3. Select whether   to clip and filter by substituting values, removing spikes, or 
using filtering   methods.

4. Do one of the   following:

 l Drag the cursor on the Log Editor   log display pane to select a range to 
clip or filter.

 l Type values in the Select depth   range KB pane for the start and stop 
depth and click Update. Click either Top   or Bottom to accept the abso-
lute   depth from the log or click All   to accept both.
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 l Click Depths from tops to display the Depth   Range from Tops dialog 
box and then select the formation tops that   signify your zone of interest 
from the drop-down lists and click OK.

5. Click Apply.

Related topics
"Applying math equations to logs" below
"Creating blocked log models" on page 65

Applying math equations to logs
The Log Math dialog box enables you to generate derived logs based on readings 
from other logs as inputs. To derive these logs, you can use either industry-stand-
ard equations provided by GeoSyn in the Log Equation Library, or you can create 
your own customized equations that are then saved to the Log Equation Library.

Any log can be used as an input for the derived log equation. For example, you 
can use a common sonic log, or derive a log and then use that derived log as an 
input in the equation from which you derive yet another log. For details about mer-
ging log runs, see Related topics below.

About the Function Library
A library of standard functions or equations ships with GeoSyn. While you can't 
overwrite the default equations in this library, you can copy them as user func-
tions and then modify or delete them. Because the function library is centralized, 
any GeoSyn synthetic can access the equations you create. 

GeoSyn users with their own equations created with versions of GeoSyn before 
the function library was introduced can open the synthetics that contain these 
equations and save the equations to the function library so that they're available 
to all synthetics.

The general Log Equation Library dialog box, which is used to create equations for 
any log type, is accessed through several different dialog boxes available from 
the Edit menu. You can also invoke the Log Equation Library dialog box for only a 
specific log using the Well Properties > Log Properties dialog box.
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To apply math equations to logs:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.

2. In the toolbar   beside the Log Editor, click the Math   tool ( ).

The Log Math dialog box opens.

To copy a portion of one log to another, enter the following equation XX=YY, 
(where XX is the recipient log and YY is the source log) drag the interval to copy 
in the source log, and then click Apply.

3. Do either of the following:
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To build an equation based an equation in the function library, select the equation 
from the Add a function from the library drop-down list,

and then do either of the following to modify the equation. If the desired function 
doesn't appear, click Edit to the right of the drop-down list to launch the Log Equa-
tion Editor dialog box and create it.

Type equation terms directly in the top box of the Compose an equation pane.

Select equation terms from the drop-down lists above the Add a function from the 
library drop-down list.

4. Using the Log Resolution pane, select a log from each drop-down list to the 
right of each equation term to associate a log with each term.

5. Do one of the   following:

Drag the cursor ( ) on the Log Editor log display pane to select a range to   
which to apply the mathematical equation.

Type more precise values in the   Depth range KB pane for the start and stop depth 
and click Update Click either Top   or Bottom to accept the absolute   depth from 
the log or click All   to accept both.

Click Depths from tops to display the Depth   Range from Tops dialog box and 
then select the formation tops that   signify your zone of interest from the drop-
down lists and click OK.
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6. Click Apply.

Related topics
"Building equations using the log equation library" on page 57
"Creating blocked log models" on page 65
"Clipping or filtering logs" on page 75
"Merging logs" on page 72

Cutting logs
Cut a section from a log and then either lower the start   depth or raise the stop 
depth so that either the tops below or above the   cut maintain accurate depths. 

You can also insert a constant value log section the   same thickness as the sec-
tion removed. For details, see Related topics below.

To cut logs:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.

2. In the toolbar   beside the Log Editor,   click the Cut tool ( ).

The Cut   dialog box opens.

3. Do one of the   following:

Drag the cursor ( ) on the Log Editor log display pane to select a range to   cut.
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Type more precise values in the   Depth range pane for the start and stop depth 
and click Update

Click either Top   or Bottom to accept the absolute   depth from the log.

Click Depths from tops to display the Depth   Range from Tops dialog box and 
then select the formation tops that   signify your zone of interest from the drop-
down lists and click OK.

4. Click Apply.

Related topics
"Inserting log sections using log editor" on page 59

Creating log composites
Take a range of data from a donor well and either insert   it into or replace part of a 
host well.

Log data from the specified depth range of the donor   well is copied to the cor-
responding log type in the host well. Logs in   the donor well without corresponding 
logs in the host well are ignored   unless you manually associate them with logs in 
the host well.  For details about merging log runs, see Related topics below.

To create log composites:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.

2. In the toolbar   beside the Log Editor,   click the Composite tool ( ).
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The Import   log data   dialog box opens.

3. Select the root   directory or drive from the Look in   drop-down list then double-
click folders in the display pane to browse   to the directory that contains either the 
desired files or the subdirectory   with those files. To filter the type of files dis-
played, from the File filter drop-down list, select a   file format extension.

4. Either click Browse dir. or Browse   sub-dir to launch Directory   Browser dis-
playing LAS and GeoSyn files sorted by UWI, or simply   select the desired file in 
the display pane. For details on using Directory Browser,   see Related topics 
below.

For   LAS files, you can inspect and modify the raw data in an ASCII text editor   
before importing it by clicking File   Viewer.  

When you select the file, details appear in the   format file pane.

5. In the well tree,   select whether to import specific logs. A check mark ( )   
appears beside logs that will import, a cross ( ) beside those   that won't. For 
wells with numerous logs, toggle the group by clicking   All ( , ) depending on 
whether to import or ignore the majority of   logs then toggle the individual logs to 
import or ignore and click Import.
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The Log Composite   dialog box opens displaying which logs from the donor well 
will be inserted   into logs of the host well.

6. Logs that match appear in the pane to the right. Logs that don't completely 
align and for which some constant values will need to be applied are colored red 
in the cell between the donor and recipient log. 

Drag a log from the Unmatched pane into the Matched pane in the left-most cell 
of the row that lists the desired recipient log, or drag it from the Matched pane to 
the Unmatched pane if you don't want it to be a donor log.

Drag the alias in the left-most column of the Matched pane to change the default 
recipient log.

7. Do one of the   following:

Type precise values in the Copy   range and Replacement range boxes and then 
click Update.

Click Top   and Bottom to accept the absolute   depth from the log.
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Click Depths   from tops to display the Depth   Range from Tops dialog box and 
then select the formation tops that   signify your zone of interest from the drop-
down lists and click OK.

8. Click Apply and then click Close.

Related topics
"Clipping or filtering logs" on page 75
"Using Directory Browser" on page 10
"Inserting log sections using log editor" on page 59
"Merging logs" on page 72

Shifting logs
Correct log depths with cable stretch and other errors   by adding a segment to the 
top or bottom of one or multiple logs in the   current synthetic. New data points 
added to the top or bottom of logs   are extrapolated using the last available data 
point. If the top or bottom   value is anomalous, it will be propagated and may 
require further editing.

GeoSyn requires that all logs have the same top and bottom,   so when one log is 
shifted in depth, GeoSyn adds data to the top or bottom   of all logs to com-
pensate. 

The time datum can also be changes using the Edit > Time Datum menu option. 
For details, see Related topics below.

To shift logs:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.

2. In the toolbar   beside the Log Editor,   click the Shift tool ( ).
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The Shift Curve   dialog box opens.

3. In the display   pane, select the logs to shift. SHIFT+CLICK or CTRL+CLICK for 
multiple   selection.

4. Type a signed   value to shift the log(s) in the Shift selected curves box then 
click Apply.   

Related topics
"Cutting logs" on page 80
"Drawing straight edge and freehand curves" on page 59
"Inserting log sections using log editor" on page 59
"Changing time datum properties" on page 111
 

Changing log editor display
Change the minimum and maximum values that define the   scale range for logs. 
Configure which logs appear in each track. The same log can be repeated in mul-
tiple tracks selected by log type.

To change log editor display:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.

2. In the toolbar   beside the Log Editor,   click the Set log editor scales   tool ( ).
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The Log Editor Display Properties   dialog box opens.

3. In the display   pane, select the log and type minimum and maximum scale val-
ues in the   boxes below the display pane then click Close.

These changes apply to only the current synthetic.   To change the default scale 
for a log in all future synthetics, see Related topics below.

Related topics
"Changing log defaults" on page 54

Inspecting logs
View the range over which data falls in a given log and narrow the selected range 
by either depth and top. The narrowed range can be output to the Crossplot wiz-
ard.

To inspect logs:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.

The Log Editor   dialog box opens.
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2. In the toolbar   beside the Log Editor,   click the Log Inspectiontool ( ).

The Log Inspection dialog box opens.

Click different log tabs in the Log Editor to change the log that appears in the Log 
Inspection dialog box.

3. To set the data range to interrogate, do one of the following:

Using the Log Inspection dialog box, in the Select depth range pane, type in the 
boxes, or click the Tops button to display the Depth Range from Tops dialog box 
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and then select the upper and lower tops that bound the range in the model, and 
then click Update.

Using the Log Editor, drag the interrogation range as depicted below.

To reset the range, click either Top or Bottom (to move only one element of the 
range), or click All.

Click Launch Crossplot to display the Crossplot wizard with only the data range 
specified above.

4. Click Close to return to the model.   

Related topics
"Creating crossplots" on page 170

88 © 2020 IHS Markit™. All Rights Reserved



Tops Lists

Tops Lists
GeoSyn includes three default lists for tops: 

 l Generic — the tops that appear in logs of the current synthetic.

 l AccuMap   System Tops —  the tops that are loaded from your local 
AccuMap database   when you create a new synthetic or launch an exist-
ing one. Information   forthese tops may change following AccuMap data 
loads.

 l AccuMap   User Tops, which are always loaded from your local AccuMap 
user   tops database when you create a new synthetic or launch an exist-
ing one.   Information for these tops changes based on your changes.

Create an unlimited number of tops lists with   customized display properties that 
are hidden or shown in the main synthetic   display, populate tops lists with check 
shot or directional survey values,   copy tops amongst lists, and delete individual 
tops in lists. You cannot   delete the three default lists above, but you can delete 
the tops within.

Related Topics
"Changing tops properties" below
"Duplicating tops lists" on page 91
"Inserting tops" on page 94
"Importing tops from GeoSyn files" on page 96
"Importing tops from delimited files" on page 97
"Importing tops from fixed width files" on page 99
"Importing tops from LAS and ASCII Files" on page 104

Changing tops properties
When you create a new synthetic or launch an existing   one, GeoSyn auto-
matically downloads the latest system tops and user tops   from the local AccuMap 
database or the IHS Online Information Hub.   If importing an LAS or GeoSyn file, 
you specify whether the well is in   measured depth or true vertical depth units so 
the tops are placed at   the correct depths. 

The display properties of tops including   formation name, depth, marker attrib-
utes, and lithology can be modified. Customized tops   can be copied to multiple 
tops lists and displayed in the main synthetic   display. 
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Important: Changes you make in the GeoSyn user tops list in aren't   
updated in the AccuMap user database and will be over-
written by the AccuMap   user database the next time you 
launch the synthetic. To change the value   in the AccuMap 
user database, use AccuMap Tops Manager. To prevent the   
changed depth from being overwritten without changing the 
depth in the   AccuMap user database, copy the top to the 
Generic   tops list.

To change a tops properties:
 1. Launch the Tops Properties dialog box:

 l Menu: Edit >Tops properties

 l Toolbar: ( )

 l Main display tops table: Right click and select Tops properties. 

The Top Properties   dialog box opens.

 2. Select a list to display from Tops lists (B).

 3. Choose a top to change from the selected list Tops: List name (A).

 4. Change the tops display   properties in the Edit top(s)section(C).
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 5. Click Close to return to the main synthetic display with the changes 
applied.

Related topics
"Importing tops from GeoSyn files" on page 96
"Exporting tops lists" on page 200
"Tops Lists" on page 89
"Importing tops from fixed width files" on page 99
"Importing tops from GeoSyn files" on page 96
"Importing LAS or GeoSyn files" on page 14

Duplicating tops lists
Duplicate and then customize an entire list of   tops or copy only select tops from 
one list to another. Tops copied from   one list to another don't overwrite tops with 
the same name in the recipient   list.

To duplicate tops lists:
1. From the Edit menu, select Tops properties ( )
OR
Right-click the tops table in the main synthetic display and select Tops prop-
erties. 

To   display the tops table in the main synthetic display, from the Edit   menu, 
select Synthetic properties   ( ) and in the Display elements pane, select 
Tops table.
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The Top Properties   dialog box opens.

2. In the Tops lists pane, select the tops list to copy then click Duplicate.   

To   copy only select tops to an existing list instead, in the Tops for list display 
pane, select the tops to copy (SHIFT+CLICK or   CTRL+CLICK for multiple selec-
tion) then click Copy selected tops to another list to display the Select   a 
recipient tops list dialog box and select the receiving tops   list.

The tops names, depths, and lithology are copied   to a new file that appears below 
the existing tops lists in the Tops lists pane. 

3. Select the duplicate   tops list to display its tops in the Tops for list pane and 
select a row that contains a top to change, duplicate,   or below which to add a new 
row and do one of the following in the boxes   below the Tops for list display:
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To   change an existing top, type and select the desired details then click   Update.

To   make a copy of a top to modify, select the top below which to place the   copy 
and click Duplicate.

To   add a blank row where you can type new top details, select the top below   
which to add a blank row, click   New, type top details, then click   Update.

Related topics
"Tops Lists" on page 89
"Importing tops from LAS and ASCII Files" on page 104
"Importing tops from LAS and ASCII Files" on page 104
"Importing tops from delimited files" on page 97
"Importing tops from fixed width files" on page 99
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Inserting tops
Insert a top at a location on a log you click. When inserting,   you can specify the 
tops list to which to write the top information so   that you can update it, correlate 
it, and so on.

To insert tops:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.
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The Log Editor   dialog box opens.

2. Select the tab   for the log in which to insert a top and in the Log Editor toolbar, 
click   the Insert a Toptool ( ).

3. Click the cursor   ( ) at the location on the log at which to insert a top.
The Insert Top in   Selected List dialog box opens.

4. Select the list   in which the name and depth of the top you insert will be saved, 
and then   type a name for the top and click OK.
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Related topics
"Tops Lists" on page 89
"Changing tops properties" on page 89

Importing tops from GeoSyn files
Import tops lists saved in GeoSyn format into   the GeoSyn tops list to make them 
available to your current model. 

When importing tops, you have the option of overwriting   existing tops in the list, 
if you keep the current tops, imported tops   with the same name appear alongside 
them.

To duplicate and then modify an existing tops list within   GeoSyn, see Related top-
ics below.

To import tops from GeoSyn files:

1. From the File menu, point to Import, click Tops,   and then select GeoSyn 
file. 

2. Browse to the   desired GeoSyn file and select the depth placement options, 
units, and   whether to delete current tops if importing into a tops list that's 
already   populated, and then click OK.

The Select   a recipient tops list dialog box opens.

3. Select the list   to which to import the tops or click New top list and define a 
new tops list, and then click   OK. Shift+Click or Ctrl+Click   to select more than one 
tops list into the list of tops.
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Related topics
"Duplicating tops lists" on page 91
"Tops Lists" on page 89
"Importing tops from delimited files" below
"Importing tops from LAS and ASCII Files" on page 104
"Importing tops from fixed width files" on page 99

Importing tops from delimited files
Import tops lists saved in delimited ASCII format   files into GeoSyn tops lists so 
that they are available to your current   synthetic. Delimiters can include commas, 
tabs, or spaces. 

Delimited format is different than fixed width columns.   All entries in fixed width 
columns align on the left-edge of the column.   Delimited simply includes one or 
more delimiters between entries, but   the items may not align neatly in columns.

When importing tops, you have the option of overwriting   existing tops in the list. 
If you keep the current tops, imported tops   with the same name appear alongside 
them.

To duplicate and then modify an existing tops list within   GeoSyn, see Related top-
ics below.

To import tops from delimited   files:

1.  From the File menu, point to Import, click Tops,   and then select Delimited. 

2. Browse to the   desired tops file, and then click Open.
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The Tops Import   dialog box opens.

GeoSyn automatically searches in the file you selected above for a UWI   that 
matches the one in your GeoSyn file and highlights the row in which   it appears in 
the tops source file.

3. Using   the display pane, verify whether the tops in the source file are ordered   in 
rows (formation top names run horizontally along a single row), or   columns (form-
ation top names run vertically down a single column).
Your selection above is saved and applied the next time you launch the   Tops 
Import dialog box.

4.   Using the Names in row or column and the Depths   in row or column (depending   
on whether you selected Tops in rowsor Tops in columns above), specify   the row 
or column in which the formation top names and depths appear.

5.   In the from and to   boxes, specify the range to import.
OR
Drag in the display pane to select the tops to import.
Rows are highlighted gray simply to show the columns and rows in which   form-
ation top names and depths appear. Rows and columns highlighted green   are 
those that will be imported into GeoSyn.
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Verify   the delimeter GeoSyn chose is correct. GeoSyn attempts to determine the   
correct delimeter by reading the source file.

In   the Top placement pane, select   the desired processing options.

6.   Click Apply.

The Select   a recipient tops list dialog box opens.

9. Select the list   to which to import the tops, or click New   top list, define a new 
tops list, and then click OK.   Shift+Click or Ctrl+Click to select more than one tops 
list into which   to import into the tops.

Related topics
"Duplicating tops lists" on page 91
"Tops Lists" on page 89
"Importing tops from fixed width files" below
"Importing tops from GeoSyn files" on page 96
"Importing tops from LAS and ASCII Files" on page 104

Importing tops from fixed width files
Fixed width columns format is different than delimited   format. All entries in fixed 
width columns align on the left-edge of the   column. Delimited simply includes one 
or more delimiters between entries,   but the items may not align neatly in 
columns.

When importing tops, you have the option of overwriting   existing tops in the list, 
if you keep the current tops, imported tops   with the same name appear alongside 
them.
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To duplicate and then modify an existing tops list within   GeoSyn, see Related top-
ics below.

To import tops from fixed width   files:

1. From the File menu, point to Import, click Tops,   and then select fixed width, 
delimited.   

2. Browse to the   desired tops file and select the depth placement options, units, 
and whether   to delete current tops if importing into a tops list that's already pop-
ulated,   and then click OK.

The Highlight first line   dialog box opens.

3. Select   the row in which the first top appears, and then click Next.

100 © 2020 IHS Markit™. All Rights Reserved



Inserting tops

The Import Wizard:   Highlight Last Line   dialog box opens.

4. Select the row   in which the last top appears, and then click Next.
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The Import Wizard: Set Column Delimeters   dialog box opens.

Set   the column delimeters ( ) by clicking in the display pane   between required 
columns. The green line cannot bisect a data column.   Double-click column delim-
iters to delete. 

Click the   box that appears below each delimeter to display the 
Select   from List dialog box and identify the data type then click 
Next.
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The Import Wizard: Finish   dialog box opens.

5.   Click Finish.

The Select   a recipient tops list dialog box opens.

6. Select the list   to which to import the tops or click New top list and define a 
new tops list, and then click   OK. Shift+Click or Ctrl+Click   to select more than one 
tops list to import into the list of tops.

Related topics
"Duplicating tops lists" on page 91
"Tops Lists" on page 89
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"Importing tops from delimited files" on page 97
"Importing tops from GeoSyn files" on page 96
"Importing tops from LAS and ASCII Files" below

Importing tops from LAS and ASCII Files
Import tops lists saved in LAS, or ASCII format   into the GeoSyn tops list so that 
they're available to your current synthetic.   

When importing tops, you have the option of overwriting   existing tops in the list, 
if you keep the current tops, imported tops   with the same name appear alongside 
them.

To duplicate and then modify an existing tops list within   GeoSyn, see Related top-
ics below.

To import tops from LAS and ASCII files:

1. From the File menu, point to Import, click Tops,   and then select LAS file.   
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The Import Tops dialog box opens.

2. Select the desired LAS file and select the depth placement options, units, and 
whether   to delete current tops if importing into a tops list that's already pop-
ulated,   and then click Open.
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The Select   a recipient tops list dialog box opens.

3. Select the list   to which to import the tops or click New top list and define a 
new tops list, and then click   OK. Shift+Click or Ctrl+Click   to select more than one 
tops list to import into the list of tops.

Related topics
"Duplicating tops lists" on page 91
"Tops Lists" on page 89
"Importing tops from delimited files" on page 97
"Importing tops from GeoSyn files" on page 96
"Importing tops from fixed width files" on page 99

Creating models
Create a synthetic model to investigate the seismic   response to a given geo-
logical situation. The response may be studied   in zero or multiple offset mode 
with several reflection coefficient dependency   options.

To create models:

1. From the Edit menu, select Model Properties ( ).

106 © 2020 IHS Markit™. All Rights Reserved



Inserting tops

The Model Properties   dialog box opens. 

2. In the display   pane, either click an existing trace and click Duplicate   or simply 
click New.

A new row appears as the last entry in the display pane with either   a random num-
ber or a copy of   identifier depending on your selection above. 

3. In the box below   the display pane, type a more descriptive name for the trace 
selected   in the display pane above, and then click Update.

4. Select the model   type and trace properties. Depending on the model type and 
attributes   you select, corresponding tabs right of the model default properties 
become   active and one of the following tab display: Wavelets, Display, 
Expanded, Multi offset, Derived, or Filter Panel.

For details on using the various   tabs, see Related topics below.
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Related topics
"Changing wavelet properties" on page 143
"Changing wavelet expansion properties" on page 145
"Changing derived properties" on page 128
"Creating AVO logs" on page 112
"Changing multi-offset properties" on page 129
"Changing color palettes" on page 131

Applying multiple filters across a group of traces
Filter the low and high frequency across a group of traces.

For zero offset models, apply one filter starting at the left-most trace of a group 
of traces and a second filter to starting at the right-most trace with both filters 
working towards the middle of the group of traces.

The two filters must share the same type, taper, and operator length, but the low 
and high cut and pass, and the phase can be unique for each.

To apply multiple filters across a group of traces:

1. From the Edit menu, select Model Properties ( ).
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The Model Properties   dialog box opens. 

2. In the display   pane, click a trace(s) with which to apply the filter. You can also 
duplicate or create a new curve by clicking Duplicate   or New.

3. In the Type box to the left below   the display pane, select Zero offset filter 
panel (P-P). 
A default setting of 20 traces per group is applied. Trace settings can be changed 
using the Display tab.

4. Using the Filter panel tab, specify the type, taper, operator length, and then dif-
ferent filter settings for the left and right traces, which taper towards the middle 
of the group of traces. The phase can also be shifted separately for the left and 
right traces.
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Related topics
"Creating models" on page 106
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Changing time datum properties
Add zones above the sonic log to lower it to the same depth as the seismic sec-
tion (time zero). These zones can be hidden in the main display but still exert 
their effect on the main display. The added zones are helpful when doing 
AVO analysis instead of using the Log Editor to manually add visible sections to 
the top of the log.

To change time datum properties
1. From the Edit menu, click Time Datum ( ).

The Time Datum Properties dialog box opens. If the model was built by importing 
data from Kingdom, a zone is automatically created to account for the difference 
between the top of seismic section and the top of the sonic log.

2. To the right of the Layers label, click Add to create a default zone with a thick-
ness of zero to the top of the Add Layered Section... pane of the Time Datum Prop-
erties dialog box.

3. Hover the cursor over fields in the newly created row until the cursor appears 
as follows: , click to type details for a given field, and then press ENTER or click 
a different location in the pane.
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4. Select from the following options:

Tie depth point to time - click to display the Tie to Datum dialog box where 
you correlate a sonic log depth to a time point on the seismic section. This tie 
point is honored throughout GeoSyn, for example, whey you export SEGY data. 

Convert to log data - click to convert the otherwise invisible section to a visible 
part of the log in the main display.

Related topics

Importing Wells from Kingdom

Creating AVO Logs

Inserting Log Sections using Log Editor

Creating AVO logs
Create an entire suite of logs that can be used for AVO   analysis using reflection 
coefficients. Instead of creating each type   of log individually, one selection from 
the Reflection Coefficients drop-down list   enables you to create them with a 
single click. 

Access more general log creation functionality   from the Well Properties: Log Prop-
erties dialog box or create a new log   populated with values from an equation that 
uses existing logs using the   Math dialog box. For details, see Related topics 
below.

Use the Edit > Time Datum dialog box to add zones above the log to push the log 
down to time zero so that it matches the seismic. For details, see Related topics.

To create AVO logs:

1. From the Edit menu, select Model Properties ( ).
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The Model Properties: Display   dialog box opens.

2. Select the desired   model(s) in the display pane, and then select a reflection 
coefficient equation from the drop-down list.

3. Select the logs upon which to base your derived logs, and then click Create 
AVO log suite.

The AVO   log suite dialog box opens.

4. Select the log   types to create, and then click OK.

5. In the main Model Properties   dialog, click Close to return   to the main synthetic 
display with the changes applied.

Related topics
"Creating models" on page 106
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"Changing multi-offset properties" on page 129
"Changing log display properties" on page 52
"Applying math equations to logs" on page 77
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Modelling fluid replacement
In Amplitude vs. Offset modelling, as seismic waves reflect   off an interface, the 
amplitude of the reflected wave is affected by the   amount and type of fluid that 
occupies the pore space of the rock.

GeoSyn applies Gassman's   equation to model this using a P sonic, shear sonic, 
and density log.   You change the water saturation to apply different scenarios to 
your model.   The available pore space not saturated with water is assumed to con-
tain   oil and gas.

Click for in-depth details on how fluid replacement modelling is implemented in 
GeoSyn.

To model fluid replacement:

1. From the Edit menu, select Log editing ( ).
OR
Double-click the log
OR
Right-click the log and select Log editing.
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The Log Editor   dialog box opens.

2. In the toolbar   beside the Log Editor,   click the Fluid Replacement Modelling   
tool ( ).
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The Fluid Replacement Wizard (Input and output logs, depth range)   dialog box 
opens.

3. GeoSyn automatically   populates the Input logs and Output logs drop-down 
lists if the required   logs are available in your model; otherwise, click Create 
Missing Log Types to display the Generate Logs for Well... dialog box and select 
the log types to create, and then click Create after noting the following:
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Click   the log types to create in the left column and ensure Maintain link check 
box is cleared so that changes made to the derived log aren't   overwritten by the 
parent log.

Click Edit to the right of a log type   to display the Edit the Derivation Equation for 
Log   dialog box and modify the equation used to derive the log.

Click Duplicate Key Logs to create exact copies of existing logs in your model 
for the input logs. You might do this if you want to keep a pristine copy of the ori-
ginal logs.

4. Click Next.
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The Fluid Replacement Wizard (In-situ   reservoir properties)   dialog box opens.

5. Using the image in the top-left of the Matrix and Pore Fluids tabs, click to place 
the white circle in the mineralogy and pore fluid zones that most closely define 
the rock properties in the subsurface.

Click Workshop to display either the Minerals Calculator   or the Batzle and Wang 
Fluid Properties Calculator   dialog boxes and select criteria more specific to your 
zone of interest.

6. Click Next.
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The Fluid Replacement Wizard (Calibrate   shear log for water saturations < 100%)   
dialog box opens if the water saturation defined using the previous   dialog box is 
less than 100%. This option compensates for the fact that the shear   log is fre-
quently derived from a sonic log using Castagna's formula. Castagna's   formula 
requires a correction when gas is present in the zone of interest. Select   the check 
box and click Next.

The Fluid Replacement Wizard (FRM   Modelling: Set new water saturation)   dialog 
box opens.
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7. Ensure the above   dialog box doesn't overlap the Log   Editor displaying the well 
for which you're modifying water saturation,   and then using the Log Editor, drag 
the mouse to select the area of interest as depicted below.

 
The Depth Range fields are updated in the Fluid Replacement Wizard. 

To define the area of interest using formation tops instead, click Tops to display 
the Depth Range from Tops dialog box, where you select the top and bottom form-
ations for the zone.

8. Click the thumbnail or drag the green circle to the desired fluid composition and 
then click Close to complete the wizard and apply the changes.

Related topics
"Changing log display properties" on page 52
"Notes on GeoSyn fluid replacement " on page 124
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Changing model porosity
Porosity is modeled by changing  a well logs density and or velocity. 

 l Sonic porosity( ) is calculated using one of three selectable equations: 

 
 l Wyllies time 

average 

 
 l Velocity aver-

age 

  l Raymers et al.

  ( ) mineral matrix, ( ) pore fluid

 l Density porosity ( ) is calculated as a simple volumetric average of 
the densities.

  ( ) mineral matrix, ( ) pore fluid

Note: Mineral matrix velocities are calculated internally by solving the velo-
city equation for mineral velocity followed by plugging in the VP and fluid velo-
cities. Once mineral matrix velocities are known then the equation is reset to 
solve for Vp and porosity may be adjusted, which changes VP.

Below is an example of changing the porosity from 13% to 30% using the model 
porosity tool.
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Insitu porosity = 13% Model porosity = 30%

To model the porosity of a log:

Modify the percentage of porosity to a selected portion of a log  using the Log 
Editor.

 1. Open the Log Editor.

 2. Click the Model porosity tool ( ) on the Log Editor toolbar to 
open the Model Porosity  dialog.

 3. Enter the logs Insitu porosity value and click Update. This  creates a 
starting point for the porosity model.

 4. Select a value for the fluid property from the drop down list.

 5. Select a P Sonic and or Density log.

 6. Select  a velocity equation to apply to the model. See equations above.

 7. Set the depth range. Once set, the number of samples and a meas-
urement for the selected depth range  will be updated on the dialog. The 
depth range  will also be highlighted in on the log in cyan . The depth 
range is set using one of four methods:
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 l Click and drag the Log editor cursor  to select a depth range. 

 l Type values in the  depth fields and click Update

 l Click Top   or Bottom to accept the absolute   depth from the log or 
click All   to accept both

 l Click Depths from tops to display and select formation tops 
that   signify your zone of interest from a drop-down lists .

 8. Use slider to change percentage of porosity. Changes made will be 
reflected on the selected Sonic and density logs. 

 9. Click Close to apply changes or Cancel to discard changes. 

Related topics
"Model porosity dialog" on page 276

Notes on GeoSyn fluid replacement 

Introduction
GeoSyn uses the Biot-Gassman fluid substitution method. 

There are other approaches to fluid substitution (empirical and heuristic) which 
avoid the porous frame calculations but often do not yield reliable results. 
GeoSyn provides some empirical Vp information (Wyllie’s time average, Average 
Velocity and Raymers equation) as a check for consistency between the modelled 
log data and the in-situ rock parameters. In general, and in particular for Wyllie’s 
equation, these empirical relationships fall down when substituting gas for water 
and cannot be used reliably for fluid substitution.

The following overview is based largely on the bible of the field "The Rock Physics 
Handbook."

Some basic equations
The mechanics of fluid substitution on the density and shear logs is simple. For 
the density log, fluid substitution can be written: 

(1)

where  is the initial rock bulk density,  is the bulk rock density after fluid sub-

stitution,  is the initial fluid density,  is the density of the substituting fluid, 
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and φ is the porosity. The substituted rock density  is simply the fractional dif-
ference attributable to the fluid change in the pore space. 

Given the fact that in Biot-Gassmann’s model the shear modulus μ is independent 
of the pore fill, the substituted Vs depends only on the change in density: 

(2)

This means, of course, that substitution of hydrocarbon for water will result in a 
lowering of bulk density and an increase in Vs. 

Calculating the fluid substitution effect on the compressional wave velocity , as 
measured by the sonic log, is not so straightforward because it depends not only 
on the substituted density and the shear modulus, but also on the saturated bulk 
modulus Ksat: 

(3)

In turn, the bulk modulus of the new rock  requires knowledge of the mineral 

modulus , the fluid modulus  and the bulk modulus of the unsaturated rock 

 (Mavko and Mukerji, 1995; Avseth et al., 2005): 

The Biot-Gassman equations

(4)

Solving for 

(5)
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The shear modulus is the same dry or saturated.

Where

= shear wave velocity

=compressional wave velocity

=effective bulk modulus of dry rock

=effective bulk modulus of the rock with pore fluid

=bulk modulus of mineral material making up rock

=effective bulk modulus of pore fluid

=porosity (fractional)

=effective shear modulus of dry rock

=effective shear modulus of rock with pore fluid

Performing the fluid substitution
In plain terms the Biot-Gassman relationship allows one to calculate the sat-
urated bulk modulus and resultant Vp (equation 3) from a combination of the dry 

bulk modulus , the fluid bulk modulus  and the mineral bulk modulus . 

Modeling the changes from one fluid type to another requires that the effects of 
the starting fluid first be removed prior to modeling the new fluid. i.e. calculate 

. In practice, the rock is drained of its initial pore fluid, and the moduli (bulk 
and shear) and bulk density of the porous frame are calculated. Once the porous 
frame properties are properly determined, the rock is saturated with the new 
pore fluid, and the new effective bulk modulus and density are calculated.

A direct result of Gassmann's equations is that the shear modulus for an isotropic 
material is independent of pore fluid, and therefore remains constant during the 
fluid substitution process. In the case of disconnected or crack like pores, how-
ever, this assumption may be violated. Once the values for the new effective bulk 
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modulus and bulk density are calculated, it is possible to calculate the com-
pressional and shear velocities for the new fluid conditions. 

A two-step calculation is required. In-situ saturation to dry saturation followed by 
dry saturation to new fluid saturation.

1. Calculate the dry bulk modulus using the in-situ saturated bulk modulus  

and in-situ fluid modulus .  is calculated using equation 3, which is where 

the original log data  is used. 

2. Calculate the new saturated bulk modulus  using the dry bulk modulus  

and a new fluid modulus  reflecting the changes in gas/water saturation. With 

the new  and using equation 3 a new  can be calculated.

What can a GeoSyn user take from this?
The in-situ reservoir parameters for matrix bulk and shear modulus and density 
must be correct for the log section being analyzed. 

For example you could incorrectly describe an extremely high modulus matrix 
then apply it to a log section of very slow velocity. In reality such a rock should be 
quite fast. The equations will fail. 

GeoSyn provides several empirical relationships to give users a ball park the-
oretical Vp based on the reservoir parameters. The Vp calculated from one or all 
of these equations should roughly match the Vp of the log data or something is 
wrong and the Biot-Gassman equations will not work properly. Note that these 
empirical relationships are not reliable when gas is the pore fluid. If they were reli-
able then the trouble and trickiness of using the Biot-Gassman equations would 
be unnecessary.

is calculated using equation 3

Wyllies time average equation
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Velocity average equation

Raymers equation

Changing derived properties
Generate a trace based on the results of a mathematical   operation performed on 
two traces in the current synthetic.

To change derived properties:

 1. From the Edit menu, select Model Properties ( ).
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The Model Properties: Derived   dialog box opens. 

 2. Select the desired   model(s) in the display pane and select 
Derivedfrom the Type drop-down   list.

 3. Using the drop-down   lists in the Derived tab, select the trace and math-
ematical operator. The result of this equation   becomes the derived 
trace.

 4. In the main Model Properties   dialog, click Close to return   to the main 
synthetic display with the changes applied.

Related topics

"Creating models" on page 106

Changing multi-offset properties
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Create multi-offset models for amplitude offset   analysis. If summing traces, you 
can define groups of traces (near, middle, far) and then do mathematical oper-
ations between the three groups, which enables you to filter or enhance certain 
portions of the offset trace. For example, you might subtract the far traces from 
the near traces and then multiply the difference by the far traces to enhance the 
far offset amplitude.

To change multi-offset properties:

1. From the Edit menu, select Model   properties ( ).

The Model Properties: Multi offset   dialog box opens. 

2. Select the desired   model in the display pane and select Multi   offset from the 
Type drop-down   list.

3. Click the Multi offset tab and select the criteria.
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If using summed traces, click Edit to display the Sum Options dialog box where 
you select the traces that make up the near, middle, and far group of traces, and 
then define an equation to process the groups.

4. In the main Model Properties   dialog, click Close to return   to the main synthetic 
display with the changes applied.

Related topics

"Creating models" on page 106

Changing color palettes
Specify color fills for logs and traces in seismic, logs, cross plots, models, and 
more. Color schemes can be loaded from stock color palettes that   ship with 
GeoSyn, or from color templates you save in the GeoSyn Working directory with a 
.pal   extension. Templates can be quickly applied to any synthetic and can be   
shared amongst GeoSyn users.

Color schemes can also be configured for the current   synthetic without creating a 
template and automatically saved with   individual GeoSyn files.

To automatically apply a color scheme to all new synthetics,   apply it to the cur-
rent synthetic then update the import defaults file   with the current synthetic 
options. 

When working with models and certain types of crossplots, you can drag the min 
max color nodes that appear at the top and bottom of the histogram to tighten 
them to the desired amplitude range so that a fuller color spectrum is displayed in 
GeoSyn. This option isn't available for cross plot properties with a depth-based 
color reference type, or for logs, as typically a certain color represents a certain 
log value and is related to lithology.

To change color palettes:
 1. Open the Edit color palette:

 l Well Properties:   Log Properties, select Edit adjacent to the Infill 

display ( ).

 l Model   Properties dialog box, select Edit  adjacent to the color dis-

play ( ).
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 l Seismic   Properties dialog box, select Edit adjacent to the Color 

underlay display ( ).

The Edit color palette   dialog box opens. The top and bottom of the color bar 
represent the   fixed extremes in the data values of the selected log or trace. 
Nodes   along the display bar associate a color to a particular data value. 

 2. Choose a palette:

 l Copy   a stock palette drop-down list 

 l Load import a previously saved custom palette .

 l None  remove all colors
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To create a custom color palette:
 1. Creating a custom color bar can be done in several ways:

 l Drag and drop color on existing node.

 l Drag and drop color on the color bar. GeoSyn creates a corresponding 
node for each   color you drop.

 l Create a custom color

 2. Type   a unique name for this color configuration in the Palette   Name 
box then click Save   to save it in the GeoSyn Working   directory.

Related topics
"Changing seismic properties" on page 162
"Changing log display properties" on page 52
"Creating models" on page 106
"Changing import defaults" on page 12
"Creating crossplots" on page 170

Displaying comments
Type comments about the processing applied to a synthetic that help clarify your 
interpretation. Actual operations that have been performed on a synthetic are 
stored in a GeoSyn file and can be automatically pasted into the Comments dialog 
box where you edit them. 

The comments you create appear as an object in the main page of the synthetic 
anchored below the Tops table, or below where the Tops table would appear if the 
Tops table is hidden. When you move the Tops table, the Comments object 
moves too.

Once comments are displayed in the main synthetic, double-click (or right-click 
and select Edit) to change them.

To display comments:
1. From the Edit menu, select Synthetic properties ( )
OR
Right-click the well header and select Synthetic properties.
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The Synthetic Properties   dialog box opens.

2. Using the Tables pane, ensure the Comments check box is enabled, and then 
click Edit.
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The Comments dialog box opens.

3. Do any of the following:

Type directly in the display pane.

Click Insert Well History to paste the operations performed on this synthetic 
into the display pane and then edit them.

Select text that appears in the display pane and click Copy, and then paste it in 
another program.

With text to paste copied to the Windows Clipboard from GeoSyn or a third-party 
application, click Paste.

4. Click Apply and then Close to display the Comments in the main synthetic 
immediately below the Tops table.

Like the Tops table, the Comments box that appears in the main display can be 
dragged to the desired location. The Tops table moves along with the comments 
box.
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To change the comments displayed, double-click the Comments box that appears 
on the main display (or launch it using the steps above).

Related topics
"Changing the main synthetic display" on page 46

Importing wavelets and wavelet sets
Import wavelets in ASCII or SEGY format and import   wavelet sets in .wav format. 
Wavelets can be saved and imported using a centralized library of wavelets you 
create. The wavelet library is shared by all GeoSyn projects.

To avoid aliasing, GeoSyn doesn't extract frequency information   that is higher 
than the Nyquist frequency of either the import data or the current   synthetic, 
whichever is lowest. 

Separate procedures for importing wavelets and wavelet   sets appear below.

To import wavelets:
1. From the Edit menu, select Wavelet   properties ( ).
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The Wavelet Properties   dialog box opens.

2. In the Import/Export   pane, click Import to the right of the wavelet label to 
import a wavelet from disk. Alternately, import wavelets from a centralized wave-
let library used by all GeoSyn models by clicking Retrieve to the right of the 
Library label to display the Wavelet Library dialog box, where you select the wave-
let and then click Import wavelet; otherwise, continue with the below steps.

The Import   time data dialog box opens.

3. In the Files of type drop-down list, select whether to import SEGY or ASCII   
data then browse to and select the file.
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If you select a SEGY file, the Import   Wavelet Processing Flow   dialog box opens; 
otherwise, if you select ASCII, the Highlight   First Line   dialog box opens. 

4. Select the first   line to import then click Next.

The Highlight Last Line   dialog box opens.

5. Select the last   line to import the click Next.

138 © 2020 IHS Markit™. All Rights Reserved



Changing model porosity

The Set Column Delimeters   dialog box opens.

6. Set the column   delimeters ( ) by clicking in the display pane between   required 
columns. The green line can't bisect a data column. Double-click   column delim-
iters to delete. 

7. Click the box   that appears below each delimeter to display the Select   from List 
dialog box and identify the data type.

8. Click Next.                         
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The Finish   dialog box opens.

9. Click Back   to change any previous selections or click Finish.

The Import Wavelet Processing Flow   dialog box opens.

10. Specify whether   to taper the file on import, the name by which to identify the 
wavelet,   the length of the operator, and then click OK.

To import wavelet sets
1. From the Edit menu, select Wavelet properties ( )
OR
  Right-click a wavelet and select Wavelet properties from the popup menu.
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The Wavelet Properties: Wavelet   dialog box opens.

2. In the Import/Export   pane, click   Import to the right of the Wavelet Sets 
label. Alternately, import wavelets from a centralized wavelet library  used by all 
GeoSyn models by clicking Retrieve to the right of the Library label to display 
the Wavelet Library dialog box, where you select the wavelet and then click 
Import wavelet; otherwise, continue with the below steps.

The Import   a wavelet set dialog box opens.

3. Browse to and   select the wavelet file in .wav   format then click OK.

The Import   Wavelet Groups from Wavelet Set dialog box opens.
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4. Select the wavelet   group(s) to import then click OK.

Related topics
"Changing wavelet properties" on the facing page
"Inverting wavelets" on page 146
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Changing wavelet properties
Apply up to three filters to different segments of a   model and specify the amount 
of overlap between filters. Wavelets can be saved and imported using a cent-
ralized library of wavelets you create. The wavelet library is shared by all GeoSyn 
projects.

To change wavelet properties:
1. From the Edit menu, select Wavelet properties   ( ).

The Wavelet   dialog box opens.
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2. From the Aux. trace drop-down list, select whether   to display a background 
trace to which to correlate the displayed trace   and from the Background drop-
down   list, select whether to display a different color scheme.

3. Type a value in   the center phase box or drag the   slider below it.

4. Type a length   for the operator, which controls the sample size displayed in the 
window.

5. To customize the   amplitude or phase spectrum of the selected wavelet, click 
the Spectrums   tab. 

The Spectrums   tab appears.

6. Hover your cursor   over the amplitude display then click to define points that 
describe the   modified spectrum.

7. Click either Amp or Phase   to apply the defined points to either, or click Clear   
(or press ESC) to exit drawing   mode without applying changes.

8. Click the horizontal   arrows at the bottom of the view window to change the 
amount of frequency   shown.

9. Click the Wavelet tab to review how the changes   will appear then click Close 
to   apply them to the main display.

Related topics
"Extracting wavelets" on page 149
"Inverting wavelets" on page 146
"Importing wavelets and wavelet sets" on page 136
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Changing wavelet expansion properties
Change the lengths, percentage of overlap, and   reflection coefficient of individual 
wavelets.

To change wavelet expansion properties:

1. From the Edit menu, select Model Properties ( ).

The Model Properties: Expanded   dialog box opens. 

2. Select the desired   wavelet(s) in the display pane, Derived from the Type drop-
down list, and then select Expanded   from the Attribute drop-down list.

3. Modify the parameters   that control wavelet generation and placement then in 
the main Model   Properties dialog box, click Close.
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Related topics
"Changing wavelet properties" on page 143

Inverting wavelets
Invert a wavelet and then import it into GeoSyn (or another seismic program 
such as Kingdom) to deconvolve (filter) a seismic section.

Deconvolving a seismic section using an inverted wavelet removes phase and 
amplitude distortions that are introduced by various earth processes. These dis-
tortions prevent the peak of a wavelet from aligning with zero time.

To invert wavelets:
1. From the Edit menu, select Wavelet   properties ( ).
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The Wavelet Properties   dialog box opens.

2. Click Invert to the right of the Invert Wavelet option.
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The Wavelet Inversion dialog box opens.

3. In the top-right of the dialog box, click Select and choose an existing wavelet 
to invert from the GeoSyn project. 

4. Alter the Inversion Parameters to apply inversion criteria, clicking Update to 
see what change a given setting has on the preview wavelet displayed in the 
Inverted Wavelet pane. 

The Show radio buttons enable you to display either a wavelet or spectrum i the 
Wavelet Inversion dialog box.
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5. Click Next to save the wavelet to either the GeoSyn library or to disk.

6. Using the Wavelet Inversion Save dialog box, type wavelet details and then 
click either Add to Library or Export to File, and then click Close.

7. From the Edit menu in the main GeoSyn display, select Seismic Properties.

The Seismic Properties dialog box opens.

8. Using the Seismic Properties dialog box, click the Processing tab, and then to 
the right of the Deconvolve using Inverted Wavelet option, click either Library or 
Import and then import the inverted wavelet created above. 

It is automatically applied to your seismic.

Related topics
"Changing wavelet properties" on page 143
"Importing wavelets and wavelet sets" on page 136

Extracting wavelets
Import seismic data and extract a wavelet from it. Apply this wavelet to a model 
to improve the tie between the seismic and the model.

To extract wavelets:
1. From the Edit menu, select Wavelet   ( ).
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The Wavelet   dialog box opens.

2. Beside the Extractionlabel,   click Extract.
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The Wavelet Extraction  dialog box opens.

3. Click Import and navigate to the seismic section upon which to base the 
extracted wavelet. If you launch the above dialog box from the Seismic Prop-
erties dialog box or there are already seismic lines in the model, the Seismic Data 
drop-down list is already populated. 
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The Set Time Range dialog box opens, where you specify the time   range and num-
ber of traces to sum, and then click OK.
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4. Using the Frequency Wavelet Extraction dialog box, specify the extraction 
method, and then click Next to display the Extracted Wavelets panes.

In the above dialog box, in the pane to the left, the GeoSyn model trace is dis-
played with a portion of the seismic section on either side. In the Seismic Selec-
tion pane, a bird's eye view of the well header with respect to the seismic is 
displayed. In the Extracted Wavelet pane in the top-right, the wavelet that will be 
extracted is displayed.

5. Modify the processing options as follows:
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To restrict the extracted range, using the left pane, drag the green arrows ( ) 
up from the bottom or down from the top of the range.
OR
Type the top and bottom of the extraction range in the Seismic Selection pane in 
the bottom-right of the Frequency Wavelet Extraction dialog box.

Click the arrows in the bottom-left of the model display pane to zoom.

6. Click Next to display the Save Options dialog box.

7. Select from the following options:
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Select a current model(s) in the display pane, and then click Replace Model Wave-
let to overwrite its wavelets. CTRL+Click or SHIFT+Click for multiple selection.

Add to Library to save wavelets that can then be  imported using a centralized lib-
rary of wavelets you create. The wavelet library is shared by all GeoSyn projects.

Export to a SEGY file.

Related topics
"Changing wavelet properties" on page 143
"Importing wavelets and wavelet sets" on page 136
"Exporting wavelets" on page 199
"Tying seismic to models" on page 164
"Generating models using wavelet equations" below

Generating models using wavelet equations
Create a new synthetic model using a process based on Maxwell's wave equa-
tions, which state that amplitude in time equals acceleration in space.

Standard models are calculated using reflection coefficients based on density and 
velocity contrasts by placing them in time using the time/depth curve, and con-
volving them with a wavelet.

Maxwell's equation more closely resembles what's happening when the wave is 
progressing through the earth -hitting reflectors, bouncing up, and continuing 
onward. The signal is digitized and a time increment of microseconds is used. 

To generate models using wavelet equations:

1. From the Edit menu, select Model Properties ( ).
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The Model Properties: Wave Equ   dialog box opens. 

2. Select the desired   model(s) in the display pane, and then select Wave Equa-
tionfrom the Type drop-down   list.

3. Select Median Filter Points and Resample Depth Interval options in the Wave 
Equ tab, and then click Animation Viewer to display the 1D Wave Equation 
Viewer dialog box, where you animate how the sonic pulse given the above set-
tings will impact the model.

Reducing the Median Filter Points and Resample Depth Interval above can alle-
viate some of the processing burden on your PC's CPU.

156 © 2020 IHS Markit™. All Rights Reserved



Changing wavelet properties

The 1D Wave Equation Viewer dialog box opens.

In this time-based dialog box, the left-most frame displays the original sonic and 
density logs. The middle pane represents the earth. And the right-most pane dis-
plays the synthetic that results from running the animation. 

The Absorbing area above the Surface marker cancels reflections that move 
upward and that bounce off of the surface when the initial pulse activates. An 
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accompanying noise cancellation buffer is not required below the Bottom marker 
as the synthetic finishes drawing before the pulse that travels through the Bot-
tom marker can enter back into the model.

4. Use the Upand Down arrows to increase or decrease the speed at which the 
pulse proceeds through the earth, and then click Start Animation. Once clicked, 
the button label displays Stop Animation and you can click to stop the pulse.

Click One Step to increment the pulse through the earth by one step each time 
you click .

Zoom to magnify details that appear int he 1D Wave Equation Viewer dialog box.

Related topics
"Changing wavelet properties" on page 143
"Importing wavelets and wavelet sets" on page 136
"Exporting wavelets" on page 199
"Extracting wavelets" on page 149
"Tying seismic to models" on page 164
 

Importing seismic data
Import and display single-trace and multi-trace   seismic data saved in SEGY 
format. Before importing the file,   display it in a stand-alone SEGY Viewer to 
review its format and contents.

To import seismic:

1. From the File menu, select Import > Seismic.
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The Import seismic data dialog box opens.

2. Browse to and   select the desired SEGY file.

General file information appears in the File details  pane. Click either Import   or 
SEGY Viewer to review   more file details before importing.

If   you click SEGY Viewer, the SEGY Viewer   dialog box opens. Click various tabs 
to view the file data and select   various formats in which to display the data in the 
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viewer.

3. When you click   Import, the Set time   and range for   dialog box opens.

4. Type a time and   trace range then click OK.

The trace(s) appears in the main synthetic display.

Related topics
"Changing seismic properties" on page 162
"Importing seismic from Kingdom" on the facing page
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Importing seismic from Kingdom
Import Kingdom data into GeoSyn to create a synthetic. Tie the seismic data to a 
well and extract a wavelet. Before importing seismic from Kingdom, you first 
import a well. For details on importing a well, see Related topics below.

To import Seismic from Kingdom:

1. From the File menu, click Kingdom Import and then Seismic Data. The 
Import Kingdom Seismic dialog box will open.

2. Select either the 2D seismic or 3D seismic tab depending on the type of seismic 
to import. The number of seismic sections available is denoted in the label of the 
tab.

3. Populate the dialog box fields, and then click Import.
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Related topics
"Import Kingdom Seismic: 2D" on page 219
"Import Kingdom seismic: 3D" on page 220
"Changing seismic properties" below
"Importing seismic data" on page 158
"Importing wells from Kingdom" on page 29

Changing seismic properties
Change seismic display options including which   samples to display, how to dis-
play them, label text, and more.

To change seismic properties:

1. From the Edit menu, select Seismic properties ( ). 

The Seismic Properties: Display   dialog box opens.

2. In the display   pane, select the seismic trace(s)   for which to configure label and 
layout properties. SHIFT+CLICK or CTRL+CLICK   for multiple selection.

3. Use the tabs to   configure trace display properties as follows:
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Display,   overlay and underlay properties.

Annotations,   trace name and label frequency.

Trace   Layout, number of traces to display.

Processing,   trace processing options including summing raw traces using com-
mon offset points.

Histogram, plot density of data.

Spectrum, graphical display of frequencies and their amplitudes.

4. In the main Seismic Properties   dialog box, click Close to return   to the main syn-
thetic view with the changes applied.

Related topics
"Importing seismic data" on page 158
"Changing color palettes" on page 131
"Tying seismic to models" on the next page
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Tying seismic to models
Tie seismic to a model in the current synthetic for correlation purposes and for 
reverse AVO modelling. 

Kingdom users tie the seismic using GeoSyn, and then save the resulting 
time/depth chart back to Kingdom to assist with the creation of future synthetics.

To tie seismic to models:
 1. Right-click the seismic trace and select Tie Seismic to a Model from 

the popup menu.
The Set time and range for dialog box opens.

 2. Select the time and trace range that includes the well from which the 
synthetic is created, and  then click OK.
The Select Data Sets for Cross-Correlation dialog box opens.
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 3. In the Model Data drop-down list, select a model to which to tie the 
seismic trace, and then click Continue.
The Tie Seismic dialog box opens.
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 4. Select from the following options:

GeoSyn automatically aligns the seismic trace and model trace at the point 
of best fit. To move the point of best fit to another seismic trace, drag the 
slider at the bottom of the seismic sample left or right. 
To move the seismic trace up or down in relation to the model trace, in the 
Cross correlation function pane, drag the vertical slider up or down. The amp-
litude values for the Amplitude and the Amplitude Envelope appear to the 
right of the slider.
Drag the green and the blue horizontal lines that limit the data range to 
exclude unwanted data that appears at the top or bottom of the model or the 
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seismic, which may interfere with the selection of the best tie.

To change the seismic phase or the model phase, drag the sliders or type val-
ues in the boxes below the Phase label in the bottom-left of the dialog box. 
The results appear in the Cross Correlation Function area of the dialog box 
where the red signal represents the seismic pulse and the black signal rep-
resents the amplitude envelope.
To stretch and squeeze the sonic to improve the tie with the sonic, click 
Stretch/Squeeze to display the Stretch and Squeeze dialog box. Hover the 
cursor over the seismic at the point to tie. Click to set the first tie anchor, 
and then hover the cursor over the correlating tie point on the model. Click 
to place  the second anchor, which ties the seismic to the model.

Select multiple points using the above process. For details on stretching and 
squeezing traces, see Correlating Logs and Traces below.
To zoom the seismic pane, click Zoom In and then move the cursor over the 

seismic section (the cursor changes to a magnifying glass ( )), and then 
drag the extents to zoom. Once you've zoomed in, use the Zoom Out option 
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to restore the original screen extents. You can Zoom in multiple times to 
increase magnification and improve accuracy 

To change the trace pane displayed in the Tie Seismic dialog box in either 
the Model data or the Cross correlation function  pane, hover the cursor 

( ) over the display to move then click and hold while dragging the display 
pane up or down.

 5. Click OK to close the Tie Seismic dialog box.

The Time Shift Options dialog box opens.

 6. Select whether to shift the synthetic or the seismic (bulk shift), and 
then click OK.

Related topics
"Changing seismic properties" on page 162
"Stretching and squeezing logs" on page 70
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"Correlating logs and traces" on page 180
"Importing seismic from Kingdom" on page 161

Analyzing velocity and depth
Contained in the chart are the time depth log in blue,   the sonic transit log in red, 
and tops in black. By default, time is two-way,   though you can change it to one-
way.

As you move your cursor time depth, isochron, isopach,   and interval velocity 
information appears in a corresponding dialog box.

To analyze velocity and depth:
 1. From the Utilities menu, select Time vs. Depth.

The Time vs. Depth Chart   dialog box opens.

 2. Click Zoom In then click   and hold the mouse button on the chart 
where you want to begin zooming,   drag a zoom rectangle around the 
area of interest, then release the mouse   button.
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 3. Use the check boxes in the lower-left of the Time Depth Toolkit dialog 
box to select whether to display a basic depth / time grid and the tops 
in the Time vs. Depth Chart.

Related topics
"Drawing straight edge and freehand curves" on page 59
"Applying math equations to logs" on page 77
"Clipping or filtering logs" on page 75

Creating crossplots
Create crossplots using data from logs, seismic,   and models. 

Following are some of the more common crossplots you   might create:

offset   trace along the x axis and an amplitude trace along the y axis.

incident   angle along the x axis and the amplitude from the seismic along the y   
axis.

gradient   on one axis and intercept on the other.

To create crossplots:

1. From the Edit menu, select Cross Plots ( ).

If there isn't already a crossplot in the main   synthetic display, the Crossplot 
Wizard: Select Data Type dialog box opens.
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Otherwise, the Crossplot   Viewer and Crossplot Properties dialog box opens, and 
you must click New   to display the above dialog box.
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2. Select whether   to base the crossplot on time or depth.

172 © 2020 IHS Markit™. All Rights Reserved



Tying seismic to models

The Crossplot Wizard: Select axis data   dialog box opens.

3. Select the logs to plot along first the X axis and then the Y axis.
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The Crossplot Wizard: Set the data range   dialog box opens.

4. Click either Select All, or click Define a data range to display the Define 
Data Window dialog box where you select the sampling (milliseconds for time 
plots and depth   samples for depth data), and the overall duration or depth.
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The Crossplot   Viewer and Crossplot Properties dialog box opens.

5. Configure display   options using the Crossplot Properties: Controls,     Crossplot 
Properties: X and Y Axis, Crossplot Properties: Enclosures, and Crossplot Prop-
erties: Color Mapping tabs.

Related topics
"Annotating crossplots" on the next page
"Color mapping crossplots" on page 178
"Exporting crossplots" on page 192
"Changing color palettes" on page 131
"Inspecting logs" on page 86
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Annotating crossplots
Highlight crossplot features by drawing either a polygon   or ellipse in the Crossplot 
Viewer and then changing the default annotation   display properties. The data 
points that fall within the polygon you draw are highlighted on the synthetic. This 
enables you to see where data points of interest that are on the crossplot come 
from. For details on creating a crossplot, see Related topics below.

When drawing an ellipse, you can specify an eccentricity   of 0 to 0.99 where 0 rep-
resents a circle and 0.99 represents the narrowest   (most eccentric) ellipse. Typ-
ing 1 draws a line instead of an ellipse.

To annotate crossplots:
 1. With at least   one crossplot created in the main synthetic display, from 

the Edit   menu, select Crossplot properties   ( ).

The Crossplot   Viewer and Crossplot Properties: Enclosures dialog box 
opens.

176 © 2020 IHS Markit™. All Rights Reserved



Tying seismic to models

 2. Click the Enclosures tab.

 3. Do either of the   following:

 l To   draw a polygon, click Start,   and then click to define the anchor 
points for the polygon segments in   the Crossplot Viewer. Click End   to 
complete and automatically enclose the polygon.

 l To   draw an ellipse, type a decimal value from 0 to 0.99 in the eccent-
ricity   box. Click Start and then click   to anchor one end of the ellipse. 
Move your mouse across from the start   anchor point to the desired 
end point and then click to anchor that point.

As you draw polygons and ellipses, they're added   to the Enclosure list below 
the drawing controls. Draw multiple annotations to encompass different fea-
tures.

 4. In the Enclosure List, select the annotation with which to work 
(SHIFT+CLICK or   CTRL+CLICK for multiple selection).
In   the Name box, type a descriptive name for the annotation(s) selec-
ted above.

 5. Select from the   following display properties:

 l Outline   to specify the annotation border color.

 l Infill   to specify the annotation fill color within the annotation border.

 l Both   to select one color for both the annotation border and fill.

 6. In the Link List pane, click the synthetic or log on which to display the 
data point highlighting.
To hide an annotation from the Crossplot Viewer, clear the check box in 
the Show column of the Enclosure list. You can also select the enclos-
ure and then press Delete.

Related topics
"Creating crossplots" on page 170
"Color mapping crossplots" on the next page
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Color mapping crossplots
Select areas of the crossplot to color. Either work with a color gradient to change 
the default palette, or use a block fill to change the color of desired cells on the 
grid. The color you apply is also displayed for the data points on the log or syn-
thetic that also fall within that cell.

This functionality is similar to drawing annotations that encompass desired data 
points. For details, see Related topics below.

To color map crossplots:

1. With at least   one crossplot created in the main synthetic display, from the Edit   
menu, select Crossplot properties   ( ).
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The Crossplot   Viewer and Crossplot Properties: Color Mapping dialog box opens.

2. Click the Color Mapping tab.

3. Select either of the   following:
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Gradational, to apply a color to one of the four quadrants that blends with the 
colors from the surrounding three quadrants.

Blocked, to fill individual cells you click with a solid color. In the Columns and 
Rows boxes, type the number of segments into which to divide the overall Cross-
plot Viewer canvas size. For example, if you type 2 in both boxes, the Crossplot 
viewer canvas is divided into four quadrants. If you type 100 in both boxes, the 
Crossplot viewer canvas is divided into a 100 x 100 grid. 

4. Click Brush to select the desired color.

5. In the Link List pane, click the synthetic or log on which to display the data 
point highlighting. 

To hide color coding from the Crossplot Viewer, clear the Enable color coding 
check box.

Related topics
"Creating crossplots" on page 170
"Annotating crossplots" on page 176

Correlating logs and traces
Overlay a GeoSyn correlation on a seismic section displayed on a seismic work-
station.

Correlation windows and all dialog boxes opened from   them float above all applic-
ation windows, not just those in GeoSyn. You   can drag them over a seismic dis-
play in any program for comparison. 

Open any number of correlation windows. Multiple   correlation windows open 
locked together, and some operations such as   zooming or scrolling affect them 
all.

To maximize clarity and minimize clutter, obvious controls   in correlation windows 
are only available when you right-click the correlation   window.

Using the Vertical Scale pane that appears in the Synthetic Properties dialog box, 
select whether the linear scale displayed in the Correlation window is based on 
time or depth. Viewing synthetics in depth can be useful to verify the velocity 
functions upon which a synthetic is derived are accurate.
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To correlate logs and traces:

1. To open a single   correlation window, right-click a log (displayed in a single 
track) or   a trace and select Correlation window   from the pop-up menu 
OR
   To open multiple correlation windows, from the Utilities   menu, select Create 
correlation window(s).

The Create Correlation   Window(s) dialog box opens.

Select the traces or logs for which to create correlation windows   then click OK. 
SHIFT+CLICK or CTRL+CLICK for multiple selection.

If you selected more than one Correlation window,   they open locked together. A 
red horizontal line with yellow triangles at either end indicates the center of the   
correlation window.

2. Drag the Correlation window alongside the trace or log to match.

3. Right-click the window and click Set vertical scale from the shortcut menu. 
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The Set Scales dialog box opens.

4. Do either of the following, and then click Close:

Type a specific increment in the Inches per second box. This distance may not 
equal physical measured distances because online display is defined in pixels and 
varies for different monitor resolutions, but the onscreen display should match 
the same setting defined in other seismic interpretation software.

Click the Center buttons to raise or lower the correlation on a pixel basis. 

Click the Zoom buttons to change the distance between the timing lines in the 
Correlation window. The larger buttons move and zoom the correlation in larger 
pixel increments.

5. Right-click the Correlation window and click Controls from the shortcut menu.
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Depending on whether you displayed the correlation window for a log or trace, 
either the Log   or the Trace   toolbar appears.

Use the log or trace Toolbar to access a number   of dialog boxes, including Log   
Properties, Display   Properties, Tops   Properties, Wavelet   Properties, and more. 
The available controls depend on whether   a log or trace is selected. Change the 
controls by clicking a correlation   window for either a log or trace.

6. Do any of the following:

To move the log or trace vertically,   click and hold the mouse button inside the cor-
relation window and drag   up or down.

To match the scale in the correlation   window with that of the seismic display pro-
gram, SHIFT+CLICK inside the   correlation window and drag. 

To change the trace amplitude,     drag the sliders on the Toolbar.

7. Click Stretch and Squeeze. 
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The Stretch or Squeeze   dialog box opens.

8. Using the model trace, click to define the top of the area on the model to 
stretch and squeeze, and then click the bottom of the area on the model to 
stretch and squeeze.

9. Using the Stretch or Squeeze dialog box, drag the slider to elongate or com-
press the trace within the window defined above.

Related topics
"Stretching and squeezing logs" on page 70
"Tying seismic to models" on page 164
"Importing check shot surveys and vertical seismic profiles" on page 21
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GeoSyn output
There are several ways to output GeoSyn data:

Printing Synthetics By default, a printed page outline appears on the 
main synthetic display bounding the pane that will 
fit on the paper size selected for the default printer.

Reformatting GeoSyn 
and LAS Files

Convert batches of LAS files to GeoSyn format or 
vice versa.

Importing and Exporting 
Images

Copy any individual element that appears in the 
main synthetic display (or the entire synthetic dis-
play) to the Windows clipboard then paste it into 
other applications to create a montage.

Exporting Crossplots Export X and Y coordinates in .CSV format. Export a 
crossplot either using the Crossplot properties dia-
log box or the Export Manager:

Exporting Log Aliases Export a list of all the aliases that GeoSyn uses to 
recognize imported logs.

Exporting Logs Export depth logs in either SEGY binary format (for 
importing in geophysical workstations) or LAS 
format, and time logs in either SEGY or column-
ordered ASCII format (for importing in spread-
sheets).

Exporting Models Export models are saved in either SEGY or ASCII 
format.

Exporting to Petra Export GeoSyn data to Petra in various formats 
including .syn, .emf, LAS, and SEGY format. For LAS 
format, specify the logs to include in the LAS file.

Exporting Seismic Export seismic files in SEGY format.

Exporting Wavelets Export wavelets in SEGY or ASCII format.
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Exporting Tops Lists Save tops lists to disk in ASCII format.

Exporting Tops Tables GeoSyn displays a list of tops in a tops table that 
can be exported in either .emf or ASCII text for 
other applications.

Exporting Time/Depth Export as ASCII file showing times and equivalent 
depths.
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Printing synthetics
By default, a printed page outline appears on the main   synthetic display bounding 
the pane that will fit on the paper size selected   for the default printer. Because 
most printers don't print right to the   edge of the page, an additional three-quar-
ters of an inch of image inside   the print margin won't be printed.

Toggle whether the page outline appears in the main synthetic   display using the 
Synthetic Properties dialog box.

If you change the paper size using the File > Print   Setup dialog box, the page out-
line in the main synthetic display changes   too. 

Print either the current synthetic or select   a group of GeoSyn synthetics saved to 
disk and print them in one batch.   Separate procedures for each appear below. 

To print current synthetics:

1. Verify how the   current synthetic will appear when printed by selecting File   > 
Print Preview. 

The Print Preview   dialog box opens.

2. From the File menu, select Print( ), or click   Print in the Print Preview dia-
log box above.

The Print   dialog box opens.

3. Select the desired   print options then click OK.

To print multiple GeoSyn files:

1. From the File menu, select Printing.

The Batch Printing   dialog box opens.
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2. Click Add files, browse to and select the   desired file(s). SHIFT+CLICK or 
CTRL+CLICK for multiple   selection.

To   sort files by UWI, click either Browse dir.   or Browse sub-dir.   to launch Dir-
ectory Browser. For   details on using Directory Browser, see Related topics below.

3. In the Open   a ... format file dialog box, click Open.

4. Select either   Original parameters to print each   file using display parameters 
specified in its own file, or Import   default file to select a default file from the 
current GeoSyn Working directory from which to use   parameters. 

5. Click OK.

Related topics
"Using Directory Browser" on page 10
"Reformatting GeoSyn and LAS files" below

Reformatting GeoSyn and LAS files
Convert batches of LAS files to GeoSyn format   or vice versa. 
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To reformat GeoSyn and LAS files:

1. From the File menu, select Batch Reformat.

The Batch Reformat   dialog box opens.

2. Click either LAS to GeoSyn reformat or GeoSyn to LAS reformat then click 
Add files.

3. Browse to and   select the desired file(s). SHIFT+CLICK   or CTRL+CLICK for mul-
tiple selection.

To   sort files by UWI, click either Browse dir. or Browse sub-dir.   to launch Dir-
ectory Browser. For details on using Directory Browser, see   Related topics below.

  If   converting LAS to GeoSyn format, ensure you specify that GeoSyn create   a 
constant velocity sonic if none is available, otherwise it ignores LAS   files without 
sonic logs.

4. In the Open   a ... format file dialog box, click Open

5. In the Batch   Reformat dialog box, verify the target directory listed in the   bot-

tom-left is correct or click  to select another then   click OK.

Related topics
"Importing LAS or GeoSyn files" on page 14
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"Using Directory Browser" on page 10
"Printing synthetics" on page 187

Importing and exporting images
Copy any individual element that appears in the   main synthetic display (or the 
entire synthetic display) to the Windows   clipboard then paste it into other applic-
ations to create a montage.

GeoSyn also enables you to paste .emf   files from disk or from your Windows clip-
board into the main synthetic   display and control the placement, size, and vis-
ibility of all pasted   images from one dialog box.

Images that appear in the above dialog box are saved   with the synthetic file, 
even if they're hidden from the main synthetic   display, and can be shown in the 
future.

Separate procedures for pasting Windows clipboard images   and importing .emf 
images appear   below.

To paste images from the Windows   clipboard into GeoSyn:

With   the desired image copied to the Windows clipboard, from the Edit   menu, 
select Paste. 

The image appears in both the main synthetic display   and in the Enhanced   Meta-
files properties dialog box detailed below.

To import .emf   files into GeoSyn:

1. From the Edit menu, select Metafile   properties.
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The Enhanced Metafiles properties   dialog box opens.

2. Click Import   from file.

The image appears both in the main synthetic display   and in the above dialog box 
display pane with an automatically generated   ID.

To modify images pasted into   GeoSyn:

1. From the Edit menu, select Metafile   properties.

The Enhanced Metafiles properties   dialog box opens.
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2. To change the   image ID to something more descriptive, select the row in which 
the image   appears in the above display pane, then type a different name in the 
Label box and click Update.

3. From the Positioning drop-down list, specify   whether the image appears in 
the top-right corner, can be dragged to a   location where it offsets existing syn-
thetic elements, or floats over   synthetic elements without offsetting them.

4. In the Show   column of the display pane, select whether the image is displayed 
in the   synthetic or saved along with it for display in the future. 

GeoSyn only imports files saved in .emf   format. If the above image is pasted from 
the Windows clipboard and you   want to use it in other synthetics without having 
to open this synthetic   and copy it to the Windows clipboard, click Export   and 
save it to disk with a .emf   extension.

Related topics
"About the Main Synthetic Display" on page 45
"Changing the main synthetic display" on page 46

Exporting crossplots
Export X and Y coordinates in .csv format. Export a crossplot either using the 
Crossplot properties dialog box or the Export Manager: Crossplot dialog box. Pro-
cedures for both appear below.

To export crossplots using the Crossplot Properties dialog box:

1. From the Edit menu, select Crossplot properties.
OR
Right-click the crossplot and select Crossplot Properties.
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The Crossplot properties dialog box opens.

2. Click Export, select a location, and then click Save.

3. Click Close to exit the Crossplot Properties dialog box.

To export crossplots using the Export Manager dialog box:

1. From the File menu, select Export.
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The Export Manager: Crossplots dialog box opens.

2. Select the crossplot to export in the display pane, and then click Export.

Related topics
"Creating crossplots" on page 170

Exporting log aliases
Export a list of all the aliases that GeoSyn uses to recognize imported logs. The 
file is exported in ASCII format and you can view it using numerous third-party 
products to determine whether GeoSyn is using a desired alias.

To export log aliases:

1. From the Edit menu, select Default Log Properties  ( ) > Log Library.
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The Properties: Log Library tab appears.

2. Click Export alias list.

3. Browse to a location in which to save the file, and then click Save.

Now open the file using a third-party application such as Microsoft Excel or Win-
dows Notepad.

Related topics
"Changing log defaults" on page 54

Exporting logs
Export depth logs in either SEGY binary format   (for importing in geophysical work-
stations) or LAS format, and time logs   in either SEGY or column-ordered ASCII 
format (for importing in spreadsheets).   

Depth logs are the original logs imported into GeoSyn.   GeoSyn creates time logs 
when importing a sonic log. The time log can   be used by other seismic applic-
ations.
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To export logs:

1. From the File menu, select Export   then click either the Logs (depth)   or Logs 
(time) tab. 

Depending on your selection, either the Export Manager: Logs (Time)   or Export 
Manager: Logs (Depth)   dialog box opens.

2. Select the row   to export and from the File format   drop-down list, select the 
file format for the exported file and click   Export.

If exporting depth logs, you can further select   whether to convert uncommon ali-
ases to something more common to facilitate   importing the log into other applic-
ations and whether to include a list   of tops in the log file.

3. Browse to a disk   location in which to save the file then click Save.

Related topics
"Importing LAS or GeoSyn files" on page 14
"Exporting to Petra" on the facing page

Exporting models
Export models are saved in either SEGY or ASCII format. Time depth information 
added using the Edit > Time Datum dialog box is preserved in the exported SEGY 
file.
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To export models:

1. From the File menu, select either Export   > Models
OR
From the Edit menu, select Model properties ( )   > Export.

The Export Manager: Models   dialog box opens.

2. Select the row   with the model to export and from the File format drop-down 
list, select   the file format for the exported file and click Export.

3. Browse to a disk   location in which to save the file then click Save.

Related topics
"Creating models" on page 106

Exporting to Petra
Export GeoSyn data to Petra in various formats including .syn, .emf, LAS, and 
SEGY format. For LAS format, specify the logs to include in the LAS file. For 
SEGY format, specify the GeoSyn models to include.

The Petra export option is only available if you created a GeoSyn project using 
PetraSeis. For details, see Related topics below.

To Export to Petra:

1. From the File menu, select Petra Export. 
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The Export to Petra Project dialog box opens.

2. Verify the location where to export the file, the format to include (Syn, EMF, 
LAS, SEGY), and then click OK.

Related topics
"Exporting seismic data" below
"Exporting logs" on page 195
"Launching GeoSyn using PetraSeis" on page 38

Exporting seismic data
Export seismic files in SEGY format. Time depth information added using the Edit 
> Time Datum dialog box is preserved in the exported SEGY file.
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To export seismic:

1. From the File menu, select either Export   > Seismic
OR
From the Edit menu, select Seismic properties ( )   > Export.

The Export Manager: Seismic   dialog box opens.

2. Select the row   with the seismic trace to export then click Export.

3. Browse to a disk   location in which to save the file then click Save.

Related topics
"Importing seismic from Kingdom" on page 161
"Exporting to Petra" on page 197

Exporting wavelets
Export wavelets in SEGY or ASCII format. For   details on extracting a zero phase 
wavelet, see Related topics below.

To export wavelets:

1. From the File menu, select either Export   > Wavelets
OR
From the Edit menu, select Wavelet properties ( )   > Export.
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The Export Manager: Wavelets   dialog box opens.

2. Select the row   with the wavelet to export and from the File format drop-down 
list, select   the file format for the exported file and click Export.

3. Browse to a disk   location in which to save the file then click Save.

Related topics
"Creating models" on page 106
"Extracting wavelets" on page 149

Exporting tops lists
Save tops lists to disk in ASCII format. This   file contains tops names, tops depths 
KB, a units flag, and the Kelly   Bushing depth. 

To merge tops from multiple lists into one list, either   export each individual list to 
disk and then concatenate them using an   ASCII text editor, or show all the tops in 
the tops table in the main   synthetic display and copy this data to the Windows 
clipboard, then paste   it into a spreadsheet application or ASCII text editor. For 
details, see   Related topics below.
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To export tops lists:

1. From the File menu, select either Export   > Tops
OR
From the Edit menu, select Tops properties ( ) >   Export
OR
Right-click the tops table and select Tops   properties > Export tops.

To   display the tops table in the main synthetic display, from the Edit   menu, 
select Synthetic properties   ( ) and in the Display elements pane, select 
Tops table.

The Export Manager: Tops   dialog box opens.

2. Select the row   with the list to export then click Export.

3. Browse to a disk   location in which to save the file then click Save.

Related topics
"Tops Lists" on page 89
"Importing tops from GeoSyn files" on page 96
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"Importing tops from delimited files" on page 97
"Importing tops from fixed width files" on page 99
"Importing LAS or GeoSyn files" on page 14

Exporting tops tables
GeoSyn displays a list of tops in a tops table that can   be exported in either .emf 
or   ASCII text for other applications. When multiple tops lists are shown   in the 
main synthetic, all tops are grouped in one tops list. To display   lists separately in 
the main synthetic display (such as a list of check   shot values and a list of tops), 
show one of the lists in the main synthetic   display and copy and paste it into 
GeoSyn, then hide the original list   —not the pasted one, and show the other list.

Copy the data that appears in the tops table   as either a static image or as ASCII 
text. 

Tops tables copied as ASCII text can be pasted into other   applications for modi-
fication including AccuMap Tops Manager, with which   you update the AccuMap 
user tops database.

When the tops table is shown in the main synthetic display,   it offsets other syn-
thetic elements instead of floating over them. Tops   tables copied as images can 
be pasted back into the main synthetic display   as floating images without off-
setting other synthetic elements or pasted   into other applications to create a 
montage.

To export tops tables:

1. To display the   tops table, from the Edit menu,   select Synthetic properties (
) and in the Synthetic   Properties dialog box, select the Tops   table check box 

and the adjacent position radio button.

2. Right-click the   tops table and from the popup menu, select one of the fol-
lowing:

Copy   tops table image to load an image in the Windows clipboard that   can be 
pasted into other applications or pasted back into GeoSyn.

Copy   name and md depth to load only top names and measured depth values   
into the Windows clipboard as ASCII text to paste into a text editor or   spread-
sheet application.
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Copy   all tops info to load all information that appears in the tops   table into the 
Windows clipboard as ASCII text to paste into a text editor   or spreadsheet applic-
ation.

Export   tops to display the Export   Manager and write tops data to disk in ASCII 
format.

Related topics
"Duplicating tops lists" on page 91
"Importing check shot surveys and vertical seismic profiles" on page 21
"Importing directional surveys" on page 16
"Exporting tops lists" on page 200
 

Exporting Time/Depth
Export as ASCII file showing times and equivalent depths. The time depth chart 
can be imported into third-party applications; however, for Kingdom, you can 
save the time depth chart directly to the Kingdom database using GeoSyn. For 
details, see Related topics below.

To export time/depth:

1. From the File menu, select Export   > Time/Depth.
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The Export Manager dialog box opens.

2. Select the row   with the time/depth curve to export then click Export.

3. Browse to a disk   location in which to save the file then click Save.

Related topics
"Importing seismic data" on page 158
"Importing seismic from Kingdom" on page 161
"Importing wells from Kingdom" on page 29
"Exporting to Petra" on page 197
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Appendices
Basic AVO workflow Guide for the use of the   AVO functionality in 

GeoSyn

Check shot computation Check shots to a synthetic computation

Supported file formats .ihs, .syn, .las, .segy

Well symbol legend Table of well symbols provided in GeoSyn

"Wizards and dialog 
boxes " below

Alphabetical listing of all user dialogs

 

Wizards and dialog boxes 
The following pages provide descriptions and definitions of all the wizards and dia-
logs used in GeoSyn.

Blocked log wizard: Create new layers and logs
With this fea-

ture...
Do this...

Display pane Select a formation top to change or remove or above   
which to insert a new formation.

Edit Type the value to place in the cell selected in the   dis-
play pane above. The depth is a positive value (kelly 
bushing).

Layers Click one of the following:
Add   to insert a generic formation top row above the 
row selected in the display   pane above. 
Delete   to remove the row selected in the display pane 
above, or All   to remove all tops columns.

Logs Click one of the following:
Add   to display the Select   from list dialog box and 
select a blocked log type to create.
Delete   to remove the column selected in the display 
pane above, or All   to remove all logs columns.

Enter transit log 
values

Select the depth and time units for converting depth   to 
time.

© 2020 IHS Markit™. All Rights Reserved 205



Appendices

Parent Topics
"Creating blocked log models" on page 65

Blocked log wizard: Description and output 
options
With this feature... Do this...

Labels Type the labels that appear in the main synthetic dis-
play.

KB elevation Depth inc. Type values for the kelly bushing elevation, the depth   
increment, and the top and bottom of the zone.

Top Bottom Type the top and bottom depth of the log

Create an LAS format 
file from the model and 
save to   disk

Toggle whether to create an LAS file for the blocked   log 
that you can subsequently import into GeoSyn and 
other applications.

Create a GeoSyn syn-
thetic

Toggle whether to automatically create a synthetic or   
select the option above instead and then import the 
LAS file.

Parent Topics
"Creating blocked log models" on page 65
"Blocked log wizard: Create new layers and logs" on the previous page

Check shot wizard: Import data
With this fea-

ture...
Do this...

Display pane Select the check shot time depth pair to modify.

Time Depth Type a time and depth pair for a new or existing row.

Insert Update 
Delete   All

Select a check shot in the display pane above and click   
one of the following:
Insert to add a new row with the time depth values 
typed in the   Time and Depth boxes. Regardless of the 
row selected, the inserted row   is placed according to its 
depth.
Update to apply the values typed to the selected row.
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Delete to remove the row or All   to clear the entire dis-
play pane.

Export Import Click to save or load a file in ASCII format.

Parent Topics
"Importing check shot surveys and vertical seismic profiles" on page 21
"Check shot wizard: define datums" below

Check shot wizard: define datums
With this fea-

ture...
Do this...

Check shot source 
offset

Type the check shot offset coordinates.

Check shot depth 
reference

Type the subsea depth from which the check shot 
depths   are measured (typically the same as the log 
KB).

Check shot source 
elevation

Type the subsea depth at which the check shot energy   
source is located. Typically it's deeper than the log KB. 
In a marine   setting, the air guns are a few meters below 
sea level.

Parent Topics
"Importing check shot surveys and vertical seismic profiles" on page 21
"Check shot wizard: Import data" on the previous page
"Check shot wizard: shift time zero" below

Check shot wizard: shift time zero
With this fea-

ture...
Do this...

Time Datum SS Change the default check shot source elevation, which 
by default is the top of the sonic log, to align with the 
seismic time zero. The check shot data is typically at 
the KB whereas seismic data is at the highest elevation 
above the seismic survey to account for variations in sur-
face topography. 

Correction Velo- Specify a velocity that matches the speed of the sub-
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city surface material found in the surface elevations. This 
correction is applied to surface valleys to correct the 
subsurface readings for distortions caused by varying 
surface topography. The change in time is the difference 
between the check shot   time datum and the value in the 
Time  Datum box divided by the datum velocity.
GeoSyn calculates a check shot correction without ref-
erence   to this value, then as a final step, adds or sub-
tracts section to correct   the new time datum.

Drift Calculation Select either a Spline curve or Linear correction type.

Quality control Select from the following:
Drift Curve A record of the transit correction applied to 
each sample   of the original active sonic. Inspect this log 
for large drift corrections.
Check Shot Transit Curve A record of the velocity 
field observed   by the check shot. This log should be a 
rough approximation of the sonic   log and is particularly 
useful for spotting datum errors, such as an incorrect   
well KB or check shot depth datum.
Create New Tops List for Check Shots to import the 
check shot depth   time pairs as tops. You can then check 
the position of these tops in time   on the synthetic 
against the check shot time values. These times differ   if 
the synthetic is moved to a new datum.

Parent Topics
"Importing check shot surveys and vertical seismic profiles" on page 21
"Check shot wizard: define datums" on the previous page

Crossplot wizard: Select data type
With this feature... Do this...

Depth data Time 
data

Select whether to base the crossplot on depth or time   
readings.

Parent Topics
"Creating crossplots" on page 170
"Crossplot wizard: Select data type" above
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Crossplot wizard: Select axis data
With this feature... Do this...

Display pane Click the log upon which to base first the X and then 
the Y axis. 

Parent Topics
"Creating crossplots" on page 170
"Crossplot wizard: Select data type" on the previous page
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Crossplot wizard: Set the data range
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With this feature... Do this...

Display pane Click the data 
upon which to 
base the cross-
plot based on 
the following:

 n Select all 
to select 
the entire 
log depth. 

 n Define a 
data 
range to 
display 
the 
Define   
Data Win-
dow dia-
log box 
and spe-
cify the 
portion of 
the log.

 n Pre-
selected 
Data 
Range to 
use the 
depth 
range spe-
cified in 
the Log 
Inspection 
dialog 
box, 
which is 
launched 
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from the 
Log 
Editor.

Parent Topics
"Creating crossplots" on page 170
"Define data window" on page 244
"Crossplot wizard: Select axis data" on page 209

Data search wizard: Search locations and ranges
With this fea-

ture...                
Do this...                

Add Location | 
Add Range                

Click to display the Edit   a UWI dialog box and select 
the survey system then type coordinates   within which to 
retrieve logs.                 

Remove | All                 Select the specific location or range in the display   pane 
and click Remove,   or click All to clear all locations   and 
ranges from the list.                 

Recent Searches                 Select a search you previously conducted from the drop-
down list.                 

Data Source                 Select whether to retrieve logs from the IHS Information 
Hub or from a local or networked drive. Click Edit online 
configuration to display the Properties:   Con-
figuration dialog box and change folders in which down-
loaded logs are   saved and your connectivity parameters 
for the IHS Information   Hub. For GeoSyn network install-
ations, connectivity parameters (except   user name) 
affect all GeoSyn users.                 

Edit user paths                 Click to display the Set Source and Target dir-
ectories dialog box where you select the source to 
search for data and the location in which to save down-
loaded files.

Parent Topics 
"Downloading logs from the IHS information hub" on page 41
"Launching GeoSyn using AccuMap" on page 35
"Data search wizard: Select data from catalog" on the facing page
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Data search wizard: Select data from catalog
With this fea-

ture...                 
Do this...                 

Node expansion 
buttons 
    ( )                 

Click to expand or contract all well nodes in the display   
pane.

Auto Select                 Click to display the Auto Curve Selection dialog where 
you specify the curve type, author, and other details 
with which to select rows. To select all logs for a well, 
simply click   the well.

Select all | 
Deselect all                 

Select all | Deselect all                 

Display Layout                 Before specifying the Selection   criteria above, click to 
display the Catalog   display options dialog box and 
specify the parameters under which   wells appear in the 
display pane.                 

Report                 Click to output the information that currently appears   in 
the display pane to an ASCII text file.                 

Display pane                 Click + and   - to expand or contract individual nodes   and 
select the desired logs. To select all logs for a well, 
simply click   the well.
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Show                 Toggle whether wells with digital sonic, digital density, 
and a specific depth appear in the display pane. GeoSyn 
automatically creates a constant velocity sonic log if 
none is available in the downloaded log. 
Specify whether undigitized logs and directional surveys 
appear in the display pane. If you try to download an 
undigitized log, an online digitization request form 
appears that you submit to IHS. 
Showing wells without data enables you to at least 
determine that a well UWI exists in the data.                  

Hide if well                 Click whether wells with digital sonic or density, or that 
don't reach a certain depth appear in the display pane.                  

Group multiple 
runs                 

Select whether to merge the overlapping portions of 
curves. Further merge options such as whether to merge 
only curves from a common source and whether to trim 
the shallower or deeper curve appear in the Data 
Search Wizard: Save Options dialog box, which 
appears after you click Next.
                    By default, data on the IHS Information Hub is metric, 
but it can be converted to Imperial.

Parent Topics
"Downloading logs from the IHS information hub" on page 41
"Launching GeoSyn using AccuMap" on page 35
"Data search wizard: Search locations and ranges" on page 212
"Data search wizard: Define save options" below
 

Data search wizard: Define save options
With this feature...                 Do this...                 

Synthetic creation...                 When importing logs from 
a single well, toggle 
whether   to automatically:
Create and launch a syn-
thetic. 
Apply  directional survey 
(if applicable)

Directional survey When you select a dir-
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save options                 ectional survey in the 
Online   Data Search Wiz-
ard: Select Data from 
Catalog dialog box, spe-
cify   the folder and format 
in which to save it.
For directional surveys to   
be visible in Data Search 
Wizard: Select Data 
from Catalog dialog box, 
ensure Service curves is 
selected in the Show 
pane.                 

LAS save options Specify whether down-
loaded curves are saved 
to the default target dir-
ectory. 
Depth increment - 
select the depth incre-
ment with which curves 
will be resampled. If you 
select User defined a 
second drop-down list 
appears where you type 
the desired depth incre-
ment. Using a larger 
depth increment may 
mute some curve details 
in curves with a small 
depth increment. Using a 
smaller depth increment 
may add some undue influ-
ences in curves with a 
large depth increment.
Tops nomenclature - 
select the naming ter-
minology for your tops.
Multiple runs - select 
whether to merge only 
curves from the same 
source and for curves that 
are merged, whether to 
use the portion from the 
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shallower curve (trim 
deep) or use the portion 
from the deeper curve 
(trim shallow). 

Parent Topics
"Downloading logs from the IHS information hub" on page 41
"Launching GeoSyn using AccuMap" on page 35
"Properties: Import defaults" on page 294
"Data search wizard: Select data from catalog" on page 213

Fluid replacement wizard (Input and output logs, 
depth range)

With this fea-
ture...

Do this...

Log tool kit Click to display the Fluid   Replacement Tool Kit dialog 
box to populate the input and output   logs.

Input logs
(P Sonic, S Sonic, 
Density)

GeoSyn automatically populates these boxes with P 
wave,   shear sonic, and density logs if they're present in 
your model. Otherwise, click Log   Took Kit above to 
derive them from other logs. The input logs are   the 
source logs for Gassman's equation.

Porosity Select either a constant porosity percent (most com-
mon),   or derive the porosity percent from a density log. 
Note that a porosity log derived from a density log   may 
not be accurate for zones in which gas is present.

Porosity units Select a scale of either 0-10 or 0-100. GeoSyn analyses   
the data extents and picks the units that seem most 
likely, but you can   override them if some aberrant data 
values cause GeoSyn to select the   wrong units.

Create Missing 
Log Types

Click to display the Generate Logs for Well dialog box 
and derive the logs required as input logs   for fluid 
replacement modelling from other logs in your model. 
For example,   the shear log is typically derived from the 
sonic log.

Duplicate Key 
Logs

Click to create exact copies of existing logs in your   
model for the input logs. You might do this if you want to 
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keep a pristine copy of the original logs.

Output logs Initially, these are copies of the input logs, to which   you 
then apply fluid replacement changes. Specify *Active   
logs in the drop-down lists so that fluid replacement 
changes are automatically   reflected in the current 
model.

Depth range KB Do one of the following:
 Type   start and stop depths and click Update.
   Click   either Top or Bottom   to select an absolute depth 
from the log, or click All   to select both.
   Click   Range from tops to select a zone   of interest 
using the formation top names that also appear in the 
tops   list selected in the Top   Properties dialog box.
Tip:   You can also use your mouse pointer to drag a spe-
cific zone on the Log Editor to specify   a zone of interest.

Parent Topics
"Modelling fluid replacement" on page 115

Fluid replacement wizard (In-situ reservoir prop-
erties)

With this fea-
ture...

Do this...

Matrix Click the thumbnail or drag the white circle to the area in 
the thumbnail that most closely matches the subsurface 
matrix. To type these values directly, clear the Define 
Manually check box. If you click Workshop, the Minerals 
Calculator dialog box opens, where you type the min-
eralogy for a given zone. Use the Identifier radio buttons 
to specify whether the mineral group (Carbonate), or a 
specific member of that group (Calcite) appear in labels 
for the thumbnail. The mineral group and members are 
specified in the Minerals Calculator.

Pore Fluids Click the thumbnail or drag the white circle to the area in 
the thumbnail that most closely matches the subsurface 
pore fluids.    For detailed derivations, click Workshop   to 
display the Batzle   and Wang Fluid Properties Calculator 
dialog box where you specify more   precise values for 
your zone of interest.
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Workshop With the Batzle Wang check box enabled, click Cal-
culator   to display the Batzle   and Wang Fluid Properties 
Calculator dialog box and specify values   specific to your 
zone of interest. 

Averaging 
Method

Select Reuss iso-stress   if fluid ratios are consistent in 
pores throughout the zone of interest;   otherwise, select 
Voight iso-strain.

Quality Control Select check boxes to display values as log overlays in 
the Log Editor.

Parent Topics 
"Modelling fluid replacement" on page 115
"Batzle and Wang fluid properties calculator" on page 232
"Minerals calculator" on page 275
"Fluid replacement wizard (Input and output logs, depth range)" on page 216

Fluid replacement wizard (Calibrate shear log for 
water saturations   < 100%)
This dialog box only appears if the water saturation   defined using the previous dia-
log box is less than 100%.

With this fea-
ture...

Do this...

Apply correction 
using Mavko's Pro-
cedure

It's recommended that you select this to compensate   
for the fact that the shear log is frequently derived from 
a sonic log   using Castagna's formula. Castagna's for-
mula requires a correction when   gas is present in the 
zone of interest. 

Edit Click to display the Edit   the Derivation Equation for 
log dialog box and change the formula.

Parent Topics
"Modelling fluid replacement" on page 115
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Fluid replacement wizard (FRM Modelling: Set 
new water saturation)

With this fea-
ture...

Do this...

Thumbnail Drag the green circle while viewing the effect in the Log 
Editor dialog   box and in the Out of Range box. Click 
Apply   to save these changes to the log.

Depth Range Drag the cursor in the Log Editor to select the area of 
interest. 

Tops Click to display the Depth Range from Tops dialog box, 
where you select the top and bottom formations for the 
zone.

Parent Topics
"Modelling fluid replacement" on page 115
"Fluid replacement wizard (In-situ reservoir properties)" on page 217

Import Kingdom Seismic: 2D
With this fea-

ture...
Do this...

Seismic Survey Select the name of the seismic survey. To change the 
order in which options in this list are displayed, use the 
Sort by option. To reduce the actual volume of seismic 
sections from which to choose, refer to the Survey 
Retrieval option below.

Data Type Select from the various versions of the seismic line that 
may be available. Entries in this list include versions that 
may have been migrated, to which particular filters are 
applied, etc.

Survey Retrieval Specify an are around the wellbore around which to 
retrieve the surveys where increasing the radius 
increases the volume of selections available in the top-
left drop-down list of the Import Kingdom Seismic dialog 
box.

Trace Selection Select whether to automatically pull traces or surface 
positions from the seismic for a given line that fall within 
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a certain distance from the well. These can either be 
selected by line or cross line sequentially (every Nth 
trace or surface point). Unlike shot point, surface pos-
ition is not sequential.
If the Auto select option is cleared, type the min/max 
range for the traces to select.

Time Selection Type the duration of data to retrieve from Kingdom. The 
maximum duration is up to 4 seconds of data. 4 seconds 
is a large volume of data, perhaps 100,000 feet down. 2 
seconds is likely a more appropriate volume of data.

Well Tie Options Select whether to tie the data to the surface or bottom 
hole location. The bottom hole location is typically 
closest to the reservoir target.

Parent Topics 
"Importing seismic from Kingdom" on page 161

Related topics
"Import Kingdom seismic: 3D" below

Import Kingdom seismic: 3D
With this fea-

ture...
Do this...

Seismic Survey Select the name of the seismic survey. To change the 
order in which options in this list are displayed, use the 
Sort by option. To reduce the actual volume of seismic 
sections from which to choose, refer to the Survey 
Retrieval option below.

Data Type Select from the various versions of the seismic line that 
may be available. Entries in this list include versions that 
may have been migrated, to which particular filters are 
applied, etc.

Survey Retrieval Specify an are around the wellbore around which to 
retrieve the surveys where increasing the radius 
increases the volume of selections available in the top-
left drop-down list of the Import Kingdom Seismic dialog 
box.
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Trace Selection Select whether to automatically pull traces or surface 
positions from the seismic for a given line that falls 
within a certain distance from the well. These can either 
be selected by line and opposing cross line, the entire 
line or cross line within a range, or by a given radius 
around the well, which will include both lines and cross 
lines.
If the Select data within check box is cleared, data can 
be retrieved from only a line or cross line instead of a 
radius.
Refer to the Kingdom base map for line and cross line 
numbering.

Time Selection Type the duration of data to retrieve from Kingdom. The 
maximum duration is up to 4 seconds of data. 4 seconds 
is a large volume of data, perhaps 100,000 feet down. 2 
seconds is likely a more appropriate volume of data.

Well Tie Options Select whether to tie the data to the surface or bottom 
hole location. The bottom hole location is typically 
closest to the reservoir target.

Parent Topics 
"Importing seismic from Kingdom" on page 161

Related topics
"Import Kingdom Seismic: 2D" on page 219

Import wizard: Highlight first data line in red
With this feature... Do this...

Display pane Click the first line of data (not column headers) to   
import.

Parent Topics 
"Importing tops from fixed width files" on page 99
"Importing directional surveys" on page 16
"Import Wizard: Highlight last data line in red" on the next page
"Importing wavelets and wavelet sets" on page 136
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Import Wizard: Highlight last data line in red
With this fea-

ture...
Do this...

Display pane Click to define the last line of data to 
import.

Parent Topics 
"Import wizard: Highlight first data line in red" on the previous page
"Importing directional surveys" on page 16
"Import wizard: Set column delimiters" below
"Importing wavelets and wavelet sets" on page 136

Import wizard: Set column delimiters
With this fea-

ture...
Do this...

Fixed width Tab 
Comma

Select the character used to separate values in the   file 
being imported.

Display pane Click to place a column delimeter ( )   before a column of 
data to import or double-click to remove an existing   deli-
meter. Delimeters need to be placed on both the left and 
right of   columns to import.

Identify for 
Import

Click and select the column type from the Select   from 
list dialog box. Columns without headers aren't impor-
ted.

Parent Topics 
"Importing directional surveys" on page 16
"Importing wavelets and wavelet sets" on page 136
"Import Wizard: Highlight last data line in red" above
"Import wizard: Finish" on the facing page
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Import wizard: Finish
With this feature... Do this...

Display pane (for 
tops, check shot, 
and directional   sur-
vey imports)

Review the data that will be imported 
and click Back to make any changes.

Start time End time 
Sample   rate (for 
wavelet imports) 
Time data...

Type the interval time and sample fre-
quency. 

Parent Topics 
"Importing tops from fixed width files" on page 99
"Importing directional surveys" on page 16
"Import wizard: Set column delimiters" on the previous page
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Kingdom Data Browser (Import log data or mod-
els)

Synthetic mode  l Modeling: Time objects are placed by reference to 
a velocity field derived from the sonic log. Time 
data points are discarded after import. Click 
Details... button for advantages and dis-advant-
ages of this option.

 l Correlation: Time objects are placed by reference 
to a velocity field derived from saved time depth 
charts. The correlating seismic procedure is sim-
plified but users should restrain from over editing 
the time depth chart. Click Details... button for 
advantages and dis-advantages of this option.

Get  l Visible well list - wells that appear on the King-
dom base map. Wells may be hidden from the King-
dom base map using Kingdom.

 l All - all wells in the project database. 

Note: A large volume of wells may be associated with a 
given project.

Hide if Well Filter the wells displayed in the well drop-down list above 
using the data associated with each well, and then click 
Apply.

Identify by Select the columns to display in the Model 
Options: Create a new model box, and then click Apply. 
The order in which the columns appear can't be changed; 
however, to display a column as the left most column, 
clear the check box for all other columns so that only the 
desired column remains.

Create a New 
Model

Select the log to import into GeoSyn and upon which to 
base the synthetic.

Open a Geosyn 
Model

View models you've already created in GeoSyn for the 
existing well.

Parent Topics
"Importing wells from Kingdom" on page 29
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Kingdom data browser (Import directional sur-
veys and time depth charts)

With this fea-
ture...

Do this...

View Directional 
Survey

Click to view the directional survey that's automatically 
applied to the well (if available in the data). 

Apply Time Depth 
Corrections to 
Synthetic

Apply a time depth chart that is created when working 
in a given area by tying logs to seismic using Kingdom. 
The time depth chart corrects the sonic log auto-
matically created by GeoSyn by adjusting the sonic's 
time depth points. Click View and Edit to display the 
Time Datum dialog where you add an invisible log sec-
tion above the synthetic.
Alternatively, select Hang synthetic... and then click 
Edit to select a single depth on the wellbore to tie to 
the time on the seismic section. Selecting this option 
requires that you add an invisible log section above the 
synthetic in order to move it down, as logs don't typ-
ically run to surface where time zero is marked. 

Set as Default Select a well from the drop-down list from which to cre-
ate the model and whether to use this well for future 
models.

Drift Correction Correct the sonic by applying the variation between the 
time depth curve  vs. the actual sonic and apply this to 
the synthetic using one of several methods.

Add Drift Curve to 
Display

For quality control, select whether to show the drift 
curve in the main synthetic window; otherwise it only 
exists temporarily in the computer's RAM.

Add the Time 
Depth Chart...

For quality control, select whether to convert the time 
depth points to depth vs. velocity and display the res-
ults in the main synthetic window. The resulting chart 
can be overlaid on the sonic to detect discrepancies 
between the two.

Parent Topics
"Importing wells from Kingdom" on page 29
"Import log data" on page 259
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Service log wizard: Digitizing order information
With this fea-

ture...                 
Do this...                 

Contact Details                 Type your contact information in the related 
fields.                 

Parent Topics
"Downloading logs from the IHS information hub" on page 41

Service log wizard: Comments and curve selec-
tion

With this fea-
ture...                 

Do this...                 

Select curve type                 Select the desired mnemonic from the drop-down 
list.                    

Additional curves, 
remarks                 

Type any special instructions.                 

Parent Topics
"Downloading logs from the IHS information hub" on page 41

Service log wizard: Select curves and digitizing 
range

With this fea-
ture...

Do this...                 

Digitizing range                 Type the depth to digitize.

Digitize all curves on 
this service log                 

Click to digitize every curve on the ser-
vice log.                 

Parent Topics
"Downloading logs from the IHS information hub" on page 41
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Wavelet extraction (Extraction methods)
With this fea-

ture...
Do this...

Import Click to launch the Import Seismic Data dialog box and 
navigate to a SEGY file to import. Once you select the 
SEGY file and click OK, the Set Time Range dialog box 
opens where you specify the time range and number of 
traces to sum.

Extraction Meth-
ods

Seismic Only - this is the default method that has his-
torically been available in GeoSyn.
Seismic Plus Reflection Coefficient Series - the tie 
between the seismic and the synthetic, which is created 
using the Tie Seismic dialog box, must be accurate 
before selecting either of these options.

Next Click to display the Wavelet Extraction (Processing Dis-
play) dialog box.

Parent Topics
"Extracting wavelets" on page 149
"Wavelet properties: Wavelet" on page 330

Wavelet Extraction (Processing Display)
With this fea-

ture...
Do this...

Trace pane View the model displayed in between a section of seis-

mic on its left and right. Drag the green arrows ( ) up 
from the bottom or down from the top of the range.
For Walden White method, a bird's-eye view of the well 
surrounded by the seismic velocity appears above the 
model.

Model Traces Select the number of traces to include from the model. 
For either of the Seismic Plus Reflection Coefficient Ser-
ies options, use the check box to specify whether to 
include the optimum shift determined by GeoSyn.

Extracted Wave-
let pane

Display the wavelet or a spectrum.
Select the length of the wavelet to display. Phase can be 
changed for Frequency Extraction method only. 
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Select whether to use both the Sonic and Density logs to 
derive the wavelet. Clear one of these check boxes 
where the resulting log is inaccurate. 
For Seismic Only method, select how to sum and aver-
age traces.
For Weiner Levinson method, drag the Time Shift... 
slider to shift the log relative to the seismic in order to 
improve the tie. As you drag the slider, the model shifts 
in relation to the seismic in the left-most display pane of 
the Frequency Wavelet Extraction dialog box.

Seismic Selection 
pane

Type a range in the Extraction Time Range boxes to 
change the length of the wavelet to extract. This same 
functionality is available by dragging the green arrows (

) up or down in the Trace pane above.
Select whether the seismic traces that are used from the 
seismic section are those that appear closest to the well 
of all the traces in the seismic, and then type the num-
ber of traces to use. Specify a specific radius from which 
to accept traces to omit traces that are too far away. 
This is the most common option. A number appears to 
the left of the box where you typed that indicates how 
many traces fall within that range. Or click Trace Range 
and search in a range that does not necessarily include 
the nearest traces.

Next Click to display the Wavelet Extraction (Save 
Options) dialog box.

Parent Topics
"Extracting wavelets" on page 149
"Wavelet properties: Wavelet" on page 330
"Wavelet extraction (Extraction methods)" on the previous page

Wavelet extraction (Save options)
With this fea-

ture...
Do this...

Wavelet Name 
and Comment

Type the name and comment associated with this wave-
let in various places throughout GeoSyn.

Replace Model Select a current model(s) in the display pane below, 
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Wavelet(s) and then click to overwrite its wavelets. CTRL+Click or 
SHIFT+Click for multiple selection.

Add to Library Add to the wavelet library.

Export to File Export to a SEGY file.

Apply time shift This option appears when the model is moved in relation 
to the seismic using the slider at the bottom of Extrac-
ted Wavelet pane in the prior dialog box. This shift can 
be permanently applied to the synthetic or simply used 
to extract the wavelet and then abandoned.

Parent Topics
"Extracting wavelets" on page 149
"Exporting wavelets" on page 199
"Wavelet Extraction (Processing Display)" on page 227
"Wavelet properties: Wavelet" on page 330
"Importing wavelets and wavelet sets" on page 136

Model properties (Wavelet equation)
With this fea-

ture...
Do this...

Median Filter 
Points

Filters the sonic. This is the same filter that is available 
in the Log Editor. It is used to reduce high-velocity 
spikes. A high velocity spike can substantially affect pro-
cessing time. It is recommended that this setting be at 
most, 25.

Resample Depth 
Interval To

Reduces the number of depth points in the log. By 
default, this is set to 2. 
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Surface Damping 
Samples

This refers to the buffer area above the surface marker 
in the 1D Wave Equation Viewer that prevents the signal 
from distorting the model. It uses a mathematical equa-
tion to cancel out the return pulse. A buffer is not 
required below the bottom horizon because recording is 
stopped before an echo from below the bottom horizon 
affects the log.

Damping Factor This works in conjunction with the Surface Damping 
Samples option above to cancel out reflections arising 
up from the surface. It is recommended that you do not 
change these settings.

Animation Viewer Click to display the Animation Viewer, which is an anim-
ated view of how the above settings will influence a 
sonic pulse moving through the earth in time. 

Parent Topics
"Extracting wavelets" on page 149

AVO log suite
With this fea-

ture...
Do this...

Log type Select the log type to create.

Derive from Select to derive the log using industry standard for-
mulas,   which you can modify by clicking Edit   to display 
the Edit   the Derivation Equation for log dialog box.
Clearing both the Derive   from and Maintain link   check 
boxes,   creates a straight line log. 

Maintain link Ensure this check box is cleared so that the parent log   
doesn't overwrite changes you make to the derived log.

Parent Topics

"Modelling fluid replacement" on page 115
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Batch printing
With this fea-

ture...
Do this...

Add files Click to browse for GeoSyn files to print.

Remove All In the display pane, select files to delete and click   
Remove, or click   All to clear the entire display   pane.

Display pane Click Add files to populate this pane and if required,   
select files to remove then click Remove.   
SHIFT+CLICK or CTRL+CLICK for multiple selection.

Original para-
meters

Click to print the synthetic using the default file   that 
was automatically saved along with the synthetic. The 
default file   includes key parameters such as layout, 
sample rate, vertical plotting   scale, and more.

Import default file Click to display a list of default files in the GeoSyn   Work-
ing directory and select   one to apply to the entire batch 
of files while printing to ensure consistent   presentation. 
This file won't alter the saved GeoSyn files.

Print Setup Click to display the Print   Setup dialog box and select 
printing options.

Parent Topics
"Print setup" on page 292
"Printing synthetics" on page 187
"Opening GeoSyn synthetics" on page 8
"Open an LAS format file" on page 290
"Directory Browser" on page 245

Batch reformat
With this feature... Do this...

Add files Click to display the Open   an LAS format file or Open   
a GeoSyn format file dialog box and browse for the 
files to reformat.

Remove All Either select individual files In the display pane and   
click Remove, or click   All to clear the entire display   
pane.

© 2020 IHS Markit™. All Rights Reserved 231



Appendices

Display pane Click Add files to populate this pane and if required,   
select files to remove then click Remove.   
SHIFT+CLICK or CTRL+CLICK for multiple selection.

Search for selected 
curve types

If you selected LAS   to GeoSyn reformat, select the 
log type(s) to include in the final   GeoSyn file. 
SHIFT+CLICK or CTRL+CLICK for multiple selection.

LAS to GeoSyn 
reformat GeoSyn 
to LAS   reformat

Select whether to convert LAS files to GeoSyn format 
or to convert GeoSyn files   to LAS format. LAS files con-
tain   raw log data and no formatting information.

If sonic unavailable 
create constant 
velocity sonic

If you selected LAS   to GeoSyn reformat, select to 
create a constant velocity sonic   log. If GeoSyn can't 
find a sonic log in a selected file and this option   is 
cleared, it ignores the entire file.

Rename output 
files using UWI

Select whether to replace the file name with the UWI.   
To determine which UWI formats GeoSyn converts, 
select Edit   > Well and log properties,   and then 
click Edit beside the   UWI box.

Store new GeoSyn 
files in Accept the default directory or click browse ( ) to 

select a different location to write the reformatted   
files.

Parent Topics
"Reformatting GeoSyn and LAS files" on page 188
"Open an LAS format file" on page 290
"Open a GeoSyn format file" on page 290

Batzle and Wang fluid properties calculator
With this fea-

ture...
Do this...

Top portion of dia-
log box

Specify the pressure, temperature, and salinity of the   
reservoir.

Hydrocarbon Specify whether the reservoir includes gas (most com-
mon),   and the specific gravity for the hydrocarbons.
 To simulate dead oil (oil without the presence of gas),   
reduce the GOR to zero.
Note:   Click Close to preserve the values   you've spe-
cified, or click Cancel   to restore the previous values.
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Parent Topics
"Modelling fluid replacement" on page 115
"Fluid replacement wizard (In-situ reservoir properties)" on page 217

Catalog display options
Feature                 Description                

Curve Information 
Options                 

Select data type to display. A check mark ( ) appears 
beside logs   that will be imported.                

Well Sorting Order                  l No sort, (Original order). Default view

 l Sort by UWI, Sorting order can be arranged 
using swap buttons between columns

 l Sort by sub sea (SS) depth

 l Sort by kelly bushing (KB) depth.                 

Parent Topics
"Downloading logs from the IHS information hub" on page 41
"Data search wizard: Select data from catalog" on page 213

Clip or filter the log
With this feature... Do this...

Select Logs Select the log to clip or filter. 

Clip and Replace Select to replace values outside of a defined range   
with specified minimum and maximum values.

DeSpike Select to replace spikes outside of a defined range   
with data values interpolated from the   last good 
data point.

Filtering and Backus 
averaging options

Select the method to average the number of 
samples defined in the   Operator length box by:

 l Median—exact middle value  of window  sorted 
from smallest to largest

 l Arithmetic mean— average value    of selected 
window

 l Harmonic mean—average time value of selec-
ted window

© 2020 IHS Markit™. All Rights Reserved 233



Appendices

 l Triangular—average value in a triangular 
weighted window.

 l Sequential Backus averaging (sliding win-
dow)—averaging rock properties of a group 
of thin layers to approximate the properties 
of a single thick layer

 l Blocked Backus averaging—averaging rock 
properties of a group of thin layers to approx-
imate the properties of a single thick layer. 
Each sample of the block will have that same 
average value.

Time filter Select to filter log at seismic resolution. 
Click Edit to set filter parameters: type, center 
freq, phase, taper and length.

Select depth range KB Do one of the following:
   Type   start and stop depths and click Update.
   Click   either Top or Bottom   to select an absolute 
depth from the log or click All   to select both.
   Click   Depths from tops to select a range   using 
the formation top names that also appear in the 
tops list selected   in the Top Properties   dialog 
box.

Parent Topics
"Clipping or filtering logs" on page 75

Comments
With this fea-

ture...
Do this...

Insert Well His-
tory

Click to place a listing of the historic operations that 
have been performed on a well into the display pane. 
Modify, supplement, and remove details as required 
using the display pane.

Copy | Paste Pasted items saved to the Windows Clipboard or select 
text in the display pane and press Copy to then paste 
them into a third-party application.

Delete All Clear the display pane.
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Parent Topics

"Displaying comments" on page 133

Common offset stack
With this fea-

ture...
Do this...

Time range Type the start and stop time range to import.

Trace range Type the trace range to import. For example, to include   
traces in a specific pane such as near a well. You may 
need a shot point   map to determine the range to 
include.

Offsets Select whether to move in positive, negative, or both dir-
ections when summing the traces. Instead of summing 
traces with matching sub-surface points, GeoSyn sums 
traces with matching offsets.

Parent Topics
"Importing seismic data" on page 158
"Changing seismic properties" on page 162
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Composite templates in working directory
With this feature... Do this...

Delete Delete selected template from working directory.

Import Load an existing template from the GeoSyn work-
ing directory.

Correlation window stretch and squeeze
With this fea-

ture...
Do this...

Slider After defining the top and bottom of the area to stretch 
or squeeze by clicking on the correlation display win-
dow, drag the slider to elongate or compress the selec-
ted area by time or depth.

Taper Select the percentage of samples over which to apply   a 
taper. This prevents the creation of a new reflection 
coefficient (and   therefore reflection) at the top and bot-
tom of the window. The number   of samples is defined 
by the start and stop depth selected.

Max Str/Sqz 2way 
ms

Increase the amount that the correlation can be 
stretched and squeezed.

Minimum Sonic 
| Maximum sonic

Type limits the sonic transit value should not exceed   
while stretching or squeezing.

Parent Topics
"Correlating logs and traces" on page 180
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Correlation window: log
With this feature... Do this...

Display in Time | Display in 
Depth

Select whether 
to display in 
time or depth 
regardless of 
the mode selec-
ted in the main 
display.

Log properties Click to display 
the Well   Prop-
erties: Log   Prop-
erties dialog 
box and adjust 
log display prop-
erties.

Log editing Click to display 
the Log   Editing 
dialog box and 
modify log read-
ings.

Tops properties Click to display 
the Top   Prop-
erties dialog 
box and adjust 
tops properties.

Names | Tops Click whether 
formation top 
names and 
markers appear   
in the Cor-
relation   win-
dow. After 
clicking once to 
display the top 
name, you can 
click   the button 
a second time 
to highlight the 
names so 
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they're easier 
to see.

Vertical scale | Show full 
time range

Type the 
amount by 
which to expand 
or contract  the 
trace to fit the 
current Cor-
relation   win-
dow height, 
and whether to 
use a scale of 
10 or 100 mil-
liseconds. You 
can control 
whether the lin-
ear scale is 
based on time 
or depth using 
the Vertical 
Scale pane of 
the Synthetic 
Properties dia-
log box.

Stretch and Squeeze Click to display 
the Stretch   
and Squeeze 
dialog box and 
adjust the log 
length and 
width.
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Transparency Drag the slider 
to change the 
opacity of the 
Correlation win-
dow to control 
whether details 
underlying the 
Correlation win-
dow are visible.

Maximize Set the Cor-
relation window 
to the full size 
allowed by the 
monitor.

Parent Topics
"Correlating logs and traces" on page 180
"Synthetic properties" on page 312

Correlation window: Trace
With this fea-

ture...
Do this...

Display in Time | 
Display in Depth

Select whether to display in time or depth regardless of 
the mode selected in the main display.

Trace properties Click to display the Model   Properties dialog box and 
adjust model display properties.

Wavelet prop-
erties

Click to display the Wavelet   Properties dialog box 
and adjust wavelet display properties.

Tops properties Click to display the Top   Properties dialog box and 
adjust tops properties.

Names | Tops Click whether formation top names and markers 
appear   in the Correlation   window. After clicking once 
to display the top name, you can click   the button a 
second time to highlight the names so they're easier to 
see.

Vertical scale 
| Show full time 

Type the amount by which to expand or contract  the 
trace to fit the current Correlation   window height, 
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range and whether to use a scale of 10 or 100 milliseconds. 
You can control whether the linear scale is based on 
time or depth using the Vertical Scale pane of the Syn-
thetic Properties dialog box.

Stretch and 
Squeeze

Click to display the Stretch   and Squeeze dialog box 
and adjust the trace length and width.

Transparency Drag the slider to change the opacity of the Correlation 
window to control whether details underlying the Cor-
relation window are visible.

Maximize Set the Correlation window to the full size allowed by 
the monitor.

Phase sliders Click and hold a slider while dragging to change the   
amplitude and phase.

Parent Topics
"Correlating logs and traces" on page 180
"Synthetic properties" on page 312
"Stretch/squeeze log curves in time" on page 309

Create correlation window(s)
With this fea-

ture...
Do this...

Display pane Select the traces or logs to display in a correlation   win-
dow. SHIFT+CLICK or CTRL+CLICK for multiple selec-
tion. 
 Multiple correlation windows are locked and some oper-
ations   performed on one affect all.

Parent Topics
"Correlating logs and traces" on page 180
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…Create new curve type
With this fea-

ture...
Do this...

Name Type a descriptive name that appears above the log in   
the main synthetic display.

API number Type the API number.

Edit Alias Opens "Set log alias selection priority" dialog.

Curve infill Select whether to display a scaled color or lithology.   
For lithology to appear in the main synthetic display, 
formation lithologies   must also be configured in the 
Top   Properties dialog box.

Infill orientation 
Infill palette Trace

Select whether to fill the left or right side of the   log, the 
color palette to use (if scaled color is selected instead 
of   lithology above), and display properties for the trace 
line itself.

Metric to Imperial 
conversion factor

Type a conversion factor.

Track width Type the desired track width to display in the main   syn-
thetic display.

Lines Type Select the line type to display and whether to display   
them in the foreground, background, or not at all.

Auto range Select to automatically adjust scales to actual data   lim-
its.

Parent Topics
"Correcting invalid data when importing" on page 27
"Well properties: Log properties" on page 332

Crossplot properties: Controls
With this fea-

ture...                 
Do this...                 

Labels                 Clear the check box and type different text you want   to 
appear in the main display.                 

Highlight data win- Select whether an outline in the main display shows   the 
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dow                 portion of the synthetic on which the crossplot is based. 
Click Edit to display the Define   Data Window dialog box 
and specify the depth or time upon which   to base the 
crossplot.                 

Trend line                 Select whether to display a linear regression trend   line 
on the crossplot.                 

Symbols                 Select the symbol size, color scheme, and data to which   
to link scatter points. Depending on the Color Reference 
type selected, when you click Color to display the Edit 
Color Palette dialog box, a Histogram pane in the Edit 
Color Palette dialog box enables you to set the min max 
color nodes and thus control how much of the color 
spectrum is used across the data. When Depth is spe-
cified as the Color reference, the histogram doesn't 
appear in the Edit Color Palette dialog box.

Width/Height                 Type the crossplot dimensions and click Update.

Parent Topics
"Creating crossplots" on page 170
"Exporting crossplots" on page 192
"Edit color palette" on page 248

Crossplot properties: color mapping
With this fea-

ture...
Do this...

Enable color map-
ping

Select whether to display the Gradational or Blocked 
color coding in the Crossplot Viewer.

Brush Click to display a dialog box from which you select the 
desired color for either the gradational or block fill 
(depending on your selection above).

Columns Rows Type the number of segments into which to divide the 
canvas horizontally and vertically.

Link list Click the synthetic or log on which to display the data 
point highlighting. 

Parent Topics
"Creating crossplots" on page 170
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Crossplot properties: Enclosures
With this fea-

ture...
Do this...

polygon Click Start   and then click to define the anchor points of 
your polygon on the crossplot   canvas. Click End to com-
plete   and automatically enclose the polygon.

ellipse Type a value in the eccentricity box below then click   
Start and click to anchor one   end of the ellipse. Move 
your mouse to the other desired end of the ellipse   and 
click to anchor that point.

Eccentricity Type a decimal value from 0.01 to 0.99 where 0 rep-
resents   a circle and 0.99 represents an ellipse. Typing 1 
draws a line instead   of an ellipse.

Name Type a meaningful name for the selected annotation(s), 
and then click Update.

Color Click Outline,   Infill, or Both   and select the desired 
color for the selected annotation(s).

Enclosure list Click Show to   display the selected annotation in the 
Crossplot Viewer.

Link list Click the synthetic or log on which to highlight the data 
points encompassed by an annotation.

Parent Topics
"Annotating crossplots" on page 176
"Creating crossplots" on page 170

Crossplot properties: X and Y axis
With this fea-

ture...
Do this...

Data Click Edit to select different series data for the X   or Y 
axis.

Swap axis Click to switch the X and Y axis.

Auto Clear to specify a axis label, units, values, grid options,   
and scale type other than that automatically calculated 
by GeoSyn based   on the crossplot data.
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Parent Topics
"Creating crossplots" on page 170

Cut
With this fea-

ture...
Do this...

Depth range Type the start and stop depth to remove from the log,   
click Top or Bottom to   select either the absolute top or 
bottom of the log, or click Depths from tops to specify 
a zone of interest using tops selected for   display in the 
Tops   Properties dialog box.

Drop top of log 
Raise bottom of 
log

Select whether to lower the start depth or raise the   stop 
depth to compensate for the cut portion. Depending on 
your selection,   all log data either above or below the cut 
portion is shifted.

Parent Topics
"Cutting logs" on page 80

Define data window
With this fea-

ture...
Do this...

Sample Select a sample range to plot. Time samples are used   
for time plots and depth samples are used for depth 
plots.

Time Select a time range to plot.

Depth Select a depth range to plot based on Kelly Bushing   
depth.

Top Select a depth range to plot based on formation tops.

Parent Topics
"Creating crossplots" on page 170
"Crossplot properties: Controls" on page 241
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Directory Browser
With this fea-

ture...
Do this...

Survey system 
tabs

Click to select the appropriate survey system. All files   
with either a .syn or .las extension (depending on how 
you   launched this dialog box) appear in the Labels   tab, 
regardless of whether they include a valid UWI.

Display pane Click a column header to sort rows based on the values   
in that column.
     Click <> to transpose the columns on either side of it.
Right-click a file to view basic log details in a popup win-
dow.

Filter Select then click Edit,   which appears beside the Filter   
box, to display the Edit a UWI dialog box and specify the 
geographic coordinates within which to display UWIs in 
the Directory Browser display pane.

Report Click to display the Browser   report dialog box then click 
Save Report to save the above display to an ASCII 
format file.

Restore order Click to restore the original horizontal and vertical   
column order.

Open Click to open the file selected in the display pane   above.
If Directory Browser is opened from the Import log data 
or Open a GeoSyn format file dialog boxes, you can only 
select one file.   If it's launched from the Batch   printing or 
Batch   reformat dialog boxes, you can select multiple 
files. 
    SHIFT+CLICK or CTRL+CLICK for multiple selection.

Parent Topics
"Using Directory Browser" on page 10
"Opening GeoSyn synthetics" on page 8
"Importing LAS or GeoSyn files" on page 14
"Import log data" on page 259
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Edit a UWI
With this fea-

ture...
Do this...

Survey system 
pane

Click the desired survey system tab and enter coordin-
ates   for a UWI or UWI range (depending on how you 
launched this dialog   box).
Type ?? as a wildcard   when a specific value is unknown.

Parent Topics
"Changing well display properties" on page 50
"Using Directory Browser" on page 10
"Directory Browser" on the previous page
"Launching GeoSyn using AccuMap" on page 35
"Downloading logs from the IHS information hub" on page 41
"Synthetic properties" on page 312
"Well properties: Well properties" on page 334

Log Equation Library
With this 
feature...

Do this...

API num-
ber

Type the API number.

Alias Either type an alias in the box above the Add button   and then 
click Add to include   it in the Alias list, or select   an alias in the 
Alias list and   click Delete. Deleting aliases   may prevent 
GeoSyn from recognizing the aliases of imported logs in the   
future.

Curve infill Select whether the log is colored with a scaled gradient   or 
based on lithology. Even with lithology selected, the lithology 
of   formation tops must be configured in the Top   Properties dia-
log box before it appears in the main synthetic display.

Infill ori-
entation 
Infill 
palette

Select whether the positive or negative portion of the   log is 
colored. Custom color palettes aren't available for default 
curve   types.
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Trace Select the display properties.

Metric to 
Imperial 
conversion 
factor

Type the factor with which to convert Metric to Imperial.

Track 
width

Type the desired track display width.

Lines Type Select whether lines appear on the log and whether they're   log-
arithmic or linear.

Auto range Select to automatically adjust scales to data limits   or clear and 
type custom minimum and maximum values.

Display in 
velocity 
units (for 
sonic logs)

Select whether to display the log in velocity units   and type the 
range.
 

Parent Topics
"Changing log defaults" on page 54
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Edit color palette
With this fea-

ture...
Do this...

Histogram
(appears for mod-
els and some 
cross plots)

View where amplitudes in the selected model fall. 
A histogram is a density graph, with amplitude range 
along the vertical scale and bins along the horizontal 
scale. Seeing where the amplitudes cluster enables you 
to tailor the color display accordingly so that a fuller 
color spectrum is expressed in the model or cross plot. 
This is done by dragging the min max colors closer to 
the bottom and top of where most of the amplitude data 
falls.
Note that for cross plots, the color reference type spe-
cified in the cross plot dialog box determines whether 
the histogram pane appears. For logs, colors are typ-
ically associated with particular values based on litho-
logy so it's not possible to override this by dragging the 
min max color nodes for logs.

Palette Hover the cursor over an adjacent node until the cursor   
becomes a square then click and hold the mouse button 
while dragging the   color node up or down to move the 
corresponding color.

Palette Name Type a unique name by which to save the current 
palette   configuration in the GeoSyn Working   directory 
then click Save.

Palette selection Either select a default palette that shipped with GeoSyn   
or click Load to browse to and   select a custom palette 
you previously created.

Drag and drop 
node colors

Click and hold the mouse button on a color then drag   it 
onto either the color bar or onto a node adjacent to the 
color bar   and release the mouse button. If you release 
the color on the color bar,   a new corresponding node for 
that color appears beside the color bar.

Custom colors Click  to display the Custom Colors dialog box where 
you click the color to set as a custom color, and then 
drag the color to the desired location on the Palette strip 
to apply it. Custom colors are set in the registry so that 
they persist across GeoSyn sessions.
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Nodes Select from the following: 
Add   to place additional nodes beside the color bar on 
which you can drop colors.   
Remove   to delete the last node placed.
Flip   to flip the color bar on its center horizontal axis.
Even   to evenly disperse the existing nodes along the 
color bar.
Rotate   to shift all the colors one node down. The bot-
tom node becomes the top   node.

Color Interpolation 
style

Select whether to display a color gradient or solid   color 
blocks.

Frequency Select so that the center of the palette is anchored to the 
center of the amplitude data. Clear to skew the coloring of 
the amplitude points. You might choose to skew the col-
oring for logs, but not likely for models. Click All to return 
the min max colors to the bottom and top of the histogram.

None Click to remove all color from the color bar.

Parent Topics
"Changing color palettes" on page 131
"Changing log display properties" on page 52
"Creating models" on page 106
"Creating crossplots" on page 170

Edit default display properties
With this fea-

ture...
Do this...

API number Type the API number.

Equation log ref-
erence

Displays the log reference. It's this name that you 
select when building equations using the Log Equation 
library.

Edit equations Click to launch the Log Equation Library dialog box 
where you can apply mathematical equations to the cur-
rent curve type.

Alias Either type an alias in the box above the Add button   
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and then click Add to include   it in the Alias list, or 
select   an alias in the Alias list and   click Delete. Delet-
ing aliases   may prevent GeoSyn from recognizing the 
aliases of imported logs in the   future.

Curve infill Select whether the log is colored with a scaled gradient   
or based on lithology. Even with lithology selected, the 
lithology of   formation tops must be configured in the 
Top   Properties dialog box before it appears in the 
main synthetic display.

Infill orientation 
Infill palette

Select whether the positive or negative portion of the   
log is colored. Custom color palettes aren't available for 
default curve   types.

Trace Select the display properties.

Metric to Imperial 
conversion factor

Type the factor with which to convert Metric to Imper-
ial.

Track width Type the desired track display width.

Lines Type Select whether lines appear on the log and whether 
they're   logarithmic or linear.

Auto range Select to automatically adjust scales to data limits   or 
clear and type custom minimum and maximum values.

Display in velocity 
units (for sonic 
logs)

Select whether to display the log in velocity units   and 
type the range.
 

Parent Topics
"Using Directory Browser" on page 10
"Opening GeoSyn synthetics" on page 8
"Importing LAS or GeoSyn files" on page 14
"Import log data" on page 259

Edit EBCDIC Header
With this feature... Do this...

Display pane Select a value to change and then click 
Update.

Parent Topics
"SEGY viewer" on page 299
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"Import seismic data" on page 260

Edit Lithology
With this fea-

ture...
Do this...

Display pane Select the lithology for which to change the color.

Edit color Click to display the Color palette and using the Color   
palette, click the desired color for the lithology selected 
in the Edit Lithology display pane above. You can also 
click Define Custom Colors to create a color that 
doesn't already appear in the Basic colors options. The 
new color is applied to the lithology type throughout this 
and future cross sections.

Parent Topics
"Changing tops properties" on page 89
"Top properties" on page 323
"Duplicating tops lists" on page 91
"Importing tops from delimited files" on page 97
"Importing tops from fixed width files" on page 99
"Importing tops from GeoSyn files" on page 96
"Importing tops from LAS and ASCII Files" on page 104

Edit the derivation equation
With this feature... Do this...

Equation options 
panes

Drag terms into the Metric or Imperial equation box or 
simply use the panes for reference as you type dir-
ectly in the Metric and Imperial boxes.

Velocity | Transit 
output
(only appears for 
Sonic and Shear 
sonic curve types)

Select the output type. Internally, GeoSyn interprets 
sonic logs in transit format.

Metric | Imperial Drag terms from the equation options panes or simply 
type in these boxes. You must define each of these, 
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although they can be identical. Click Down or Up 
under the Copy option to quickly copy a created equa-
tion into the blank box so that you can modify it.

Description Type a description for the equation.

Equation library ref-
erence

Select a function from the library to modify. The first 
drop-down list box is relevant to the current log. The 
second drop-down list box includes all equations in 
the library, which may not be relevant to the current 
log.

Edit library Click to display the Log Equation Library dialog box.

Add to library Click to add this equation as a user equation in the 
function library. This is particularly helpful to add equa-
tions you've created in the past to the function library 
without having to retype the entire equation from 
scratch.

Color code the equa-
tions

Select whether equation terms are colored red, green, 
and blue. If selected, when you type terms in the Met-
ric or Imperial boxes, GeoSyn applies the default col-
ors to what you type.

Parent Topics
"Applying math equations to logs" on page 77
"Log equation library" on page 270

Edit the derivation equation for log
With this fea-

ture...
Do this...

Equation Modify the formula.

Function library Select a different library to display a different formula,   
or if you've modified the equation, select a library to 
revert to the   original formula.

Parent Topics
"Modelling fluid replacement" on page 115
"AVO log suite" on page 230
"Fluid replacement wizard (Calibrate shear log for water saturations   < 100%)" 
on page 218
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Enhanced meta-files properties
With this fea-

ture...
Do this...

Display pane Click the Show   column to toggle whether an image 
appears in the current synthetic or   is merely saved 
along with it for future use. Select a row to change, 
delete, duplicate, or export   the corresponding image.
SHIFT+CLICK or CTRL+CLICK to select multiple rows.

Duplicate Click to make a second copy of the image selected in   
the display pane in the current synthetic.

Export Click to output the image selected in the display pane   to 
disk in .emf format.

Import Paste 
from clipboard

Click to import a file from disk saved in .emf   format, or 
to paste a metafile image copied to your Windows clip-
board   from any application when you pressed 
ALT+PRINT   SCRN.

Label Type a more descriptive reference for the image selec-
ted   in the display pane above.

Positioning Select whether the image is fixed in the upper right   
corner (banner), movable but wrapped by adjacent 
items, or movable and   layered over other synthetic ele-
ments.

Size Toggle whether to maintain the image proportions then   
type a desired height or width, or click and hold the 
mouse button while   dragging one of the image's handles 
in the main synthetic display. You   can click Restore ori-
ginal size   even after resizing an image multiple times 
to restore it to the originally   imported size.

Parent Topics
"Importing and exporting images" on page 190
"Changing the main synthetic display" on page 46
"Synthetic properties" on page 312
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Export manager: Crossplots
With this fea-

ture...
Do this...

Display pane Select the crossplot to write to a .csv   file of 
X Y coordinates. You can only export one crossplot at a 
time.

Parent Topics 
"Exporting crossplots" on page 192

Export Manager: Logs depth
With this fea-

ture...
Do this...

Display pane Select the log to write to an ASCII LAS or SEGY format   
file. You can only export one log at a time.

Export transit data 
in velocity units

Select whether to display units in microseconds per   
meter for a velocity curve or meters per second for 
standard LAS format.

Reset log aliases 
to workstation 
friendly

Select to set the alias for exported sonic, density,   and 
gamma ray logs to DT, RHOB, and GR to facilitate 
importing those logs   into other applications. For 
example, if the alias for a sonic in GeoSyn   is DTXY, 
selecting   Workstation friendly converts   it to DT on 
export.

Include tops list in 
file

Select whether to write the current top names and 
depths   to the export file.

Include GeoSyn 
well editing history 
(LAS export only)

Select whether the date, time, and description of 
changes   made to a log using the Log Editor are written 
in the non-standard section   of the exported LAS file 
below the header.

Parent Topics
"Exporting logs" on page 195
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Export Manager: Logs time
With this fea-

ture...
Do this...

Display pane Select the log to write to an LAS or SEGY format file.   
You can only export one log at a time.

File format Select whether to export the log as a fixed format,   
column-ordered, ASCII format file for importing into 
spreadsheets, or   as a SEGY binary file for importing into 
a geophysical workstations.

Duplicates Type a value greater than one to export a number of   
traces to a SEGY file that you then import into GeoSyn.

Export transit data 
in velocity units

Select whether to display units in microseconds per   
meter for a velocity curve or meters per second for 
standard LAS format.

Parent Topics
"Exporting logs" on page 195

Export Manager: Time/Depth
With this fea-

ture...
Do this...

Display pane Select the row with the time/depth log to write to an   
ASCII format file.

Depth Increment Type the depth increment along which readings are plot-
ted.

Auto-block by 
Culling Values 
from the Time-
Depth Curve that 
Exceed

Type the sonic log values above which to block when 
creating the time/depth chart. This function is based on 
sonic transit time calculations and uses the time depth 
log generated from the main sonic log. Culling works as 
follows: GeoSyn first works down the log to determine 
the average velocity, and then working down the log 
again, sums the time. While drawing the log as blocks, 
where the actual time minus the calculated time over a 
given depth range using the average velocity exceeds 
the culling value, the current log block is ended and a 
new block is started. 
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Block at a Con-
stant Interval

Type a depth interval increment at which to ignore val-
ues in order to create a coarser time depth chart.

Time Specify whether the time scale is seconds or mil-
liseconds.

Delimiter Select whether a comma or space defines individual 
data items in the file.

Parent Topics
"Exporting Time/Depth" on page 203

Export Manager: Models
With this fea-

ture...
Do this...

Display pane Select the model to write to an ASCII or SEGY format   
file. You can only export one model at a time.

File format Select whether to export the model as a fixed format,   
column-ordered, ASCII format file for importing into 
spreadsheets, or   as a SEGY binary file for import into   a 
geophysical workstation.

Parent Topics
"Exporting models" on page 196
 

Export Manager: Seismic
With this fea-

ture...
Do this...

Display pane Select the seismic trace to write to a SEGY format file.   
You can only export one seismic trace at a time.

Parent Topics
"Exporting seismic data" on page 198
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Export Manager: Tops
With this fea-

ture...
Do this...

Display pane Select the row with the list of tops to write to an   ASCII 
format file. You can only export one tops list at a time.

Parent Topics
"Exporting tops lists" on page 200
 

Export Manager: Wavelets
With this fea-

ture...
Do this...

Display pane Select the wavelet to write to an ASCII or SEGY format   
file. You can only export one wavelet at a time.

File format Select whether to export the wavelet as a fixed format,   
column-ordered, ASCII format file for importing into 
spreadsheets, or   as a SEGY binary file for import into   a 
geophysical workstation.

Parent Topics
"Exporting wavelets" on page 199

Export to Petra project
With this fea-

ture...
Do this...

Export to Petra 
project located at

Click Edit and select the directory to which to export 
the project. The default project is the project directory 
specified by PetraSeis when you used PetraSeis to cre-
ate a synthetic in GeoSyn.

GeoSyn format file Select whether to export a .syn file.
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Synthetic image Select whether to export an .emf file.

LAS format file Select whether to export an LAS file , and if so, select 
the logs to include in the LAS file using the LAS display 
pane.

SEGY format mod-
els

Select whether to include a SEGY file, and if so, select 
the model to include in the SEGY file using the 
SEGY display pane.

Parent Topics
"Exporting to Petra" on page 197

GeoSyn settings
With this fea-

ture...
Do this...

Logs Select the Log(s) to export to GeoSyn. SHIFT+Click 
and CTRL+Click for multiple selection.

Tops Select the tops to export to GeoSyn. SHIFT+Click and 
CTRL+Click for multiple selection.

Active Select whether to include only the active curves and 
horizons, providing they are already defined in Petra.

Parent Topics 
"Launching GeoSyn using PetraSeis" on page 38

Import data for well
With this feature... Do this...

Petra export Select the well and logs to import into GeoSyn.

Petra/GeoSyn pro-
ject folder

Select any data included in the PetraSeis folder that 
may be used in GeoSyn.

Other data Select data such as seismic lines, and directional sur-
veys.

Import depth incre-
ment

Select the imported log from which to use the desired 
depth increment.
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Parent Topics 
"Launching GeoSyn using PetraSeis" on page 38

Import log data
With this fea-

ture...
Do this...

Recent Displays the last five logs imported.

Display pane Select the LAS or GeoSyn file with data to import.

GeoSyn/LAS 
format file

View basic log details about the file selected in the   dis-
play pane above.

Restrict depth 
range

Click to display the actual depth specified in the file   and 
then type different values in the adjacent boxes to 
change the zone   of interest.

Import data is TVD 
corrected

Select whether the log is recorded in Measured Depth   
or True Vertical Depth so GeoSyn places the tops 
loaded from the local   AccuMap system and user data-
bases at the correct depth.

File filter To limit the file types in the display pane above, from   
the drop-down list select either *.syn   or *.las.

File viewer If importing data from an LAS file, click to launch   the 
file selected in the display pane above in an ASCII text 
editor to   verify or modify its contents before importing.

Browse dir.   
Browse sub-dir

Click to display Directory Browser displaying LAS and   
GeoSyn files in either the current   directory or in the cur-
rent directory and all its subdirectories too.

Import Create a synthetic using the file selected in the display   
pane above and based on the import defaults file set-
tings.

Parent Topics 
"Using Directory Browser" on page 10
"Importing LAS or GeoSyn files" on page 14
"Creating log composites" on page 81
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Import seismic data
With this fea-

ture...
Do this...

Recent Displays the last five seismic files imported.

Display pane Select the .sgy   file to import.

File details Basic file information appears for the file selected   in the 
display pane above. 

Import Click to import the file selected in the display pane   
above.

SEGY Viewer Click to launch a SEGY Viewer to view header, trace,   and 
format data for the file before importing, or to locate 
problems that   affected a previous import. Seismic file 
data can't be modified using   this viewer.

Parent Topics 
"Importing seismic data" on page 158

Import tops
With this fea-

ture...
Do this...

Recent Displays the last five Tops files imported.

Top depth place-
ment

Select whether to space tops evenly or according to   
the kelly bushing or subsea. If based on depth. tops 
outside of the depth   range of the model aren't placed.

Bulk shift top 
depths by + -

Type a negative or positive value by which to shift   the 
top depth.

Import top depths 
units

Select the measurement system GeoSyn is using.

Delete current tops 
before importing 
new tops

Select to delete all tops in the tops list to which   tops 
will be imported. If this check box is cleared, tops with 
the same   name in the donor and recipient list appear 
twice in the recipient list.

File viewer If importing an ASCII format file, select the file and   
then click to display the file contents in an ASCII text 
editor.
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Parent Topics 
"Importing tops from LAS and ASCII Files" on page 104
"Importing tops from GeoSyn files" on page 96
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Import Wavelet Processing Flow
With this fea-

ture...
Do this...

Apply taper dur-
ing import

Select whether to apply tapering during import. Although   
optional, if non-zero data is encountered near the end of 
an imported   trace, spurious high-frequency energy may 
appear in the wavelet.

Wavelet name Type the name by which to identify the wavelet in the   
main display.

Operator length Type the operator length (longer operators include more   
detail) at which to extract wavelets. Extracting wavelets 
using a long   operator enables you to shorten the wave-
let length later without damaging   the detail of the amp-
litude spectrum. GeoSyn saves only the amplitude   and 
phase spectrums, and calculates time wavelets as 
required.

Taper Select the taper method to apply to the operator that's   
extracted from the import trace after it's auto-cor-
related. 

Parent Topics 
 
 
 
 

"Importing wavelets and wavelet sets" on page 136  

Insert constant value log section
With this fea-

ture...
Do this...

Insert at Select either depth or time and then either type a depth   
below or above which to insert a log section or click 
Top   or Bottom to select the absolute   top or bottom of 
the log.

Insertion range Select either depth or time and then type a depth thick-
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ness   to insert.

Insertion values To adjust the value inserted in various logs, select   the 
desired row and type a constant value to insert in the 
Edit   log insertion value box.

Resetting top or 
bottom of well

Select whether to raise the start depth or lower the   
stop depth to accommodate the insertion.

Parent Topics
"Inserting log sections using log editor" on page 59

Kingdom import horizon  picks
Drop down list List of available surveys tied to selected well

Visible only Selects only active surveys

2D search radius Custom search radius setting for 2D seismic lines

Retrieve 1 picks Select either: 
 l Time picks

 l Depth picks

Tie to well Select picks from either: 
 l Surface

 l Bottom (default)

Visible horizons only Display only active horizons

Depths in KB Toggles pick listbetween KB or SS

Horizon list List of available horizon picks to import

Import Imports selected horizon picks.
Note: Kingdom time picks are converted to depth 
picks in order to display in GeoSyn as a top.

Parent Topics
Top Properties

Kingdom import tops by author
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With this 
feature...

Do this...

Author 
list

Click which author(s) to   import tops from. 

Parent Topics
Top Properties

Log blocking
With this fea-

ture...
Do this...

Auto-Block by 
Culling...

Cull values that exceed the reading specified in the adja-
cent box. Culling works as follows: GeoSyn first works 
down the log to determine the average velocity, and 
then working down the log again, sums the time. While 
drawing the log as blocks, where the actual time minus 
the calculated time over a given depth range using the 
average velocity exceeds the culling value, the current 
log block is ended and a new block is started. This option 
faithfully reproduces the velocity field, but more 
coarsely, which can be useful for AVO analysis when you 
want to simplify the geologic model by removing tuning 
effects.

Block Between 
Tops

Select whether to apply a mean, median, or RMS con-
stant   average to the log portion between the shallowest 
and deepest top within   your selection.

Log list Select the log to block.

Set depth range 
KB

Do one of the following:

 l Type   start and stop depths and click Update.

 l Click   either Top or Bottom   to select an absolute 
depth from the log or click All   to select both.

 l Click   Get range from tops to select a range   using 
the formation top names that also appear in the 
tops list selected   in the Top Properties   dialog 
box.
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Parent Topics
"Creating blocked log models" on page 65

Log Composite
With this fea-

ture...                 
Do this...                 

Unmatched                 Drag logs that weren't automatically matched to the 
desired host log in the Matched pane or drag matched 
logs from the Matched pane into the Unmatched pane 
to remove the association.                 

Matched                 Drag the left-most cell up or down to a different log to 
change an association.                 

Resort                 Select either Alias or GeoSyn name. Typically the 
most accurate option is GeoSyn name.                 

Range                 Do one of the following:                     
 l Type   start and stop depths and click Update.

 l Click   either Top or Bottom   to select an abso-
lute depth from the log.

 l Click   Depths from tops to select a range   using 
the formation top names that also appear in the 
tops list selected   in the Top Properties   dialog 
box. The selected donor depth range must fall 
within the   host depth range.

To add the donor log section to the base of the host   
well, in the Host replacement depth range, click 
Bottom   to display the exact base of the host well 
and then type this value in the   donor well Top   box.

Raise log data and 
tops above the inser-
tion | Lower log data 
and tops below the 
insertion                 

Select whether to move overlapping data in the host   
log above or below the insertion.

Copy tops                 Select whether to copy tops from the donor well to 
the   host well. These tops are copied to the Generic   
tops list.                 

Parent Topics
"Creating log composites" on page 81
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Log Editor
The Log Editor allows you to edit and manipulate well logs.

To open the Log Editor:

 n Edit > Log editing

 n Double click on a log in the model.

 n Right-click on a log and select Log editing.
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Log tabs across 
the top —Click 
to view and 
work with dif-
ferent logs. Drag 
tabs left or right 
to change order.
 

Draw a free-
hand line.

Draw a straight 
line.

Redraw all or 
some of the log 
as blocks using 
an averaging or 
a culling 
method.

Insert   a new log 
section.

Stretch or 
squeeze a log.

Clip or filter a 
log.

Apply a math 
equation to a 
log.

Remove a seg-
ment from a log.

Model different 
water saturation 
effects on the 
log.

Model different 
porosity levels 
on the log.

Create a log 
composite by 
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inserting log   
data from 
another well.

Merge two logs.

Shift a log rel-
ative to other 
logs by   depth.

Insert a top at a 
location you 
click on the log.

 Undo and redo 
previous 
changes.

Zoom a log por-
tion in   or out.

Expand or con-
tract the   Log 
Editor tab dis-
play.

Change the min-
imum maximum 
values of   the log 
scale.

Close the Log 
Editor

Related Topics
"Drawing straight edge and freehand curves" on page 59
Inserting log sections using log editor
"Creating blocked log models" on page 65
"Inserting tops" on page 94
"Stretching and squeezing logs" on page 70
"Clipping or filtering logs" on page 75
"Applying math equations to logs" on page 77
"Cutting logs" on page 80
"Modelling fluid replacement" on page 115
"Shifting logs" on page 84
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"Creating log composites" on page 81
"Changing log editor display" on page 85
"Log Editor display properties" below

Log Editor display properties
With this fea-

ture...
Do this...

Show Select a row to modify its scale. You can't modify mul-
tiple   log scales simultaneously.

View editing his-
tory

Click to display a list of all changes made to the curve.   
Saved changes span multiple GeoSyn sessions. 

Restore Defaults Restore one or more logs using the main synthetic.

Scale range Type minimum and maximum values for the log scale 
and   then click Update.

Velocity Transit If a sonic log is selected in the display pane above,   
select whether it displays velocity or transit units.

Restore default 
scales

Reapply the default scales with which GeoSyn ships to 
either the current log or to all log types.

Show off-scale Select whether red lines appear in Log Editor beside   
amplitudes that exceed the minimum and maximum 
scale values.

Show tops name Select whether to display formation top names in the   
Log Editing   dialog box. The Show check box   must also 
be selected in the Top   Properties dialog box for the 
tops to appear.

Multi-log per 
track

Select whether to display multiple logs per track based   
on the log types defined in the Well   Properties: Log 
Properties dialog box.

Use log display 
colors

Select whether to display the colors defined using the   
settings in the Well   Properties: Log Properties dia-
log box.

Parent Topics
"Changing log editor display" on page 85
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Log equation library
With this feature... Do this...

Log type Select the log type under which the equation will be 
grouped in the Log Equation Library.

Log function Displays the name of the equation with which you're 
currently working. If you've already clicked Add, the 
term (User) follows the equation name. User equa-
tions appear first in this drop-down list. 

Update | Add 
| Delete

GeoSyn prevents you from overwriting default library 
equations, thus Update and Delete are inactive until 
you click Add to create a copy of a modified default 
equation. Once the copy is made, Update and Delete 
become available. When you click Add, GeoSyn veri-
fies your equation is valid.

Equation options 
panes

Drag terms into the Metric or Imperial equation box 
or simply use the panes for reference as you type dir-
ectly in the Metric and Imperial boxes.

Velocity | Transit 
output
(only appears for 
Sonic and Shear 
sonic curve types)

Select the output type. Internally, GeoSyn interprets 
sonic logs in transit format.

Metric | Imperial Drag terms from the equation options panes or simply 
type in these boxes. You must define each of these, 
although they can be identical. Click Down or Up 
under the Copy option to quickly copy a created equa-
tion into the blank box so that you can modify it.

Descriptions In the first box, type a description to differentiate this 
equation from other similar equations. The description 
you type appears in the Log function box when you 
click Update or Add and it is this description that you 
use to select the equation from others in a drop-down 
list when applying the equation to a log.

Color code the equa-
tions

Select whether equation terms are colored red, green, 
and blue. If selected, when you type terms in the Met-
ric or Imperial boxes, GeoSyn applies the default col-
ors to what you type.
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Parent Topics
"Applying math equations to logs" on page 77
"Building equations using the log equation library" on page 57

Log math
With this fea-

ture...
Do this...

Compose an 
equation

Type directly in the box and then click Update, or add 
terms to the equation by selecting them in the following 
drop-down lists:

Equation terms Select terms to add to the equation, which appears in the 
top box of the Compose an Equation pane, by  selecting 
terms from the drop-down lists.

Function 
Library

Either select a function to modify from the Log Equation 
Library, or click Edit to launch the Log Equation Library dia-
log box with which you compose the desired equation.

Log resolution Associate logs with equation variables defined above and 
after selecting the desired depth range below, click 
Create New Log.
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Log Type Variables you typed in your equation above that haven't 
been defined yet appear here.

Depth Range 
KB

Do one of the following: 
Type start and stop depths and click Update. 
Click either Top or Bottom to select an absolute depth 
from the log or click All to select both. 
Click Depths from tops to select a range using the form-
ation top names that also appear in the tops list selected 
in the Top Properties dialog box.

Reset Output 
Log Scales

Select to reset the log scales based on the resulting data 
range. This will reset the log scale so that the resulting dis-
play isn't blank. Clear this option to maintain a preferred or 
industry-standard log scales as you might with sonic logs, 
for example.

Parent Topics
"Applying math equations to logs" on page 77
"Log equation library" on page 270

Log inspection
With this fea-

ture...
Do this...

Select a Log Click to select the log to display in the Log Inspection dia-
log box.

Histogram View the where the log data falls. The individual data val-
ues are listed in the pane to the right, and a statistical 
summary appears above the data range pane.

Select a Depth 
Range

select the depth range to interrogate. This can be done 
by typing in the boxes, or by clicking the Tops button to 
display the Depth Range from Tops dialog box and then 
selecting the upper and lower tops that bound the range 
in the model, and then click Update. You can also drag 
the desired range using the Log Editor dialog box and 
the Log Inspection dialog box is automatically updated.
                To reset the range, click either Top or Bottom (to 
move only one element of the range), or click All.

Launch Crossplot Click to display the Crossplot wizard, which only uses 
the data range specified above.
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Parent Topics
"Inspecting logs" on page 86
"Creating crossplots" on page 170

Measured depth to true vertical depth correction
With this fea-

ture...
Do this...

Display pane Select the row to adjust.

Insert Update 
Delete

Select a row in the display pane above and click one   of 
the following:
Insert to add a new row with the values typed in the 
MD, Dip, and   Azimuth boxes. Regardless of the row 
selected, the inserted row is placed   according to its 
depth.
Update to apply the values typed in the MD, Dip, and 
Azimuth boxes   to the selected row.
Delete to remove the row.

Delete Click to remove the row selected in the display pane.

Input data set 
type

Select from the following:
MD, AZ, DIP for data that includes azimuth and dip 
data
MD, TVD, dX, dY for data that includes True Vertical 
Depth, Delta   X, and Delta Y. Delta X and Delta Y values 
are optional.

Survey units are Select the units used in the import file. The default   is 
the unit type in which the synthetic is displayed.

Import survey Click to display the Import   a Directional Survey dia-
log box and browse to the file to import.   Imported files 
overwrite values in the display pane above.

Save report Save the display pane as an ASCII text file.

Parent Topics
"Importing directional surveys" on page 16
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Merge Log Runs
With this fea-

ture...
Do this...

Unmerged Logs This pane is divided into three vertical portions: the 
host, donor, and spliced views. Preview the host, donor 
log relationship as you click host and donor curves in the 
Host and Donor panes below this pane. Either drag the 
display or drag the slider to the left of the Unmerged 
Logs display pane to change where the merge point 
(indicated by the green line running horizontally through 
the Unmerged Logs pane) appears. Click the Zoom but-
tons to the right of the pane to increase or decrease the 
zoom scale.

Host pane 
| Donor pane

Click the logs to merge. Based on the host or donor log 
you click, GeoSyn attempts to match the most likely pro-
spect in the opposite pane.

Donor KB Type a kelly bushing that matches the kelly bushing of 
the host log.

Merge at Either drag the Unmerged Logs pane to change the 
depth at which the two log runs are merged, or type a 
value and then click Update. To complete the merge 
operation, click Merge at.

Merged Logs After Merge at in the bottom left of the Merge Log Runs 
dialog is clicked, the resulting merged log appears in this 
pane.

Include Tops 
check box

Select whether to keep or import (or both) tops from the 
host and donor log. GeoSyn enables you to show mul-
tiple instances of the same top in a well, so if tops from 
both logs are included and the same top exists in both 
the donor and the host log, the merged log will include 
both.

Show Select whether to display the entire log runs or just the 
portion of the logs that overlap in the Unmerged Logs 
and Merged Logs panes.

Scales Select whether horizontal and vertical scale lines appear 
in the Unmerged Logs and Merged Logs panes.

Parent Topics
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"Merging logs" on page 72  

Mineral selector
With this fea-

ture...
Do this...

Rock Properties Click the mineral with which to populate the selected   
field in the Minerals   Calculator dialog box.

References If uncertain why to pick one member over another in the 
Rock Properties tab, note the number for each in the 
Reference column and then click the References tab and 
scroll to the corresponding number for a text and page 
reference that describes the unique properties of each.

Parent Topics
"Modelling fluid replacement" on page 115

Minerals calculator
With this fea-

ture...
Do this...

Mineral Click Select   to display the Mineral Selector dialog box 
for up to five minerals for which GeoSyn calculates   an 
average using either the Voight-Reuss-Hill or Hashin-
Shtrikman formulas   specified. 

Volume Type the percentage of pore volume this mineral occu-
pies.   Note that you can't proceed beyond this dialog 
box until the combined   volume of the minerals you've 
selected equals 100%.

Matrix Averaging 
Formula

Select Voight-Reuss-Hill   if the matrix is fairly homo-
genous for a straight arithmetic averaging   formula, or 
select Hashin-Shtrikman   if the matrix is more com-
plex.

Parent Topics
"Modelling fluid replacement" on page 115
"Fluid replacement wizard (In-situ reservoir properties)" on page 217
"Mineral selector" above
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Model porosity dialog
Insitu porosity Enter the logs Insitu porosity 

value 

Fluid properties Select a salinity level

P Sonic Select active sonic or none

Density Select active density log or none

Model Porosity Slider Slider adjusts porosity value  
according to selected equation

Wylies time average

Velocity Average

Raymer etal
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Depth range KB Set the depth range using one of 
the following methods:

 l Enter top and bottom 
depths and click Update.

 l Click and drag  on a the log 
editors log to select a depth 
range.

 l Click Top or Bottom to 
accept the absolute depth 
from the log or click All to 
accept both.

 l Click Tops to display and 
select formation tops that 
signify your zone of 
interest.

Samples Number of samples in depth 
range. Value is automatically pop-
ulated once the depth range has 
been established.

Range Overall depth measurement. 
Value is automatically populated 
once the depth range has been 
established.

Parent Topics
"Changing model porosity" on page 122

Model properties: Derived
With this fea-

ture...
Do this...

Display pane Select a model(s) to modify (SHIFT+CLICK or 
CTRL+CLICK   for multiple selection), then click either 
New   or Duplicate. 

Name Type a more descriptive name for the model.

Type Select from the following:
Zero   offset
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Multi   offset
Derived   based on a mathematical operation performed 
on two other models in the   current synthetic.

Attribute Select the mathematical transformation used to explain   
the data.

Amplitude Type the display amplitude of the trace data.

Reflection Coef-
ficients

Select the source curve and method to use when cre-
ating the AVO logs. Click Create AVO Log suite to cre-
ate numerous types of logs to use   in AVO analysis.

Multiples Select whether to display simulated first order multiples   
alongside primary reflections, or to just display mul-
tiples and not the   primary reflection. First order mul-
tiples are the first reflection of   a primary reflection.

Cutoff % Max RC Type the maximum percent for the reflection coefficient   
below which multiples are not shown. GeoSyn cal-
culates the maximum reflection   coefficient in the 
model, uses a percentage of that, and ignores all reflec-
tion   coefficients less than that.

AGC Type a value for the automatic gain control.

Noise Select the Apply check box and then click Edit to display 
the Noise Parameters dialog box, where you apply noise 
type.

Derived trace is equal 
to

From the drop down lists select the traces and math-
ematical   operator for the equation. The result of which is 
the derived trace.

Parent Topics
"Changing derived properties" on page 128
"Creating models" on page 106
"Creating AVO logs" on page 112
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Model properties: Display
With this fea-

ture...
Do this...

Display pane Select a model(s) to modify (SHIFT+CLICK or 
CTRL+CLICK for multiple selection), then click either 
New   or Duplicate. 

Name Type a more descriptive name for the model.

Type Select from the following:

 l Zero offset

 l Multi offset

 l Derived based on a mathematical operation per-
formed on two other models in the current syn-
thetic.

Attribute Select the mathematical transformation used to explain 
the data.

Amplitude Type the display amplitude of the trace data.

Reflection Coef-
ficients

Select the source curve and method to use when cre-
ating the AVO logs. Click Create AVO Log suite to cre-
ate numerous types of logs to use in AVO analysis.

Multiples Select whether to display simulated first order multiples 
alongside primary reflections, or to just display mul-
tiples and not the primary reflection. First order mul-
tiples are the first reflection of a primary reflection.

Cutoff % Max RC Type the maximum percent for the reflection coefficient 
below which multiples are not shown. GeoSyn calculates 
the maximum reflection coefficient in the model, uses a 
percentage of that, and ignores all reflection coefficients 
less than that.
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AGC Type a value in milliseconds for the automatic gain con-
trol.

Noise Select the Apply check box and then click Edit to dis-
play the Noise Parameters dialog box, where you apply 
noise type.

Display tab Specify the following:
 l Traces/in - The number of traces to display per 

inch in the main window.

 l Traces/grp - The number of traces to display in a 
group and whether to display both positive and 
negative groups.

 l Spacing - The amount of space between groups of 
traces.

 l Color - A line style and color and then click Edit to 
display the Edit Color Palette dialog box.

 l Underlay link - Shows whether the current trace 
displays highlights from a crossplot using the 
Crossplot Viewer: Color Mapping tab.

 l Quick change - Apply multiple changes sim-
ultaneously. These options are groups of individual 
options that also appear in the Attribute drop down 
list above.

 l Font - Click Edit and specify a font for model 
labels.

Parent Topics
"Changing wavelet expansion properties" on page 145
"Creating models" on page 106
"Creating AVO logs" on page 112
"Edit color palette" on page 248
"Noise parameters" on page 289

Model Properties: Expanded
With this fea-

ture... Do this...

Display pane Select a model(s) to modify (SHIFT+CLICK or 
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CTRL+CLICK   for multiple selection), then click either 
New   or Duplicate. 

Name Type a more descriptive name for the model.

Type

Select from the following:
Zero   offset
Multi   offset
Derived   based on a mathematical operation performed 
on two other models in the   current synthetic.

Attribute Select the mathematical transformation used to explain   
the data.

Amplitude Type the display amplitude of the trace data.

Reflection coef-
ficients

Select the source curve and method to use when cre-
ating the AVO logs. Click Create AVO Log suite to cre-
ate numerous types of logs to use   in AVO analysis.

Multiples

Select whether to display simulated first order mul-
tiples   alongside primary reflections, or to just display 
multiples and not the   primary reflection. First order mul-
tiples are the first reflection of   a primary reflection.

Cutoff % Max RC

Type the maximum percent for the reflection coefficient   
below which multiples are not shown. GeoSyn cal-
culates the maximum reflection   coefficient in the 
model, uses a percentage of that, and ignores all reflec-
tion   coefficients less than that.

AGC Type a value in milliseconds for the automatic gain con-
trol.

Noise 
Select the Apply check box and then click Edit to dis-
play the Noise Parameters dialog box, where you 
apply noise type.

Expanded tab
Drag the sliders to select the width of the desired dis-
play size, the reflection coefficient cutoff, and the wave-
let fill pane.

Parent Topics
 
 
 
 
 

"Changing wavelet expansion properties" on 
page 145

"Creating models" on 
page 106

"Creating AVO logs" on page 112  
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Model properties: Filter panel
With this fea-

ture...
Do this...

Display pane Select a model(s)   to modify (SHIFT+CLICK or 
CTRL+CLICK for multiple selection), then click   either 
New or Duplicate.   

Name Type a more descriptive name for the model.

Type Select from the following:
Zero   offset
Zero Offset Filter Panel to enable the Filter Panel tab 
where you apply filters to the left and right edges of a 
group of traces that resolve (average out) in the 
middle trace of the group.
Multi   offset
Derived   based on a mathematical operation per-
formed on two other models in the   current synthetic.

Attribute Select the mathematical transformation used to 
explain   the data.

Amplitude Type the display amplitude of the trace data.

Reflection Coef-
ficients

Select the source curve and method to use when cre-
ating the AVO logs. Click Create AVO Log suite to cre-
ate numerous types of logs to use   in AVO analysis.

Multiples Select whether to display simulated first order mul-
tiples   alongside primary reflections, or to just display 
multiples and not the   primary reflection. First order mul-
tiples are the first reflection of   a primary reflection.

Cutoff % Max RC Type the maximum percent for the reflection coef-
ficient   below which multiples are not shown. GeoSyn 
calculates the maximum reflection   coefficient in the 
model, uses a percentage of that, and ignores all reflec-
tion   coefficients less than that.

AGC Type a value for the automatic gain control.

Noise Select the Apply check box and then click Edit to dis-
play the Noise Parameters dialog box, where you 
apply noise type.

Type Select the type of trace, which applies to the entire 
group of traces.
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Taper Select the method by which to taper the operator 
extracted from the center of the summed and tapered 
traces.

Length Select the longest operator possible to ensure the amp-
litude spectrum retains as much detail as possible. 

Low cut | Low pass 
| High pass | High 
cut

Modify the energy shape either by typing the actual 
source values provided with the seismic data or by 
modifying the wavelet shape to visually match the seis-
mic data. 

Phase Drag the slider or type a value for the phase.

Parent Topics
"Creating models" on page 106
"Applying multiple filters across a group of traces" on page 108

Model properties: Multi offset
With this fea-

ture...
Do this...

Display pane Select a model(s)   to modify (SHIFT+CLICK or 
CTRL+CLICK for multiple selection), then click   either 
New or Duplicate.   

Name Type a more descriptive name for the model.

Type Select from the following:
Zero   offset
Multi   offset
Derived   based on a mathematical operation performed 
on two other models in the   current synthetic.

Attribute Select the mathematical transformation used to explain   
the data.

Amplitude Type the display amplitude of the trace data.

Multiples Select whether to display simulated first order multiples   
alongside primary reflections, or to just display mul-
tiples and not the   primary reflection. First order mul-
tiples are the first reflection of   a primary reflection.

Cutoff % Max RC Type the maximum percent for the reflection coefficient   
below which multiples are not shown. GeoSyn calculates 
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the maximum reflection   coefficient in the model, uses a 
percentage of that, and ignores all reflection   coefficients 
less than that.

AGC Type a value for the automatic gain control.

Noise Select the Apply check box and then click Edit to dis-
play the Noise Parameters dialog box, where you 
apply noise type.

Ray trace method Select Dix NMO   for a preliminary fast view, or Ray 
trace   for improved accuracy using a full Snell's   law ray-
tracing algorithm. 

Ray trace vertical 
sampling interval

Select whether sampling frequency is based on time 
(constant time) or   depth (constant depth) and type an 
increment.

Bin Width Set the threshold within which reflecting seismic rays 
will be included in a trace. A larger bin number will 
include more rays but the resulting trace will be less 
accurate.

CDP interval Type a value that matches the common depth point 
interval   of the seismic to which the model will be com-
pared. CDP is half of the   surface offset.

Num traces Type the total number of traces to display in the model.   

Near trace offset Type the distance from the source at which the nearest   
receiver appears. The distance to other receivers is cal-
culated using   this value, the CDP interval, and the Num 
traces values above.
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Show offset 
traces Show 
summed trace

Select whether to show individual traces for each 
receiver   and whether to sum all the traces into one trace 
displayed to the left   of the model. Click Edit to display 
the Sum Options dialog box where you define groups of 
traces (near, middle, far) and then do mathematical 
operations between the three groups, which enables you 
to filter or enhance certain portions of the offset trace. 
For example, you might subtract the far traces from the 
near traces and then multiple the result by the far traces 
to enhance the far offset amplitude.

Apply NMO cor-
rection 

Simulate the normal move-out stretch.

Mute if incident 
angle is

Apply an inside or outside angle outside of which data 
won't be included in the trace. The incident   angle is cal-
culated at each sample. The mute line is drawn on your 
synthetic to show where data is being cutoff. Select the 
color in which this line is drawn using the Mute color 
drop-down list.

Parent Topics
"Changing multi-offset properties" on page 129
"Creating AVO logs" on page 112
"Creating models" on page 106
"Sum options" on page 311

Model properties (Wavelet equation)
With this fea-

ture...
Do this...

Median Filter 
Points

Filters the sonic. This is the same filter that is available 
in the Log Editor. It is used to reduce high-velocity 
spikes. A high velocity spike can substantially affect pro-
cessing time. It is recommended that this setting be at 
most, 25.

Resample Depth 
Interval To

Reduces the number of depth points in the log. By 
default, this is set to 2. 

Surface Damping 
Samples

This refers to the buffer area above the surface marker 
in the 1D Wave Equation Viewer that prevents the signal 
from distorting the model. It uses a mathematical equa-
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tion to cancel out the return pulse. A buffer is not 
required below the bottom horizon because recording is 
stopped before an echo from below the bottom horizon 
affects the log.

Damping Factor This works in conjunction with the Surface Damping 
Samples option above to cancel out reflections arising 
up from the surface. It is recommended that you do not 
change these settings.

Animation Viewer Click to display the Animation Viewer, which is an anim-
ated view of how the above settings will influence a 
sonic pulse moving through the earth in time. 

Parent Topics
"Extracting wavelets" on page 149

Model properties: Wavelets
With this fea-

ture...
Do this...

Display pane Select the wavelet with which to work. Clear Show all 
wavelets if you're already working with the desired 
wavelet   to increase the work space in this dialog box.

Name Type a name with which the wavelet is identified in   the 
main synthetic display.

Type Select a predefined filter to apply to the wavelet selec-
ted   in the display pane. Controls to specify the cut and 
pass frequencies   appear below based on your selection.

Attribute Select the mathematical transformation used to explain   
the data.

Amplitude Type the display amplitude of the trace data.

Reflection Coef-
ficients

Select the source curve and method to use when cre-
ating the AVO logs. Click Create AVO Log suite to cre-
ate numerous types of logs to use   in AVO analysis.

Multiples Select whether to display simulated first order multiples   
alongside primary reflections, or to just display mul-
tiples and not the   primary reflection. First order mul-
tiples are the first reflection of   a primary reflection.
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Cutoff % Max RC Type the maximum percent for the reflection coefficient   
below which multiples are not shown. GeoSyn cal-
culates the maximum reflection   coefficient in the 
model, uses a percentage of that, and ignores all reflec-
tion   coefficients less than that.

AGC Type a value for the automatic gain control.

Noise  Select the Apply check box and then click Edit to dis-
play the Noise Parameters dialog box, where you 
apply noise type.

Wavelets Click Edit to display the Wavelet Properties dialog 
box, where you change wavelet and spectrum prop-
erties.

Parent Topics
"Changing wavelet properties" on page 143
"Importing wavelets and wavelet sets" on page 136
"Exporting wavelets" on page 199
"Extracting wavelets" on page 149
"Wavelet properties: Spectrums" on page 329
"Creating AVO logs" on page 112
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Multi-Log per Track Layout
With this fea-

ture...
Do this...

Log name Select the name or type of log to display in a given 
track. Click All unselected linear logs or All unse-
lected logarithmic logs to ensure none of the avail-
able logs are dropped.

Parent Topics
 
 
 
 
 

"Combining logs in tracks" on page 62 "Multi-log per track template" below

Multi-log per track template
With this fea-

ture...
Do this...

Template name Type a descriptive name for the template to distinguish   
it from others you create. The template file is saved in 
the GeoSyn Working directory with the associated   
description you type. 

Populate tracks Select whether to populate tracks of a given log type by 
type (sonic, density, etc.) or by log name (delta-T, Bulk 
Density, etc.). Even if manually by name is selected 
as your method by which to populate tracks, when 
GeoSyn saves your track population preferences to the 
default file for the first time, it saves the log type, not 
the log name, as logs can have numerous esoteric 
names which are difficult for GeoSyn to correlate back to 
a log type. 
 
Click Edit to display the Multi-log per track layout dialog 
box where you select the log types or log names to dis-
play in a given track. 
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Show empty 
tracks

Select to display tracks regardless of whether they   con-
tain logs and provided that Show Track   is also selected 
on each individual tab below.

Show track Select to display the selected track provided it contains   
a log. To ensure the selected track appears regardless 
of whether it contains   a log, also select Show empty 
tracks above.

Track width | Fol-
lowing gap

Type the width of the track and the space between 
tracks.   

Scale type Select either Linear   or Logarithmic scale display 
types.

Minor divisions | 
Major divisions

Depending on the scale type selected above, type either   
the minor and major scale increments, or the left and 
right scale.

Cross overs Click the check box to the left of the drop-down list and 
then select either a log that appears in the model or 
select Fixed value, depending on whether to infill 
curves where the two intersect or to infill where a curve 
exceeds a given value. 
Shift the log scales by either typing a value directly in 
the shift scales by box or by clicking .

Color Click to display the Edit Color Palette dialog box and 
select either a solid color or color gradient with which to 
highlight the cross over.

Import and edit Click to either load a template from the GeoSyn Working 
directory or to edit existing   template.

Parent Topics
"Combining logs in tracks" on page 62
"Well properties: Log properties" on page 332

Noise parameters
With this fea-

ture...
Do this...

Signal to Noise Adjust the signal to noise ratio.

Noise Type Select the noise type to apply to the model. Select 
from White or Gaussian.
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Band Limiting Select a predefined filter to apply to the model.

Parent Topics
"Creating AVO logs" on page 112
"Creating models" on page 106

Open a GeoSyn format file
With this fea-

ture...
Do this...

Display pane Select a GeoSyn file to display general file information 
in the GeoSyn format file pane below.

GeoSyn format file 
pane

View basic location, label, depth, and log details for the 
file selected in the display pane above.

Browse dir. 
Browse sub-dir

Click to display Directory Browser displaying LAS and 
GeoSyn files in either the current directory or the cur-
rent directory and its subdirectories too.

Open Create a synthetic using the file selected in the display 
pane above.

Parent Topics
"Reformatting GeoSyn and LAS files" on page 188
"Opening GeoSyn synthetics" on page 8
"Using Directory Browser" on page 10
"Directory Browser" on page 245
"Batch reformat" on page 231

Open an LAS format file
With this fea-

ture...
Do this...

Display pane Select the LAS file with data to import.

LAS format file View basic log details about the file selected in the   dis-
play pane above.

Restrict depth 
range

Click to display the actual depth specified in the file   and 
then type different values in the adjacent boxes to 
change the zone   of interest.
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Import data is 
TVD corrected

Select whether the log is recorded in Measured Depth   or 
True Vertical Depth so GeoSyn places the tops loaded 
from the local   AccuMap system and user databases at 
the correct depth.

File filter To limit the file types in the display pane above, from   
the drop-down list select *.las.

File viewer Click to launch the file selected in the display pane   
above in an ASCII text editor to verify or modify its con-
tents before   importing.

Browse dir.   
Browse sub-dir

Click to display Directory Browser displaying LAS and   
GeoSyn files in either the current   directory or in the cur-
rent directory and all its subdirectories too.

Import Create a synthetic using the file selected in the display   
pane above and based on the import defaults file set-
tings.

Parent Topics
"Reformatting GeoSyn and LAS files" on page 188
"Batch reformat" on page 231
"Directory Browser" on page 245

Print
With this fea-

ture...
Do this...

Name Select a printer or plotter.

Properties Click to set print properties. Options in the Properties 
dialog   box are unique to various printers, so we don't 
discuss them here. Refer   to the printer documentation 
for details.
 If using a plotter, to customize the page size, click the 
Paper   Size tab then click Properties > More Sizes.

Print range Type the page number range to print.

Copies Select the number of copies to print.

Parent Topics
"Printing synthetics" on page 187
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Print preview
With this fea-

ture...
Do this...

Print Click to display the Print   dialog box and print directly 
from the current dialog box.

Next page prev (pre-
vious) page

If printing a multi-page layout, click to navigate 
through   the pages.

Zoom in Zoom out Click to zoom. Zoom   Out is grayed out until you 
zoom in one level.

Two Page | One 
Page

Click to specify whether this dialog box displays one   
or two pages at a time.

Parent Topics
"Printing synthetics" on page 187

Print setup
With this fea-

ture...
Do this...

Name Select the printer model.

Properties Click to display the Properties   dialog box where you 
select options unique to your printer.
Note that if you are using a plotter, you are not limited 
to the paper   sizes shown in the Size box of   the Print 
Setup dialog box. To customize your page size, click the 
Paper   Size tab then click Properties > More Sizes.

Paper Select the Size   and Source options specific to   your 
printer. For example, if you select a plotter, you will see 
some   large paper sizes in the Size   list. If you are print-
ing Letter size paper, you can also select which   paper 
tray you want to print from in Source.

Orientation Select Portrait   or Landscape orientation.

Network This function is not discussed as it is specific to   your 
computer network.

Parent Topics
"Printing synthetics" on page 187
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Properties: Configuration
With this fea-

ture...
Do this...

Executables View the directory where GeoSyn operational files are   
located. For standalone installations, the Executables   
and Working directories are the   same. For networked 
configurations, the Executables   directory is shared. 
Changing this directory may prevent GeoSyn from loc-
ating   both the licensing file it requires to launch, and 
the IHS Information   Hub download parameters.

Working View the directory where customizable files such as   
color palette, log import defaults, and user default files 
are located   or click Edit to change it. To   maintain the 
integrity of each users' custom settings, it's recom-
mended   that the Working directory not be shared.

GeoSyn 
Addresses

View GeoSyn contact information and click EMail  to 
write an email message or click Open to launch the IHS 
web site.

IHS Online Data 
Retrieval Info

View information required to connect to the IHS   Online 
Data Hub. For network installations, these settings 
affect all   users. If you don't have a subscription to down-
load online digits, leave   these boxes blank. Changing 
this connectivity information may prevent GeoSyn   from 
downloading online digits.

User name | Show 
transaction warn-
ing   prompt

View or type your user name and toggle whether to dis-
play   a warning message when downloading digits may 
incur a charge.

Parent Topics
"Configuring GeoSyn defaults" on page 6
"Downloading logs from the IHS information hub" on page 41
"Launching GeoSyn using AccuMap" on page 35
"Data search wizard: Search locations and ranges" on page 212
"Properties: Import defaults" on the next page
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Properties: Import defaults
With this fea-

ture...
Do this...

Current default 
file

From the drop-down list, select a default file to either   
modify or apply to the current synthetic, or click New   to 
display the New   default file name dialog box and 
type the name of the default file   to create that inherits 
settings from the current synthetic. Default files are 
saved in the GeoSyn Working   directory and as part of 
the current synthetic configuration.

Update current 
default file with 
synthetic

Write the configuration settings in the synthetic to the 
default file selected in the Current default file drop-
down list above.

Update synthetic 
with current 
default file

Apply the configuration settings from the default file 
selected in the Current default file drop-down list above 
to the synthetic , overwriting any configurations you 
may have made in the current file.

Default file 
description

Double-click each heading or click +   and - to expand 
and contract related   properties beneath each node. The 
parameters   in the default file tree display the settings 
of the default file selected   above.

Parent Topics
"Changing import defaults" on page 12
"Import log data" on page 259

Properties: Log library
With this fea-

ture...
Do this...

Display pane To view current default settings, double-click node   text 
or click + and -.

New curve Click to display the Create   New Curve Type dialog 
box and specify default parameters for a   new curve.

Export alias list Click to export a list of all the aliases GeoSyn uses to 
recognize imported logs. 

Delete Click to delete the selected curve type. Curves that   can 
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be used as active logs (sonic, shear sonic, time depth, 
density, and   poisson's ratio) can't be deleted. Deleting 
logs may prevent GeoSyn from   recognizing imported log 
aliases. 

Edit Click to display the Edit Default Display Propertiesdialog 
box where you change curve display properties and cre-
ate curve equations for only the current curve type. To 
change properties for any curve type, click Edit Curve 
Equations below.

Alias  priority Set import order priority of available log aliases

Log Equations Click to display the Log Equation Library dialog box 
where you change curve display properties and create 
curve equations for any curve type.

Parent Topics
"Changing log defaults" on page 54
"Exporting log aliases" on page 194
"Log equation library" on page 270
"Edit default display properties" on page 249

Properties: Statistics
With this fea-

ture...
Do this...

Data ranges Select the log and view its original raw data and the   res-
ulting converted values in GeoSyn following import.

Parent Topics
"Viewing synthetic statistics" on page 44
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Quick Start and Generation mode
With this fea-
ture...

Do this...

Modeling mode 
(default)

Time objects are placed by ref-
erence to a velocity field derived 
from the sonic log. Time data 
points are discarded after import. 
Click Details... button for advant-
ages and dis-advantages of this 
option.

Correlation mode Time objects are placed by ref-
erence to a velocity field derived 
from saved time depth charts. The 
correlating seismic procedure is 
simplified but users should restrain 
from over editing the time depth 
chart. Click Details... button for 
advantages and dis-advantages of 
this option.

Quick start 
(default)

Automatically imports well using 
the default sonic, VSD seismic, and 
density logs. 

Detailed Allows user to manually select 
options for customized import.

Parent Topics
"Importing wells from Kingdom" on page 29

Save model data to Kingdom
With this feature... Do this...

Save GeoSyn File Select  to save GeoSyn file. 

Save Model Check to enable Kingdom 
and SEGY save options. 

Kingdom Saves a dynamic version of 
the model with selected 
options to the Kingdom 
database.   Once saved, 
edits made in GeoSyn are 
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automatically updated  to 
the Kingdom model.

SEGY file Saves a single trace from 
the seismic file in 
SEGY format. Options 
include: name, multiplier 
and time shift value. King-
dom requires a  SEGY file to 
maintain synchronization 
with the original GeoSyn 
model.

Amplitude multiplier Enter a value to multiply the 
amplitude of the signal trace 
. The default is 1.0 .

Start Time two - way Enter value for GeoSyn to 
time shift when the seismic 
section is tied to the model.

Save time/depth chart 
to Kingdom database

Select whether to save the 
time depth chart directly to 
the Kingdom database. 
If Save as Active is 
enabled, this time depth 
chart is associated with 
future wells you import 
from Kingdom into GeoSyn. 
This same file that can be 
saved from GeoSyn using 
the File > Export 
> Time/Depth option. 
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Cull time/depth val-
ues...

Enter the sonic log cut off 
value when creating the 
time depth chart.

Local | Shared Select whether the time 
depth chart is only avail-
able to a specific well 
(local), or all wells 
(shared).

Save Location Displays current path 
where files will be saved. A 
default sub-folder   in the pro-
ject directory is created 
when GeoSyn is launched 
from Kingdom. IHS recom-
mends that the default path 
be used.

Parent Topics
"Importing wells from Kingdom" on page 29

Save modified time depth chart
With this fea-

ture...
Do this...

Name Specify a name for the modified time-depth curve.

Chart Type Select whether the time-depth curve is available to 
only this well or to all Kingdom wells in the current pro-
ject.

Set As Default Select whether the time-depth curve is available to all 
logs in the GeoSyn project.

Parent Topics
"Importing wells from Kingdom" on page 29
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SEGY viewer
With this fea-

ture...
Do this...

Format Select a format in which to display data in the viewer   then 
click various tabs to view the following:

 l ASCII/EBCDIC - basic processing information. 

 l Binary   header - which values appear at specific 
byte positions.

 l Trace header - trace information. GeoSyn looks 
here for offsets, CDP intervals,   and location.

 l Trace   data - the specific data readings.

 l Histogram - the graphical display of frequency 
variation.

 l Spectrum - the array of amplitude and frequency 
variations.

Byte order Select whether the file was saved in PC (ASCII) or main-
frame   (EBCDIC) format. 

Edit EBCDIC 
Header

Click to display the Edit EBCDIC Header dialog box and   
change SEGY values in the file.

Parent Topics
"Importing seismic data" on page 158
"Seismic Properties: Annotations" below
"Seismic properties: Trace layout" on page 304
"Edit EBCDIC Header" on page 250

Seismic Properties: Annotations
With this fea-

ture...
Do this...

Display pane Select the seismic trace(s)   with which to work. 
SHIFT+CLICK or CTRL+CLICK for multiple selection.

Import | Export Click to import or export a seismic file in SEGY format.

Duplicate Click to create a second trace with the same values   as 
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the trace selected in the display pane above.

SEGY Viewer Click to display the SEGY Viewer and view header, 
trace,   and file format details.

Labels Type a title and description that appear in the main   syn-
thetic display above the seismic data.

Annotations Select the frequency and content of annotations on the   
wavelet, and whether to include the first and last 
traces.

Font Click Edit to   configure the label and trace display font.
 

Parent Topics
"Changing seismic properties" on page 162
"Changing import defaults" on page 12
"Exporting seismic data" on page 198

Seismic properties: Display
With this fea-

ture...
Do this...

Display pane Select the seismic trace(s)   with which to work. 
SHIFT+CLICK or CTRL+CLICK for multiple selection.

Import Export Click to import or export a seismic file in SEGY format.

Duplicate Click to create a second trace with the same values   as 
the trace selected in the display pane above.

SEGY Viewer Click to display the SEGY Viewer and view header, trace,   
and file format details.

Trace Overlay Select the mathematical transformation to use to 
explain   the data, the color and fill, and the extent of the 
trace.

Color Underlay Select the mathematical transformation to use to 
explain   the data, click Edit to display   the Edit Color 
Palette   dialog box, and either select auto range to base 
the scale on the data   or clear that option and specify 
your own range.

Noise Select the Apply check box and then click Edit to dis-
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play the Noise Parameters dialog box, where you 
apply noise type.
Select a trace normalization option. None   and Peak 
divide all values by   the highest amplitude. RMS   divides 
all values by the root-mean-square of the data

Show well loc-
ation

Selectable display options for well location:

 l Show surface location

 l Show bottom location

 l Highlight

Model/Log over-
lay positioning

 l Surface position — Places inserted item(s) at the 
surface position.

 l Bottom hole position — Places inserted item(s) at 
the bottom hole position.

 l Projected deviated position — Places inserted item
(s) on the projected deviation position. 

 l Manually tie to # —  Select this option if the header 
date in the SEGY file isn't properly formatted.From 
the drop-down list select the desired trace num-
ber, surface position, or common depth point to 
which to tie the well.

 l Open a gap at well tie — Inserts a gap in the dis-
play between the inserted item(s) and the seismic 
lines to avoid covering up seismic data.

Note: This option is not available when the insertion 
point is set to - Projected deviation position.

Parent Topics
"Changing seismic properties" on page 162
"Changing import defaults" on page 12
"Exporting seismic data" on page 198
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Seismic properties: Histogram 
With this fea-

ture...
Do this...

Display pane Select the seismic trace(s)   with which to work. 
SHIFT+CLICK or CTRL+CLICK for multiple selection.

Import | Export Click to import or export a seismic file in SEGY format.

Duplicate Click to create a second trace with the same values   as 
the trace selected in the display pane above.

SEGY Viewer Click to display the SEGY Viewer and view header, 
trace,   and file format details.

Amplitude his-
togram

Select the type of data to be used. Select from Raw 
data or Display data.

Linear, Logarithmic Select whether lines appear on the log and whether 
they're logarithmic or linear.

Include zeros Click to include zeros within frequency.

Parent Topics
"Changing seismic properties" on page 162
"Changing import defaults" on page 12
"Exporting seismic data" on page 198

Seismic properties: Spectrum
With this fea-

ture...
Do this...

Display pane Select the seismic trace(s)   with which to work. 
SHIFT+CLICK or CTRL+CLICK for multiple selection.

Import | Export Click to import or export a seismic file in SEGY format.

Duplicate Click to create a second trace with the same values   as 
the trace selected in the display pane above.

SEGY Viewer Click to display the SEGY Viewer and view header, 
trace,   and file format details.

Amplitude Spec-
trum

Select the type of data to be used. Select from Raw 
data or display Data.
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Parent Topics
"Changing seismic properties" on page 162
"Changing import defaults" on page 12
"Exporting seismic data" on page 198

Seismic properties: Processing
With this fea-

ture...
Do this...

Display pane Select the seismic trace(s)   with which to work. 
SHIFT+CLICK or CTRL+CLICK for multiple selection.

Import | Export Click to import or export a seismic file in SEGY format.

Duplicate Click to create a second trace with the same values   as 
the trace selected in the display pane above.

SEGY Viewer Click to display the SEGY Viewer and view header, 
trace,   and file format details.

Filter Select the mathematical transformation to use to 
explain   the data.

Deconvolve Using 
Inverted Wavelet

Click either Library or Import to deconvolve 
(filter) the seismic section in GeoSyn by applying an 
inverted wavelet that you created using the Wavelet 
Properties > Invert Wavelet option.

Rotate phase Drag the slider to rotate the center phase of the seis-
mic.

Common offset 
stack

If the seismic selected in the display pane above is   
unstacked data, click Create to display the Common 
Offset Stack dialog box where you generate a seismic 
trace in which the unstacked   data is collated and 
summed.

Wavelet extrac-
tion

Click to extract a zero phase wavelet from the selected   
wavelet.

Tie to a model Click to display the Set   time and range for dialog box 
and specify the location at which   to anchor the trace.
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Link to AVO trace 
model

Select a model to link to the seismic for AVO analysis.

AGC Type a value for the automatic gain control.

Sample rate Select the frequency at which to sample the data when   
building the model.
 

Parent Topics
"Changing seismic properties" on page 162
"Changing import defaults" on page 12
"Exporting seismic data" on page 198
"Inverting wavelets" on page 146

Seismic properties: Trace layout
With this fea-

ture...
Do this...

Display pane Select the seismic trace(s) with which to work. 
SHIFT+CLICK   or CTRL+CLICK for multiple selection.

Import | Export Click to import or export a seismic file in SEGY format.

Duplicate Click to create a second trace with the same values   as 
the trace selected in the display pane above.

SEGY Viewer Click to display the SEGY Viewer and view header, 
trace,   and file format details.

Bulk shift Type a signed the amount to move the trace up or 
down.   

Time Type the start and stop depths for the sample interval.

Show traces Select the range of samples to display in the main syn-
thetic.   For example, to exclude the first and last few 
samples.

Show Select whether to display every sample.

Flip left to right Select whether to invert the sample locations so that   
the sample furthest from the source becomes closest.

Duplicates Type the number of duplicate traces to display.

Traces/in Select the number of traces to display per inch.
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Parent Topics
"Changing seismic properties" on page 162
"Changing import defaults" on page 12
"Exporting seismic data" on page 198

Seismic tie data properties
With this fea-

ture...
Do this...

Seismic data From the drop-down list, select from the imported seis-
mic.   Click Display to show the Display Properties   
dialog box and Range to display   the Set time and   
range for dialog box.

Model data Select the model in your synthetic to which to tie the   
seismic trace.

Cross correlation 
function display 
attributes

Click Display   to show the Display   Properties dialog 
box.

Show logs Select up to three logs from the synthetic to display   
alongside the tie in the Tie   seismic dialog box.

Tops Select whether to display names and lines in the 
Select data sets for cross   correlation dialog box. 

Parent Topics
"Creating crossplots" on page 170
"Tying seismic to models" on page 164
"Tie seismic" on page 314
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Select data sets for cross-correlation
With this fea-

ture...
Do this...

Seismic Data From the drop-down list, select the seismic data to   tie 
to a model. Click Display   to show the Display   Prop-
erties dialog box to configure the display the same as 
the   model, and the cross correlation data. Click Range   
to display the Set   time and range for dialog box and 
reduce the number of traces.   

Model Data Select the model in your synthetic to which to tie the   
seismic data. Click Display to show the Display Prop-
erties dialog box to configure the display the same as 
the seismic and cross correlation data.

Cross Correlation 
Function...

Click Display to show the Display Properties dialog box 
to configure the display the same as the seismic and 
model data.

Show logs Select up to three logs from the synthetic to display 
alongside the tie in the Tie seismic dialog box.

Tops Select whether to display names and top markers in the 
Tie seismic dialog box.

Parent Topics
"Creating crossplots" on page 170
"Tying seismic to models" on page 164
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Select insertion point
This dialog is available when dragging a item(s) (log, model or depth gauge) onto 
a seismic line. 

With this fea-
ture...

Do this...

Surface position Places inserted item(s) at the surface position.

Bottom hole position Places inserted item(s) at the bottom hole pos-
ition.

Projected deviated 
position

Places inserted item(s) on the projected devi-
ation position. 

Manually tie to # Select this option if the header date in the 
SEGY file isn't properly formatted.From the drop-
down list select the desired trace number, sur-
face position, or common depth point to which to 
tie the well.

Open a gap at well 
tie

Inserts a gap in the display between the inserted 
item(s) and the seismic lines to avoid covering 
up seismic data.
Note: This option is not available when the inser-
tion point is set to - Projected deviation position.

Set location
With this 
feature...

Do this...

Datum Select from numerous common datums.

Hemisphere 
| UTM

Select the reference point, and zone. Alternatively, 
click Get UTM from lat/long.

Copy sur-
face pos-
ition

Select whether to use the same coordinates for the 
bottom hole as the surface hole or type coordinates 
in the fields below. Alternatively, click Get 
lat/long from UTM.

Parent Topics
"Changing well display properties" on page 50
"Well properties: Well properties" on page 334
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Set scales
With this fea-

ture...
Do this...

Inches per 
second

Type an increment that matches the increment on the 
seismic section to which you're correlating.

Monitor fudge 
factor

Type the percentage by which to multiply the monitor 
resolution. Ideally, you need to compare the changes 
that appear on screen to a fixed measurement by hold-
ing a ruler, for example, up to the monitor.

Center Click the arrow buttons to move the correlation up or 
down until it aligns with a timing line on the seismic sec-
tion. The larger arrow buttons move the correlation in 
larger increments.

Zoom Click the arrow buttons to expand or condense the cor-
relation. The larger arrow buttons zoom or unzoom the 
correlation in larger increments.

Parent Topics
"Correlating logs and traces" on page 180

Set time and range for
With this fea-

ture...
Do this...

Time range Type the start and stop time range to import.

Trace range Type the trace range to import. For example, to include   
traces in a specific pane such as near a well. You may 
need a shot point   map to determine the range to 
include.

Parent Topics
"Importing seismic data" on page 158
"Select data sets for cross-correlation" on page 306
"Seismic tie data properties" on page 305
"Select data sets for cross-correlation" on page 306
"Seismic properties: Trace layout" on page 304
"Seismic Properties: Annotations" on page 299
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Shift curve
With this fea-

ture...
Do this...

Shift selected 
curves

Type the amount by which to raise or lower the selected   
logs. A positive value raises the log and a negative 
value lowers it.

Display pane Select the logs to shift. GeoSyn automatically shifts   all 
logs in the synthetic when one log is shifted. 
SHIFT+CLICK or CTRL+CLICK   for multiple selection.
 

Parent Topics
"Shifting logs" on page 84

Stretch/squeeze log curves in time
With this fea-

ture...
Do this...

Stretch/squeeze in 
time 
Stretch/squeeze   in 
depth

Select either time or depth based on the following:  
Time   to modify the transit values through the selec-
ted depth zone. The change   in the sum of all the 
transit time changes must equal the desired 
stretch/squeeze   value.   Depth   to stretch or squeeze 
the selected depth range to the thickness defined.

Thickness 
(when 
Stretch/squeeze in 
depth selected)

Type the desired thickness of the zone defined above   
after stretching or squeezing. If the value is less than 
the difference   between the start and stop depth, the 
log will be squeezed. If more, the   log will be stretched.
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Change time inter-
val by 
(when 
Stretch/squeeze in 
time selected)

Type a value by which to adjust the transit times for   
the zone defined above.

Taper the change 
over 
 (when 
Stretch/squeeze in 
time selected)

Type the distance over which to taper the change. A   
transit modification must be tapered to avoid creating 
new reflection   coefficients at the top and bottom of the 
stretch/squeeze zone. GeoSyn   uses a linear taper at 
the top and bottom of the zone where the correction   
starts at zero and tapers up to a calculated value, then 
tapers down to   zero again. The length of the taper is 
reported in depth samples and is   the sum of the top 
and bottom tapers.

Set depth range Do one of the following:
 Type a depth range over which to taper the change 
and click Update.
 Click either Top or Bottom   to select the absolute top 
or bottom of the log, or click All   to select both.
 Click Depths from Tops and select the   top and bot-
tom of your zone of interest using formation names.

Parent Topics
"Stretching and squeezing logs" on page 70
"Correlation window: log" on page 237
"Correlation window: Trace" on page 239

Stretch and squeeze (Seismic)
With this fea-

ture...
Do this...

Add After adding at least one row to the display pane, click to 
place the times in the two boxes, type different times, 
and then click Add.

Display pane In the Tie   Seismic dialog box,  hover the cursor over the 
seismic at the point to tie and click, and then hover the 
cursor over the correlating tie point on the model and 
click to tie the two.
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Using the Stretch and Squeeze dialog box, click Apply 
to update   the Tie Seismic   dialog box.
 

Restore Original Undo the above activity.

Snap to Select the feature closest to the cursor at which to place 
the tie anchor. In this way, the cursor only has to be 
near, but not directly over one of the following features 
in order for GeoSyn to select it:
Peak - the highest amplitude point.
Trough - the lowest amplitude point.
Zero Crossing - the point exactly between the peak 
and the trough.
None - the tie anchor is not snapped to a feature, but is 
placed directly below the location of the cursor.

Parent Topics
"Tying seismic to models" on page 164
"Tie seismic" on page 314

Sum options
With this fea-

ture...
Do this...

Range definition Either select Auto or specify the trace numbers to 
include in the near, middle, and far groups.

Range rela-
tionships

Using the drop-down lists, create mathematical expres-
sions to filter or enhance traces.
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Parent Topics
"Changing multi-offset properties" on page 129
"Model properties: Multi offset" on page 283

Synthetic properties
With this fea-

ture...
Do this...

Banner Select whether the UWI or only a banner you type 
appears   as the first banner. To modify the UWI, click 
Edit   to display the Edit   a UWI dialog box then select a 
survey system and type survey coordinates. There are 
additional options available from the drop-down list to 
the right of the Banner 1 box for the well header such as 
Well Label, which can be one of three labels defined 
using the Well Properties tab of the Well Properties dia-
log box, or User Defined, with which you specify alpha-
numeric characters.

Well status sym-
bol

Select whether the well status symbol appears. Click   
Well Symbol Legend for details.

Image banner Select whether an image in enhanced metafile   format 
appears. Click Edit to   display the Enhanced   Metafiles 
Properties dialog box then browse to and select the 
image, or with the image copied into the Windows Clip-
board, click Paste.

Information ban-
ner

Select whether the banner that lists detailed synthetic   
information appears.

Depth scales Select whether to display kelly bushing and subsea 
depths   and on which side of the synthetic to display 
them.

Time scales Select whether to display time scales, their meas-
urement,   and where to display them on the synthetic.

Border Select whether a black border encompasses the syn-
thetic   display.

Printer page out-
line

Select whether to display a pink border that shows the   
portion of the synthetic that will print on a single page. 
This outline   is based on the current settings of the 
default printer. To change the   outline, change the 
default printer configuration.
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Rotate model and 
single track log 
labels 90 degrees

Flip labels for models and logs so the lettering runs   ver-
tical instead of horizontal.

Tables Select whether the tops table appears in the main syn-
thetic   display and where. You can also rotate it 90 or 
270 degrees depending   on how you will orient the prin-
ted model. To display a text box on the main display in 
which you type details about operations you've per-
formed on the synthetic and so on, with the Comments 
check box selected, click Edit to display the Comments 
box.      

General model 
parameters

Select general properties based on the following:
Sample   rate The frequency at which to sample the 
data when building the   model.
Model   units Click Change   to display the Unit   con-
version table dialog box and specify the conversion 
factors   to use when converting metric and Imperial 
units.
Prompts   Select whether GeoSyn notifies you when 
importing logs with either invalid   UWIs or unknown ali-
ases.

Vertical scale Select whether the linear scale is based on time or 
depth. Depth is helpful when comparing a synthetic to a 
log, which is also depth-based. This option affects the 
Correlation window. Select the scale units and inches 
per second or feet per inch depending on whether the lin-
ear scale is based on time or depth.

Plot range Based on whether Time   of Depth is selected in the Ver-
tical scale pane, type the start   and end measurements 
of the zone of interest to display.

Parent Topics
"Changing the main synthetic display" on page 46
"Undoing and redoing changes" on page 49
"Changing import defaults" on page 12
"Displaying comments" on page 133
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Tie seismic
With this feature... Do this...

Seismic display 
pane

GeoSyn automatically picks the best tie on the trace 
closest to the well by default,   but you can override this 
by dragging the slider left or right to move   the green 
correlation line to a more similar seismic sample. 
Drag the green and the blue horizontal lines that con-
trol the data range to exclude unwanted data that 
appears in the model or in the seismic.  

Cross correlation 
function

Drag the slider to the right of the display up or down to 
move the seismic   trace along the model trace so the 
highest value for both are correlated. GeoSyn does 
this automatically, but you can change it.

Phase Drag the sliders to the right of the Seismic and the 
Model boxes (or type directly in the boxes) to manu-
ally align the phase between the seismic phase or the 
model phase and the amplitude area. The outcome of 
the signals you adjust appears in the Cross Correlation 
Function area. The red signal is the seismic and model 
phase. The black signal is the amplitude envelope. Gen-
erally, the seismic phase should be changed to match 
the model instead of the model phase being changed 
to match the seismic.

Correlation Range Select the range of data points to include in the active 
envelope. The active envelope is the vertical range 
that appears within the two horizontal green lines on 
the seismic section and within the two horizontal blue 
lines on the model. Note that instead of typing values 
in these two boxes, you can also simply drag the hori-
zontal lines as depicted. 

314 © 2020 IHS Markit™. All Rights Reserved



Select insertion point

Data that falls outside of the active envelope is 
ignored when detecting the best tie point. 

Jump to Best Tie Move the tie to the best point in either of the following:
Current Trace - a vertical point along the existing 
trace that's colored green and within the active cor-
relation range specified above.
All Traces - a vertical location amongst all of the 
traces that appear in the seismic section and within 
the correlation range specified.

Extract Wavelet Click to display the Frequency Extraction Wavelet dia-
log box where you extract a wavelet using a seismic 
section in conjunction with a model.

Stretch/Squeeze Click then select the top of the seismic zone to tie   and 
the corresponding location on the model. Next, click 
the bottom of   the seismic zone to tie and the cor-
responding location on the model. The   Stretch and 
Squeeze   dialog box opens where you can type more 
precise values for the tie   points and click Apply.

Options Click to display the Select Data Sets for Cross-Cor-
relation dialog box.

Zoom in | Zoom 
out

Click Zoom In and then move the cursor over the seis-
mic section (the cursor changes to a magnifying glass)  
and then drag the extents to zoom to zoom the overall 
dialog box. Supports multiple zooms when tying seis-
mic to a model.

Parent Topics
"Tying seismic to models" on page 164
"Select data sets for cross-correlation" on page 306
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Tie to datum
With this fea-

ture...
Do this...

Time Datum Specify a depth that is above the top of the log so that 
the synthetic is pushed deeper. For Kingdom users, the 
datum is imported from Kingdom and applies to the 
entire project, so instead of changing the datum itself, 
change the time at a given depth point, which inserts 
the appropriate velocities in the log section added.

Well Tie Point Specify a depth point on the sonic log to tie to time zero 
on the seismic section. The range from the top of the 
well to the new datum must be greater than zero.

Uncorrected Time 
Tie

Correlate the depth point tie to time using the top of the 
sonic log as time zero. 

New Time Tie Type a time that's greater than zero.

Time Units Select the time units and time measurement system to 
use when making the tie. The units shown in the boxes 
above reflect the current selection.

Depth Datum Select the depth units to use when making the tie. The 
units shown in the boxes above reflect the current selec-
tion.

Parent Topics
"Importing wells from Kingdom" on page 29
"Changing time datum properties" on page 111
"Kingdom data browser (Import directional surveys and time depth charts)" on 
page 225
"Time datum properties" on the facing page
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Time datum
With this fea-

ture...
Do this...

Apply Time Depth 
Corrections to 
Synthetic

Apply a time depth chart that is created when working 
in a given area by tying logs to seismic using Kingdom. 
The time depth chart corrects the sonic log auto-
matically created by GeoSyn by adjusting the sonic's 
time depth points. 
Alternatively, select Tie synthetic to a depth point 
and then click Edit to select a single depth on the well-
bore to tie to the time on the seismic section. Selecting 
this option requires that you add an invisible log section 
above the synthetic in order to move it down, as logs 
don't typically run to surface where time zero is 
marked. Use the Time Datum dialog to add an invisible 
log section above the synthetic.

Parent Topics
"Importing wells from Kingdom" on page 29

Time datum properties
With this 
feature...

Do this...

Add 
Layered 
Section...

Click Add to the right of the Layers label and then type details 
associated with section to add above the log. Note that multiple 
zones with different parameters can be added above the log.

Units Specify the seismic units.

Options Click either of the following:
Tie Depth Point to Time - to display the Tie to Datum dialog 
box where you specify the point at which to tie the sonic log to 
the seismic section, which differs from the Time Datum Prop-
erties dialog box where you merely push the sonic log deeper.
Convert to Log Data - to display the otherwise invisible log 
data at the top of the log in the main display. 

Layers Click either of the following:
Add - to create a row where you add zone details in the layer 
display pane at the top of the dialog box.
Delete | All - to remove the layers from the layer pane.
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Parent Topics
"Changing time datum properties" on page 111
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Time depth quality control
With this fea-

ture...
Do this...

Curve display 
pane

View the original  (red) sonic curve, the correcting 
(green)time depth curve, and the corrected 
(blue) sonic curve that results from the time depth 
curve being applied to the original sonic curve.
Drag a time-depth reading by velocity or depth, or type 
the desired values in the Edit Options pane.

Right-click to insert a new time-depth reading.
Drag to select multiple time depth readings.

Chart: Grid Select the time depth curve to use above the chart and 
select time depth readings to adjust in the Edit Options 
pane. CTRL+Click or SHIFT+Click for multiple selection.

Edit Options Modify a reading selected in the grid (or clicked in the 
Curve Display pane), and then click Update, or click 
New to add an additional time depth reading.

Mouse Node Drag 
Options

Select whether to affect the velocity or the depth of the 
time-depth curve when you drag it using the Curve Dis-
play pane.

Single or Multi-
Node Time 
Changes

Select whether to change the velocity above and below 
the selected node point or only above the selected 
node. The default option, Lock all but selected node 
times constrains the changes to the nodes immediately 
above and below the selected node preventing the 
remaining depths from changing. Generally, this is the 
preferred option.
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Regenerate chart 
by culling times 
exceeding (usec)

Remove times above entered (usec) value and update 
TD chart.

Drift Correction 
Options

Select the method by which to apply the drift cor-
rection. Spline curve is the preferred method, as the cor-
rection is applied more gradually across the entire 
zone. Linear applies more drastic changes, which may 
cause additional reflection coefficients.

Display Options Select the depth or velocity range to display and the 
preferred view that appears in the Curve Display pane.

Parent Topics
"Importing wells from Kingdom" on page 29
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Time filter
With this feature... Do this...

Type Select a predefined filter to 
apply: 

 l Band pass (Ormsby) 
-— computed from a 
trapezoidal frequency 
spectrum.

 l Ricker -— defined by 
its peak frequency.

 l Butterworth -— com-
puted from low and high 
pass cutoff frequency 
values.

 l Butterworth low-
pass -— computed 
from low  pass cutoff fre-
quency values.

 l Lobeless -— non-phys-
ically realizable wavelet 
with no side lobes.  Used 
to investigate side lobe 
tuning effects.

Center freq. Enter frequency value.

Center phase Drag slider to change the cen-
ter phase of the wavelet.

Taper Select  equation type to apply 
to taper  : None, Cosine, 
Cosine squared, Hanning

Length (ms) Enter value for length of 
sample time  in ms.

Time shift options
This dialog appears when you close the Tie Seismic dialog box after specifying tie 
points.
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With this fea-
ture...

Do this...

Shift Synthetic Select whether to shift the synthetic relative to the seis-
mic. This option is available where the slider control in 
the Cross Correlation Function of the Tie Seismic dialog 
box is dragged above the zero to a negative value.

Shift Seismic Specify that the seismic shift relative to the synthetic.

Parent Topics
"Tying seismic to models" on page 164
"Tie seismic" on page 314

Time vs. depth chart
With this fea-

ture...
Do this...

1 Way | 2 Way Select either one or two-way time.

Zoom In Click and then draw a bounding box around the pane for   
which you want to zoom. You can only zoom in once so 
to zoom more, draw   a smaller box.

Zoom Out Click to undo the current zoom view.

Show Grid Select whether to display a basic depth / time grid.

Show Tops Select whether to display formation tops.

Parent Topics
"Analyzing velocity and depth" on page 169
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Top properties
Tops:[list name] Individual tops in selected tops list(s):

 l Check box—selects tops to show on model and  
tops table

 l Highlighting individual tops selects them for 
editing, deleting, or copying.

Show all Shows all tops on model and  table.

Hide all Removes all tops from model and table. 

New Click to create a new top.
Note: When a new top is created, the attributes  in 
the Edit Top(s) fields are applied to the new top. 
Best practice is to enter the new tops attributes first 
in the  fields before clicking New.

Duplicate Duplicates highlighted top.

Delete Delete All or Highlighted  tops from list.

Copy tops list to list Select the tops in the Tops for list pane and then 
click this button and select the destination list from 
the Select a recipient tops list dialog box.

Select All Click to highlight all of the tops in current list.

Edit tops Edit the display properties for the  selected top.

Name Highlighted tops name

Depth Selected depth

Attributes  l Lithology

 l Color

 l Thickness

Tops lists Available Tops lists to select tops from.

Show all Displays tops from all tops lists on the synthetic dis-
play.

Hide all Removes all tops lists them from synthetic display. 

Export Outputs the tops  to an ASCII format file. 
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Import Selects type and file for imports tops lists.

List Labels Enter top label information.

Plot tops labels Select  side of logs that labels appear.

AccuMap specific Requires licensed installation of AccuMap. See 
AccuMap documentation for additional information.

Kingdom specific Imports and displays Kingdom specific data items for 
selected:

 l Horizon time or depth picks

 l Tops by specific authors

Parent Topics
"Changing tops properties" on page 89
"Changing import defaults" on page 12
"Exporting tops lists" on page 200
"Duplicating tops lists" on page 91
"…Create new curve type" on page 241
"Tops import" below
"Edit default display properties" on page 249
"Well properties: Well properties" on page 334
"Importing tops from delimited files" on page 97
"Importing tops from fixed width files" on page 99
"Importing tops from GeoSyn files" on page 96

Tops import
With this fea-

ture...
Do this...

Display Pane Drag to select the tops to import into GeoSyn.

Tops in Select whether the tops in the source file are ordered   
in rows (formation top names run horizontally along a 
single row), or   columns (formation top names run ver-
tically down a single column).

Names in row/-
column Depths in 
row/column

Depending on your selection above, this field changes   
to support either rows or columns. Specify the row or 
column in which   the formation names and depths 

324 © 2020 IHS Markit™. All Rights Reserved



Time depth quality control

appear. Click the directional arrows to   either move for-
ward or backward by one column or to move to the first   
or last column.

Search GeoSyn automatically searches the formation tops 
import   file for a UWI that matches the well currently 
displayed in GeoSyn and   highlights it in red. Override 
this selection by typing a different   UWI.

Import Click to import the tops selected above into GeoSyn.

Delimiter Qualifier GeoSyn automatically interprets this information from   
the source file. Override GeoSyn's comma, tab, or 
space selection.   Delimiter is the character that 
denotes each individual item to import.   Qualifiers are 
symbols that enclose items to ignore. 

Locate at specified 
depths Ignore 
depths   and space 
evenly

Select whether to space tops evenly or according to   
the kelly bushing   or subsea. If based on depth. tops 
outside of the depth range of the model   aren't placed.

Import units Select the measurement system used in the file from   
which you're importing tops. GeoSyn will convert them 
to the unit system   GeoSyn is using if required. The unit 
system GeoSyn is using appears after   the Bulk shift 
top depths by   option below.

Depths are relative 
to KB   SS

Select whether to space tops according to the kelly   
bushing or subsea.

Bulk shift top 
depths by

Type a negative or positive value by which to shift   the 
top's depths in GeoSyn.

Delete current 
tops before import-
ing new tops

Select to delete all tops in the tops list to which   tops 
will be imported. If this check box is cleared, tops with 
the same   name in the donor and recipient list appear 
twice in the recipient list.

Parent Topics
"Importing tops from delimited files" on page 97
"Importing tops from GeoSyn files" on page 96
"Importing tops from fixed width files" on page 99
"Importing tops from LAS and ASCII Files" on page 104
"Import tops" on page 260
"Top properties" on page 323
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Unit conversion table
With this fea-

ture...
Do this...

Curves Select the log for which you want to change the con-
version   factor.

Unit conversion Review the conversion factor for the selected log, and   if 
desired, type a new conversion factor in the box below.

New units Review the units to output for the selected log, and   if 
desired, type a new output unit in the box below.

Parent Topics
"Changing the main synthetic display" on page 46
"Synthetic properties" on page 312

Wavelet inversion (Input)
With this fea-

ture...
Do this...

Select Select the wavelet to display in the Input Wavelet  
pane. 

Input Wavelet View the wavelet that will be inverted. Click Select in 
the top-right to choose another.

Inverted Wavelet View a preview of the inverted wavelet to apply to a 
seismic section.

Phase | Amplitude Select whether to invert the phase or amplitude, or 
both.

Operator Length Select the length of the operator to apply. By default, 
the operator length is the same duration as the wavelet 
selected from the GeoSyn model above; however, oper-
ators for inverted wavelets typically require a duration  
twice the many milliseconds as the sample wavelet.

Constrain 
Amplitude Spec-
trum Inversion

Enable the Bandwidth option to invert using the amp-
litude outline that appears in the Inverted Wavelet 
pane. Clear the Bandwidth option to apply a constant 
inversion to reflection coefficients that exceed a spe-
cific value you type.

Taper Select the method by which to taper the wavelet 
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edges.

Invert Spectrum 
Coefficients that 
Exceed

With the Bandwidth check box cleared, type a value 
that acts as a ceiling above which reflection coefficients 
are inverted.

Show Select either Wavelet or Spectrum. Spectrum view 
includes a wavelet in the top-right corner of the Input 
Wavelet ad Inverted Wavelet panes for reference.

Parent Topics
"Inverting wavelets" on page 146

Wavelet inversion (Save)
With this fea-

ture...
Do this...

Add to Library Library files are available in multiple locations through-
out GeoSyn, which can be more convenient than saving 
to disk.

Export to File Export the inverted wavelet as a seqy file, and then 
import it into an application such as Kingdom. Inverted 
wavelets can also be imported into GeoSyn using the 
Seismic Properties dialog box.

Parent Topics
"Inverting wavelets" on page 146

Wavelet library
With this fea-

ture...
Do this...

Display pane Select the wavelet to apply tot he current model or to 
delete.

Show all Click to automatically select all of the individual check 
boxes that control display options in the above grid, or 
click the individual check boxes.
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Replace Click to apply the wavelet selected above to the exist-
ing model.

Create Create a new model based on the wavelet selected 
above.

Delete Click to remove the wavelets selected above from the 
centralized wavelet library.

Parent Topics
"Importing wavelets and wavelet sets" on page 136
"Exporting wavelets" on page 199
"Wavelet properties: Wavelet" on page 330
"Wavelet properties: Spectrums" on the facing page

Well symbol legend
Location Suspended

Service or Drain Oil

Gas Dry and Abandoned

Heavy Oil Suspended Oil

Abandoned Oil Suspended Gas

Abandoned Gas Abandoned Service

Oil and Gas Suspended Heavy Oil

Abandoned Heavy Oil Suspended Oil and Gas

Abandoned Oil and Gas Injection
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Wavelet properties: Spectrums
With this fea-

ture...
Do this...

Display pane Select the wavelet with which to work. Clear Show sall 
wavelets if you're already working with the desired 
wavelet to increase the work space in this dialog box.

Name Type a name with which the wavelet is identified in the 
main synthetic display.

Type Select a predefined filter to apply to the wavelet selec-
ted in the display pane. Controls to specify the cut and 
pass frequencies appear below based on your selec-
tion.

Low cut Low pass 
High cut High pass

Modify the energy shape either by typing the actual 
source values provided with the seismic data or by 
modifying the wavelet shape to visually match the seis-
mic data.

Center phase Type a value or drag the slider to move the wavelet rel-
ative to the center point displayed in the Wavelet tab.

Taper Select whether to taper using an equation.

Operator length Type the overall length of the sample to display in the 
adjacent window.

Import/Export Beside either Wavelet or Wavelet sets (depending on 
whether to save a single wavelet or group of wavelets), 
click Import or Export to read or write the wavelet or 
wavelet set that appears in the display pane to or from 
disk. To save or import a wavelet(s) from a centralized 
wavelet library used by all GeoSyn models, beside the 
Library label select either Add to save the current 
wavelet to the library, or Retrieve to display the Wave-
let Library dialog box where you apply one or more 
wavelets to the current synthetic.

Import Wavelet Select either of the following and then click:
Replace wavelets in selected models - overwrites 
the wavelets selected in the Show wavelet list pane of 
the Wavelet Properties dialog box with those selected 
in the Wavelet Library dialog box.
Create new models - adds the selected wavelet along-
side other wavelets available in the synthetic.    
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Extraction Click Extract to load a wavelet saved in ASCII or SEGY 
format.

Left right arrows (

)

Click to expand or compress the spectrum.

Show Select whether to display the spectrum for power, amp-
litude, and phase.

Parent Topics
"Importing wavelets and wavelet sets" on page 136
"Inverting wavelets" on page 146
"Exporting wavelets" on page 199
"Extracting wavelets" on page 149
"Wavelet Extraction (Processing Display)" on page 227
"Wavelet properties: Wavelet" below
"Model properties: Wavelets" on page 286
"Changing wavelet properties" on page 143

Wavelet properties: Wavelet
With this fea-

ture...
Do this...

Display pane Select the wavelet with which to work. Clear Show all 
wavelets if you're already working with the desired 
wavelet to increase the work space in this dialog box.

Name and Com-
ments

Type a name with which the wavelet is identified in the 
main synthetic display.

Type Select a predefined filter to apply to the wavelet selec-
ted in the display pane. Controls to specify the cut and 
pass frequencies appear below based on your selection.

Low cut Low pass 
High cut High 
pass

Modify the energy shape either by typing the actual 
source values provided with the seismic data or by 
modifying the wavelet shape to visually match the seis-
mic data.

Center phase Type a value or drag the slider to move the wavelet rel-
ative to the center point displayed in the Wavelet tab.

Taper Select whether to taper using an equation.

330 © 2020 IHS Markit™. All Rights Reserved



Time depth quality control

Length Type the overall length of the sample to display in the 
adjacent window.

Import | Export Beside either Wavelet or Wavelet sets (depending on 
whether to save a single wavelet or group of wavelets), 
click Import or Export to read or write the wavelet or 
wavelet set that appears in the display pane to or from 
disk. 
To save or import a wavelet(s) from a centralized wave-
let library used by all GeoSyn models, beside the 
Library label select either Add to save the current wave-
let to the library, or Retrieve to display the Wavelet 
Library dialog box where you apply one or more wave-
lets to the current synthetic.

Extraction Click Extract to open the Frequency Wavelet Extrac-
tion dialog box where you select the seismic trace and 
extraction method to load.

Invert Wavelet Click Invert to display the Wavelet Inversion dialog 
box where you invert a wavelet that you import into 
GeoSyn (or another seismic application) to remove 
phase and amplitude distortions from a seismic section.

Aux. trace Select an additional trace to display in the trace display 
pane and a color format. For example, the Amplitude 
Envelope shows where the wavelet energy is and helps 
you to align the wavelet phase.

Color Select a background color for the display pane.

Parent Topics
"Wavelet properties: Spectrums" on page 329
"Importing wavelets and wavelet sets" on page 136
"Inverting wavelets" on page 146
"Exporting wavelets" on page 199
"Extracting wavelets" on page 149
"Wavelet Extraction (Processing Display)" on page 227
"Model properties: Wavelets" on page 286
"Changing wavelet properties" on page 143
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Well properties: Directional properties tab
With this feature... Do this...

TVD vs. offset calculator Click the arrows to adjust the depth and off-
set values   by 1, 10, and 100 respectively.

Seismic selection drop down 
list

Select available seismic trace to display

Zoom scroll bar Zoom in or out 

Parent Topics
"Viewing deviated well properties" on page 51

Well properties: Log properties
With this 
feature...

Do this...

Display 
pane

Select the log to modify and either change its display   
properties or click Duplicate   then change the dis-
play properties of the copied log. Click New   to create 
a blank log type. SHIFT+CLICK or CTRL+CLICK for 
multiple selection,   or click Select All.

Name Type a descriptive name with which to overwrite the   
original log name.

Type Select a log type from the drop-down list and 
whether to make it the active log upon which your 
synthetic is derived.

Alias / API Select an alias and then type the API number.

Units Type the unit suffix and for sonic logs either transit or 
velocity units.

Scales Select whether to automatically adjust scales to data   
limits or type custom minimum and maximum val-
ues.

Show off-
scale

Select whether portions of a log that over-run the 
horizontal width of the track are drawn on the other 
side of the track in a different color and different line 
style. Log portions that over-run more than one track 
are colored differently than logs that over-run only a 
single track.
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Infill If displaying a single log per track, click Edit to dis-
play the Color Palette dialog box where you specify a 
lithology   fill and whether to fill the left or right portion 
of the trace.

XPlot 
underlay 
link

Select whether the color infill for the log is derived 
from a crossplot. This option is enabled using the 
Crossplot Properties: Color Mapping tab. 

Derive 
using...

Select to apply a constant mathematical formula to 
the   selected curves that persists despite changes to 
the log. Click Edit to specify different variables.   Note 
that selecting this option will prevent you from doing 
some   log editing functions.

Edit Click to launch the Edit the derivation equation dialog 
box.

Trace Select display properties for the logs selected in the   
display pane above.

Track 
Width

Specify the width at which the track will be printed.

Description 
Options

Select whether to use the log name that appears in 
the   imported file, the GeoSyn   log name, or the alias. 
To reduce the width of the overall synthetic,   display 
the alias.

Depth 
Markers

Select the increments for major and minor depth 
markers.

Track Lay-
out

Select whether to use one log per track or multiple   
logs per track. For single logs per track, configure the 
track display   using the Infill   options listed above. For 
multiple logs per track, click Edit to display the Edit   
Multi-log per Track Template dialog box and specify 
track criteria   that can also be saved as template 
files.

Parent Topics
"Changing log display properties" on page 52
"Combining logs in tracks" on page 62
"Edit color palette" on page 248
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Well properties: Well properties
With this fea-

ture...
Do this...

Unique Well Iden-
tifier

Click Edit to   display the Edit a UWI dialog box then spe-
cify a survey system and survey coordinates.   Both UWI 
labels update.

Labels Type any log header information to show in the main   
synthetic display. Select which of the labels appear in 
the main synthetic using the drop-down list that 
appears to the right of the Banner 1 box in the Synthetic 
Properties dialog box.

Status Select a well status from the drop-down list and 
whether   to update this status if it's changed in the 
AccuMap database. Click Well Symbol Legend for 
details.

KB elevation Type the kelly bushing elevation. 

Depth inc. Type the depth increment.

TVD status Select whether the well is measured in True Vertical   
Depth or Measured Depth. If Measured Depth, you can 
import an ASCII format   directional survey file by click-
ing the adjacent button.

Import Directional 
Survey

Click to launch the Measured Depth to True Vertical 
Depth correction dialog box. Also select whether to cal-
culate the bottom hole position based on the directional 
survey imported.

Tops Click Edit to   launch the Top Properties   dialog box and 
configure tops lists and individual tops.

Editing History Click View to display a list of the date, time, and 
description of changes made to the curve using Log 
Editor. Saved changes span multiple GeoSyn sessions. 

Position Select whether to use the default datum, the datum spe-
cified in the AccuMap database, or one based on 
another standard datum you select or coordinates that 
you type using the Set Location dialog box.                 

Parent Topics
"Changing well display properties" on page 50
"Changing import defaults" on page 12
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"Importing directional surveys" on page 16
"Changing wavelet expansion properties" on page 145

Zero phase extraction processing flow
With this fea-

ture...
Do this...

Time range Sum 
traces

Select the time range and number of traces to sum.

Taper Apply taper 
to

Select the taper method and percentage of the 
summed   traces to taper.

Wavelet name Type the name by which the resulting wavelet is iden-
tified   in GeoSyn.

Operator length Select the longest operator possible to ensure the amp-
litude   spectrum retains as much detail as possible.

Taper Select the method by which to taper the operator 
extracted   from the center of the summed and tapered 
traces.

Parent Topics
"Extracting wavelets" on page 149

Basic AVO workflow
The following is a very basic guide for the use of the   AVO functionality in the new 
GeoSyn 1D   program. This functionality is capable of both reverse and forward 
modeling.   Reverse modeling requires seismic data of the common offset type.

Forward Modeling
1. Import well logs, P Sonic,   Density and Shear sonic if available.

2. Re-datum the synthetic by adding new section at the top. This critical step is 
necessary to ensure that the incident angle for any given interface calculated 
within the GeoSyn ray tracing algorithm matches the seismic section. Ray tracing 
must be done from close to the surface where the seismic was acquired.
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Two methods may be used to accomplish this.  The older method, using the Insert 
Section dialog box in the Log Editor, is no longer recommended. A new dialog box, 
Time Datum properties’, handles the problem much better.

Using the Time Datum properties dialog box

Open the Time Datum Properties dialog box, Edit/Time Datum… ( ). A single 
entry typically indicates that the top of the log suite is time zero.  Click Add a 
layer, to create a new layer with zero thickness.  Next change the KB or SS value 
of the top of the new layer and set it to near the elevation of the ground surface 
or seismic datum.  
Update the velocity of the new zone to create enough time delay to push the 
GeoSyn models down in time to the correct position in time relative to observed 
seismic or checkshot data. Notice that the top of the visible model now has a time 
matching the bottom of this new layer.  GeoSyn’s AVO calculation honors this new 
zone (or zones) as if it were genuine log section added to the top of the log suite 
(as in the older method below).

Using the Insert Section dialog box

Calculating the amount of section to add: The depth datum of the seismic section 
should not be used to calculate this value, as the incident angle field in the seis-
mic is a function of the shot point and receiver elevations, in other words, the 
ground surface. In the idealized case of flat stratigraphy and flat ground surface, 
the depth value of the first log sample (relative to the KB) is a decent value to 
use. Using the Insert Section dialog box, add this section to the top of the log 
suite.

Calculating the velocity of the new section: The velocity/transit value of the new 
section is also an issue. It must match the average velocity of the section from 
the top of the well log to the surface. Calculate this value before adding section to 
the well log.

Correlate the synthetic to the seismic and determine the difference, the time 
shift, between seismic zero and synthetic zero. Calculate the seismic time datum 
shift applied by the processor and remove this from the value. Divide the Time 
Shift by two to change from 2-way to 1-way. 
Calculate the required average velocity or transit value by dividing the required 
amount of depth section by the Time Shift.
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3. Assign AVO parameters   to a model. Right click over a model and select the 
Model Parameters dialog.   Set the model type to 'Multi Offset' and adjust the fol-
lowing parameters:

Ray trace method - Ray   trace (slow). ( Full Snell's   law calculation). 

Vertical sampling interval - Use   'Constant time'.

Geometry - CDP   interval, Num   traces and Near trace offset.

Adjust the three parameters, adding or subtracting   traces, adjusting the CDP   
interval and offset until the required maximum offset is reached. Remember   that 
the CDP   interval is half the surface offset.

Apply NMO   correction - Set to yes.

Mute - Something around 28 degrees   or so will work.

4. Apply an offset   dependency formula. By default when a multi-offset model is 
created the   offset dependency for reflection coefficient calculation is set to none.   
To apply a dependency select the Reflection Coefficient (Ref   Coef) tab of   the 
Model Properties dialog and select one of the three options, Aki   Richards 2   or 3 
term or Shuey.   If a shear sonic is unavailable GeoSyn will prompt you to create 
one based   on Castagna's   well known relationship between shear and p sonic 
curves.

Step 4 completes the basic setup for forward AVO   modeling. The   model is ready 
for cross plot analysis.

5. Cross Plot analysis.   While some information may be gleaned from visual ana-
lysis of the model   the best way to analyze the data is with a cross plot. 
Cross plots of interest fall into two categories: 

Analysis of a single or at most   2 or three sample points involving amplitude plot-
ted against one of the   following; offset, incident angle, sine incident angle or sine 
squared   incident angle. This method is most appropriate for detailed analysis   of 
an AVO response at a particular interface of interest. 

Analysis of the entire data set,   or significant portion of it, by using the gradient 
vs. intercept method.   This method is convenient in a reconnaissance sense as the 
entire data   set may be analyzed at once with a view toward identifying zones of 
interest.
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Reverse Modeling
Reverse modeling is defined as a modeling effort involving   real data. 

1. Import well logs.   P Sonic,   Density and Shear sonic if available.

2. Import seismic   offset data. A common offset stacked panel, sorted to display 
near trace   on the left and far trace on the right, works well. Set the synthetic   
sampling rate to match the sample rate of the seismic. 

3. Re-datum the synthetic   by adding new section at the top. Please refer to step 2 
in the Forward   modeling section.

4. Tie seismic to   synthetic. This critical step adjusts the time datum of the seis-
mic section   to tie the synthetic. Open the 'Tie seismic to model dialog by right 
clicking   over the seismic or selecting from the Seismic properties dialog. This   dia-
log initially requests a model to tie against then automatically calculates   a best fit 
time shift.

5. Creating an AVO   model using parameters from the seismic. Select an unused 
model using   the 'Link to AVO trace model' list box in the Seismic properties dia-
log.   The model will have its AVO properties automatically adjusted to match   the 
seismic offset panel. If there is a problem reading the seismic headers   the model 
properties must be set manually.

Step 5 completes the basic steps required to prepare   a reverse model for ana-
lysis. The model is ready for cross plot analysis.

6. Cross Plot analysis.   Please refer to step five in the Forward modeling section 
for instructions   on cross plot usage. The   cross plotting effort is identical except 
that all offset and angle selections   must come from the model and all amplitude 
selections must come from the   seismic.
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Check shot computation
The application of check shots to a synthetic is, in   theory, relatively straight-
forward. In practice, it involves complicated   datums and datum corrections. The 
following describes the basic check   shot computation in GeoSyn:

A   series of check shot time depth pairs are input to the program. The sonic   log is 
integrated (i.e., converted to a time depth log), and a second   set of time depth 
pairs that correspond in depth to the check shot time   depth pairs are selected 
from it. A third set of time depth pairs are   created by subtracting the sonic time 
depth pairs from the corresponding   check shot time depth pairs. This third set rep-
resents the difference   and therefore the correction between the sonic and the 
check shot at the   depths defined by the check shots.

The   next step is to calculate a best-fit cubic spline through the correction   points. 
A cubic spline is a third-order polynomial log, with the added   constraint that the 
second derivative of the log be continuous and smooth.   Cubic splines tend to be 
more stable than polynomials, with less possibility   of wild oscillation between the 
tabulated points. Future releases of GeoSyn   will contain provision for polynomial 
fits of greater than 3 degrees.

The   cubic spline function is used to calculate interpolated points corresponding   to 
every depth sample from the integrated sonic log. These points are   added to the 
integrated time at each integrated sonic depth point. A new   sonic transit log is cal-
culated by subtracting consecutive points from   the corrected integrated log.

The   final step involves adding new section at the top of the log to account   for the 
difference between the top of the sonic log and the source datum   elevation of the 
check shot survey. Check shots above the limits of the   original log create block 
velocity zones in the newly expanded log. 
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File formats
The following supported file formats are defined below:

 l IHS 

 l SYN

 l LAS

 l SEGY

IHS file format
The following is a truncated example of an IHS formatted   ASCII file. One header 
card is required. It must contain an identifier   string, the first depth, the last 
depth, the depth increment, and the   units. If the units are missing, GeoSyn 
prompts you to select them. GeoSyn   currently only supports single log files.
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Test Well 204.0 1463.8 0.2000 M SONIC

204.0 364.76 361.88 360.86 363.92 369.15 374.39 379.62   382.22 381.31 
379.54 10
206.0 377.76 375.93 373.71 371.16 368.62 366.78 367.17   369.08 370.99 
372.90 10
208.0 374.99 377.58 380.46 383.34 386.22 389.10 393.41   399.86 407.72 
414.99 10
210.0 415.48 410.51 405.55 400.58 396.70 394.32 392.52   390.89 389.36 
388.62 10
212.0 388.59 388.57 388.54 388.51 388.49 388.41 388.18   387.87 387.56 
387.25 10
...
1454.0 161.02 158.81 156.61 155.50 155.54 155.64 155.74   155.68 155.45 
155.21 10
1456.0 155.12 155.99 157.66 159.33 161.00 162.67 164.10   165.21 166.24 
167.27 10
1458.0 168.30 169.37 170.59 171.92 173.26 174.60 176.01   174.26 168.08 
162.26 10
1460.0 161.92 165.63 169.59 173.82 178.37 183.10 187.84   182.83 168.57 
160.55 10
1462.0 161.62 166.09 170.56 174.93 179.11 183.22 187.65   190.07 190.10 
190.09 10
#TOPS# 5
Top1 258.0
Top2 348.0
Top3 481.0
Top4 599.5
Top5 684.0
KB 900.9
No special end of file characters are required.

SYN file format
After you have created and saved a new synthetic, the   synthetic is saved to disk 
as a binary file with the optional extension   .syn. This file contains all   the inform-
ation necessary to re-create the state of the synthetic as well   as the raw log 
data.
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LAS format
The Canadian Well Logging Society's Floppy Disk Committee   has designed a 
standard format for log data on floppy disks. It is known   as the LAS format (Log 
ASCII Standard). LAS consists of files written   in ASCII and containing minimal 
header information. The LAS format has   evolved over the years. GeoSyn cur-
rently supports the import of two versions,   2.0 and 1.2.

GeoSyn will read an attached tops file, although strictly   speaking tops are not 
included in the official LAS format. Two styles   of tops formats are supported in 
Version 2.0, and one format is supported   in Version 1.2. 

Truncated Example of LAS Version 2.0 

~VERSION INFORMATIONVERS. 2.00:CWLS LOG ASCII STANDARD - VERSION 
2.00WRAP. NO :One Line per depth step#~WELL INFORMATION#MNEM.UNIT 
DATA DESCRIPTION#--------- ----------------------------------- -------------
-----------------STRT.M 249.7836 :START DEPTHSTOP.M 1254.2520 :STOP 
DEPTHSTEP.M 0.1520 :STEP LENGTHNULL. -999.2500 :NULL VALUECOMP. 
AnyCompany OIL & GAS LIMITED :COMPANYWELL. AnyCompany etal 
AnyWhere :WELLLOC . AnyWhere :LOCATION#~CURVE 
INFORMATION#MNEM.UNIT DATA DESCRIPTION#--------- -------------------
---------------- ------------------------------DEPT.M :1 DepthDT .US/M 7 520 
80 00 :2 Sonic Travel TimeRHOB.G/C3 31 350 02 00 :3 Bulk Dens-
ity#~PARAMETER INFORMATION#MNEM.UNIT DATA DESCRIPTION#--------- 
----------------------------------- ------------------------------EKB .M 
300.0000 :Kelly bushing#~t 7 Tops //or ~T 7 TopsT0   647.98T1 800.89T2 
1011.86Wabamun 1132.40Ireton 1536.64Slave Point 1812.01Pre Cambrian 
1841.80#~A DEPT DT RHOB249.7836 410.825 1819.972249.9356 410.752 
1791.029250.0876 410.679 1802.005250.2396 410.607 1869.852250.3916 
410.534 1908.247250.5436 410.461 1958.225250.6956 410.388 
1987.873250.8476 410.316 2014.986250.9996 410.249 2022.811...1253.4396 
169.758 2730.6461253.5916 169.758 2730.6461253.7436 169.758 
2730.6461253.8956 169.758 2730.6461254.0476 169.758 2730.6461254.1996 
58.382 939.106No special end of file characters are required.**alternate tops 
format~Formation Tops Information#TOPS NAME . DEPTH:BR . 
7221.0410:WPBI . 8034.6790:COLO . 8539.9220:CARD . 9553.6900:CARD . 
9671.7980:L CA . 9743.9760:BKST . 9799.7500:

 

342 © 2020 IHS Markit™. All Rights Reserved



File formats

Truncated Example of LAS Version 1.2 

~Version : LASOUT vs 1.20VERS. 1.20: CWLS Log ASCII Standard -VERSION 
1.20WRAP. NO: One line per depth step~Well Information Block#MNEM.UNIT 
Data Type Information#----.---- ------------: ------------------------------
STRT.M 250.0000: Start DepthSTOP.M 2413.0000: End DepthSTEP.M .2000: 
Depth IncrementNULL. -999.25:COMP. COMPANY:WELL. WELL: Dog Patch 
LAKE 5-4FLD . FIELD: Dog PatchLOC . LOCATION: 10-10-99-1w6PROV. 
PROVINCE: ALBERTASRVC. SERVICE COMPANY: FlyByNight LoggersDATE. 
LOG DATE: 1889/12/29UWI . UNIQUE WELL ID: 0101010101010~Parameter 
Information Block#MNEM.UNIT Value Description#----.---- ------------: -----
-------------------------BHT .DEGF .0000: Bottom Hole TemperatureBS .MM 
.0000: Bit SizeDFD .0000: Mud Weight (Density)DFV .0000: Mud ViscosityDFL 
. .0000: Mud Fluid LossDFPH .0000: Mud pHRM .OHMM .0000: Mud Res-
istivityRMT .DEGF .0000: Mud Resistivity TemperatureRMFS.OHMM .0000: 
Mud Filtrate ResistivityRMFT.DEGF .0000: RMF TemperatureRMC .OHMM 
.0000: Mud Cake ResistivityRMCT.DEGF .0000: RMC TemperatureEKB .M 
987.5000: Elevation Kelly BushingEGL .M 982.3000: Elevation Ground 
Level~Curve Information Block#MNEM.UNIT API CODE Curve Description#---
-.---- ------------: ------------------------DEPT.M : 1 DEPTHDT .USM 60 520 0 
1: 2RHOB.KM3 42 350 1 1: 3~A Depth DT RHOB250.0000 376.4800 
1922.6000250.2000 345.2000 1998.4000250.4000 313.9200 
2363.4000250.6000 282.6400 2512.2000250.8000 254.4400 
2463.2000251.0000 275.8800 2392.0000...2411.2000 -999.2500 
2715.90002411.4000 -999.2500 2713.90002411.6000 -999.2500 
2712.40002411.8000 -999.2500 2707.20002412.0000 -999.2500 
2691.00002412.2000 -999.2500 2674.80002412.4000 -999.2500 
2658.60002412.6000 -999.2500 2640.70002412.8000 -999.2500 
2683.40002413.0000 -999.2500 2730.9000No special end of file characters 
are required.

SEGY format
GeoSyn can export integrated time data (traces, wavelets,   wells, rocs, etc.) in 
SEGY format. The format specification discussed   here is a derivative of the SEGY 
9-track standard. Because there is no   official MS DOS standard, some liberties 
have been taken with respect   to the original specifications. For a discussion of the 
9-track SEGY format,   refer to "Recommended Standards for Digital Tape 
Formats" K.M.   Barry, D.A. Cavers, C.W. Kneale: Geophysics,   Vol. 40 No. 2, p. 
344-352.

A SEGY file consists of three sections or blocks:
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 l ASCII file identification header

 l Binary file header

 l Trace header

ASCII file identification header
The first 3600 bytes of the file is the File Identification   Header and consists of a 
3200-byte ASCII card image block followed by   a 400-byte binary block. The 
3200-byte ASCII section represents a deviation   from the 9-track SEGY standard, 
which specifies that this section be in   EBCDIC format. Both are text formats, but 
use of the ASCII format enables   a user to read this portion of the SEGY file in any 
PC-based text editor.   This deviation from the standard has no detrimental effects 
because most   programs rely on the binary data for hard information.

The ASCII section consists of 40 lines of 80 characters   each. Each line starts with 
a C and the line number. The following is   an abridged example of the 3200-byte 
ASCII header for a typical GeoSyn   SEGY file and describes the well name, sample 
rate, data type, and byte   order. This same information is encoded in the 400-byte 
binary section.

C1 GeoSyn Synthetic Seismogram
C2 ABC OIL AND GAS 11-11-11-11W1
C3 Date: 11:35 AM Fri Dec 01, 1995�
C4 Sample Rate: 2.00 (ms)
C5 Data Type: Integer(2 byte)
C6 Byte Swap: Yes
C7
.....
C36
C37
C38
C39
C40

Binary file header
The 400-byte binary file header follows the ASCII file   header and is situated on 
bytes 3201 to 3600. GeoSyn does not require   or make use of most of the space. 

The following bytes are used:
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3213 to 3214 Number of byte traces 
per record =1
3217 to 3218 Sample interval in 
microseconds
3221 to 3222 Number of samples per 
data trace
3225 to 3226 Data sample format 
code (will be either   1 or 3)
1=floating point (4bytes)
2=fixed point (4 bytes)
3=fixed point (2 bytes)
4=fixed point with gain code (4 
bytes)
3261 to 3262 Total number of traces 
per line =1
3269 to 3270 Start time of data trace 
(can be negative   in the case of a 
wavelet)

Trace header
The trace header is a 240-byte binary section that precedes   each section of trace 
data. GeoSyn only writes one data curve, so there   is one trace header in the file. 
The trace header occupies bytes 3601   to 3840. The bytes used by GeoSyn are tab-
ulated below. Note that some   values are 4 bytes long instead of 2-byte integer.

The following bytes are used:

3601 to 3604 Trace Number.
3629 to 3630 Trace identification 
code 1=seismic data,   2=dead trace.
3715 to 3716 Number of samples.
3717 to 3718 Sample interval in 
microseconds.

Trace Data

Trace data is stored in binary format and follows the   240-byte trace header. The 
binary data may be stored in one of two formats,   16-bit integer or IEEE floating 
point. The 16-bit integer format requires   2 bytes per amplitude value, whereas 
the floating point format requires   4 bytes. 
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Data Area

The data area follows the trace header and consists of   a number of 2- or 4-byte 
numbers representing the amplitude data of the   trace or wavelet. Note that the 
number of samples in this record will   exceed the number of samples in the syn-
thetic if a trace is being saved,   because the roll out portion of the trace below the 
bottom of the log   is included. The number of extra samples will equal the length of 
the   trace plus half the length of the wavelet operator.

Well symbol legend
Location Suspended

Service or Drain Oil

Gas Dry and Abandoned

Heavy Oil Suspended Oil

Abandoned Oil Suspended Gas

Abandoned Gas Abandoned Service

Oil and Gas Suspended Heavy Oil

Abandoned Heavy Oil Suspended Oil and Gas

Abandoned Oil and Gas Injection
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